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1 INTRODUCTION

1

INTRODUCTION

1.1

About RAYLASE
RAYLASE offers high-precision components for fast deflection and modulation of laser beams.
These comprise top-quality optical elements, galvanometer scanners, and control electronics with
an intuitive software interface. Customers across the globe rely on the unique performance and
reliability of our deflection units. These components form the cornerstone of industrial laser
systems for scanning printed codes, marking textiles and surfaces, welding metal plates and
plastics, and cutting and drilling semiconductor wafers and many other materials, including metal,
plastic, or glass. RAYLASE also develops and manufactures intelligent solutions with machine
vision for the setup, automation, and monitoring of laser processes and for additive manufacturing.

1.2

About RAYGUIDE
RAYGUIDE is a laser material processing software suite. Its powerful and flexible user interface
makes it easy to design or import text, barcode, and graphic elements in order to realize complex
and extensive laser process projects.
RAYGUIDE offers two user interfaces:
▪

The Graphical User Interface (GUI). This makes it easy for users of all experience levels to
manage complex laser processing tasks.

▪

The RAYGUIDE Software Development Kit (SDK), a programmable API based on the
Microsoft .NET environment. With it, the full functionality of RAYGUIDE can be integrated into a
tailored system application according to customer needs.

RAYGUIDE is currently in a pre-series status. The functional range will be extended further on.

1.3

Compatibility
The RAYGUIDE application suite is compatible with the RAYLASE SP-ICE-3 scan controller.
Please note that the software can even operate without the scan controller connected. The
integrated emulation of the controller makes it possible to work "offline", set up parameters and edit
designs to define laser processing tasks.
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1.4

Features
▪

Support of all features of the SP-ICE-3 scan controller

▪

Support of multiple SP-ICE-3 scan controllers

▪

Support of many laser types, using precise parameter sets

▪

Support of deflection units with up to 5 axes

▪

Support of digital deflection units

▪

Support of GCD und FC3 correction files

▪

Import and export of hardware configuration sets

▪

Import of a variety of graphic formats: DXF, PLT, SVG, DWG, GBR, CGM, JPG, BMP, GIF

▪

Highly flexible user interface (GUI) that permits a customized arrangement of the control panels,
for example

▪

Working with design templates

▪

Efficient layout editing tools for vector graphics, including unlimited undo/redo

▪

Large barcode and text style libraries, with serialization of barcodes and text

▪

Definition of multi-slope power ramps plus ramp visualisation

▪

Support of MOTF processes, including various trigger and automated path sorting options

▪

Support of combined workspaces when working with multiple scan controllers

▪

Pre-definition of laser processing jobs for stand-alone operation of scan controllers

▪

Support of customer-specific plugins

▪

Support of different user roles with specific permissions

▪

Special Solar Wafer Plug In
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1.5

Scope of Delivery
A typical set of items delivered to the customer includes the following items:

1.6

▪

RAYGUIDE software installation file. In order to install all necessary program and library files
needed for the RAYGUIDE API and/or the GUI.

▪

RAYGUIDE user manual as PDF file

▪

License agreement as PDF

▪

Sample codes for the SDK/API

▪

RAYGUIDE SDK programmer’s manual

▪

Sample correction files to get familiar with the RAYGUIDE device configuration

▪

Optional hardware dongle containing license information

Laser Safety
The user is responsible for safe operation and for safeguarding the surrounding area against
hazards caused by laser radiation. OEM customers must ensure compliance with all local and
national regulations.

WARNING
Unsafe laser operations
Turn on the PC before turning on the laser system. This prevents the laser from behaving in an
uncontrolled manner when the PC is turned on. Check your application carefully before using the
laser system. Defective software can block the entire system and lead to uncontrolled operation of
laser or deflection unit.
Refer to the user manuals of the laser system and the deflection unit for safety information on
those items.
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1.7

About this Manual
This manual describes the full functionality and feature set of the RAYGUIDE software when used
with the Graphical User Interface (GUI).
There is a separate manual for the RAYGUIDE software development kit (SDK).

Conventions
Emphasized phrases are printed in bold.
Important notes and remarks are introduced with NOTE:, RULE:, etc.
Folder and file names are printed in italics.
Names of windows, dialogs and tabs are in plain text: On the Properties tab.
Menu selections are bold and in italics: Select File > Save as…
Names of dialog options (radio buttons, checkboxes) are in italics: Choose Fixed if you ...
Buttons are bold and in italics and shown with brackets: Click [Apply].
Buttons labeled with graphic icons are described by words. Example:

is a [Rotation] button.

References to other pages in the manual are in italics: See page 22, Setup.
Links to web addresses are underlined: Visit RAYLASE

1.7.1

Versions Reference
The following table references the manual version of the corresponding software product version.
Manual version

RAYGUIDE version

v1.12

v1.33
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1.8

Legal Information
Copyright
RAYLASE reserves the right to modify the product described in this manual and the manual
contents without prior notification.
All rights reserved.
Duplication of this manual, including extracts – particularly by photocopying, scanning or
photographing – and any other form of reproduction is only permitted with the prior written approval
of RAYLASE.

License Agreement
The text of the License Agreement is delivered together with the software as a PDF file.

Warranty
The customer's rights in the event of any material or legal defects in the product are set out in
RAYLASE’s general terms and conditions of business. These can be viewed at:
https://www.raylase.de/en/terms-and-conditions.html.
There is no implicit guarantee or warranty regarding suitability for particular purposes. RAYLASE is
not responsible for damage resulting from the application. Individual assemblies or other
assemblies manufactured by RAYLASE may be subject to different warranty terms. Further
information can be found in the corresponding manuals.
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1.9

Addresses
Manufacturer
RAYLASE GmbH
Argelsrieder Feld 2-4
82234 Wessling
Germany
Phone: +49 (0) 81 53 - 99 99 - 0
Fax: +49 (0) 81 53 - 99 99 - 339
http://www.raylase.de
E-mail: info@raylase.de

Customer Service
RAYLASE Customer Service can assist you with any queries or problems with the software or this
manual. Please contact RAYLASE technical support from Monday to Friday between 09:00 and
17:00 (time zone UTC +1/+2).
Phone: +49 (0) 81 53 - 99 99 - 297
E-Mail: support@raylase.de
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2

INSTALLATION AND STARTUP
Requirements
To successfully install the RAYGUIDE software on a computer, the following requirements have to
be met:
▪

Supported operating systems:
Microsoft Windows 10, 32 or 64 bit.
– The Linux Operating System is not supported

▪

Minimum hardware requirements:
– Microsoft .NET Framework version 4.8 or higher
– 4 GB of RAM
– 200 MB of free disk space

Scan controller
▪

A cardis needed to operate a complete laser system. Installation and setup of the scan
controller card are described in a separate user manual.

▪

To install, execute and configure the RAYGUIDE software, it is not mandatory to have a scan
controller installed.
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Installation Process
Double-click RAYGUIDE_Setup.exe to start the installation.

Fig. 2.1: AAA

▪

To use the plug-ins, a license upgrade can be required. The plug-in documentation is provided
as separate PDF file.

▪

The License manager tool can be useful to read out license information when not using the
RAYGUIDE main GUI.

▪

Click [INSTALL].
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Fig. 2.2: AAB

By default, the installation process creates the following folders:
▪

C:\Program Files\RAYLASE\RAYGUIDE\ for the program

▪

C:\ ProgramData\RAYLASE\RAYGUIDE\ for the storage of configuration files, log files, and
other resources

▪

User specific data are stored in: C:\users\user name\AppData\Local\RAYLASE\RAYGUIDE

▪

The software environment for the license management is also installed.

If no license file is found, RAYGUIDE will start in demo mode.
To activate the full feature set, a software license is required. For information on licenses and their
activation, see page 17, Licenses and Updates.

Fig. 2.3: AAC
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Click [Finish] to complete the installation.

Fig. 2.4: AAD

The installation creates a desktop icon on the computer:

Fig. 2.5: AAE

Starting the Software
Double-click RAYGUIDE icon.

Fig. 2.6: AAE

NOTE: When RAYGUIDE is started for the very first time, the main GUI is displayed but no
devices are configured and therefore are not available for use. For details on device configuration,
see page 37, Device Configuration and Calibration.
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3

LICENSES AND UPDATES
Licenses
There are licenses for two product variants:
▪

The RAYGUIDE SDK license allows the full use of API functions to develop customized laser
process applications, typically integrated into a laser machine HMI. It comprises only a basic
version of the software's Graphical User Interface (GUI), the so-called "demo" version. It can be
used to configure and calibrate the system, but cannot run or save actual jobs.

▪

The RAYGUIDE GUI license comprises the full feature set. This license includes the use of the
SDK part. When you plan to use the embedded GUI feature, the GUI license is required.

The license is distributed in two ways:
▪

A hardware dongle, to be inserted into an USB port of the computer running the software. With
this variant, you may install the software on more than one computer and use the same dongle
with any of those. When the software is installed or started with the dongle attached, the license
is found and activated automatically.

▪

A software key, which is valid only for a specific computer. To use a software key, a "fingerprint"
of the designated computer has to be generated. In the RAYGUIDE menu, select Help >
Licence > Generate licence request… and send the generated file to RAYLASE
(license@raylase.de). RAYLASE will return an activation file which can be imported by selecting
Help > Licence > Activate licence.
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To view license and version information for the installed software, select Help > About in the
RAYGUIDE menu. Example:

Fig. 3.1: AAH

Updates
A maintenance plan can be purchased along with the software. To look up the maintenance period,
select Help > About in the RAYGUIDE menu. During the maintenance period, you will
automatically receive feature enhancements that are distributed via regular software updates.
If the maintenance period is expired, but your application requires using new functions, you can
request a license update "on demand" to update the software. For a quote, contact your RAYLASE
sales agent.
To update your current RAYGUIDE application, download the latest RAYGUIDE release. The latest
installation file can be run without further preparations. Your configuration and data are preserved.

Bug fixes
To update your current RAYGUIDE application for bug-fixing, download the latest RAYGUIDE
release and run its setup-file. Independent of the maintenance period, there is no license update
required.
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4

INTRODUCTION TO THE USER
INTERFACE

4.1

Overview
When the software is started, the RAYGUIDE GUI is displayed in the standard panel layout:
1

2

3

4
Fig. 4.1: AAI

Menu
1 The main menu provides access to all important functions. For details, see page 21, Menu.

Toolbar
2 The icons in the toolbar offer shortcuts to program functions. For details, see page 22,
Toolbar.

Viewport
3 The viewport is the area where the geometric layout of the layout objects is displayed, created,
and modified. For details, see page 28, Viewport.

Status Bar
4 The status bar displays the current user role (left) and status information (right).
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Panels
Program functions are available on a variety of panels. They can be presented and moved to
various places of the GUI. For details, see page 31, Panels.

Dialogs
Most configuration, layout and processing parameters are entered in pop-up dialogs.

Online Help
In all dialogs and panels you find a “?” sign in the headline. Click on the "?" to open the online help
on the desired section in your default browser.

Related Presets
Main toolbar and status bar visibility can be turned on/off. Select System > Preferences from the
menu to open the Preferences dialog. Go to the System (all users) tab and to the Visibility sub-tab,
Bars section.
Setting

Explanation

Toolbar

Turns the main toolbar on/off.

Status bar

Turns the status bar on/off.

Tab. 4.1: 001

The size of toolbar icons can be specified.
Select System > Preferences from the menu to open the Preferences dialog. Go to the System
(all users) tab and to the UI sub-tab.
Setting

Explanation

Toolbar icon size [pixel]

Size of object toolbar icons in pixels

Tab. 4.2: 002
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4.2

Menu
The main menu at the top of the GUI offers some essential functions.

Fig. 4.2: AAJ

Some standard functions of the software require no further explanation.
▪

The File menu refers to common job file tasks. RAYGUIDE job files will be saved with file
extension *.rg. The menu also offers the option of importing layout objects and exporting jobs to
other file formats such as DXF.
NOTE: Bitmap elements are not included in the export, while text elements are exported as
vector graphics.

▪

TheEdit menu contains common operations that can be applied to the selected objects. This
menu also contains the "Click to adapt" object transformations. Details see page page 22,
Toolbar.

▪

The View menu is described in page 26, View Options.

▪

The Job menu refers to working with jobs.

▪

The Objects menu can be used to insert objects into the job, just like the Object panel (see
page 87, About Layouts). In addition, available templates are listed for each object type (see
page 164, Templates).

▪

The Tools menu provides access to the "Measurement tool" and the "Split object" tools.

▪

The System menu provides access to the Devices and their configuration dialogs plus the
Laser Diagnostic and RAYGUIDE Preferences dialogs to define the available presettings. It also
gives you access to the Library Pen set and its Pen configurations. The autonomous scan
controller operating dialog is also started from this menu item.

▪

The Help menu displays brief information about the software and takes you to the
administration of licenses. You can also launch an email with all relevant information
automatically attached and send it to your responsible support contact. For further information
also see chapter page 236, Error Messages.

Applicable keyboard shortcuts are shown behind most menu options.
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4.3

Toolbar
The toolbar (below the main menu) offers the following functions:

Tool

Explanation

Jobs
Adds a blank job document.
Opens/saves a job document.
Cut, Copy, Paste
Cuts, copies and pastes selected items.
Undo, Redo
As long as the job document has not been closed, every step of your work can be undone.
To do so, repeatedly click the undo icon (arrow to left). To restore a step that was undone,
click on the redo icon (arrow to right).
For complex operations (e.g. when objects with a large number of vector objects are
deleted or modified), a larger amount of memory is required to undo the operation.
Therefore, the software may prompt you with the following query.

This gives you the choice of whether or not you want the operation to be reversible. By
setting the checkbox, your selection will be saved for future events.
The saved selection can be found again in Preferences > User (current user) > UI (see
page 77, UI).
Lock / Unlock workspace.
This option locks all (current and new) layout objects in the viewport against mouse
operation. Applies to all open jobs.
Tools
Tool to measure distances.
Click once to the start point of the distance, and then pull the mouse to the second point of
distance or right click once for the start point and a second time for the end point of the
distance.
Keep [Shift] pressed to measure horizontal/vertical only.
Keep [Ctrl] pressed to stay in measurement mode, e. g. for subsequent measures. The
cursor icon indicates the measurement mode by switching from “arrow” to “crosshair”.
After each measurement, the distance is:
▪
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Tool

Explanation
▪

Noted in the notifications panel:

To measure an exact distance from one thumb to another thumb, please refer to the Thumb's
context menu. See Details on page 154, More Object-related Operations in the Context Menu.
Splits the selected objects.
Any selected object can be split into two parts.
First, select the object for which the tool should be available. Click in the viewport to define
the first point of the split-line that is visible now. Click again to define the second point of
the split-line. (Press [Shift] to get a horizontal / vertical line.) The object will be split now.
NOTE: All objects that are content based (e.g. text, codes) produce vector-based parts
after splitting.
NOTE: Containers as a whole cannot be split with this tool. However, multiple objects can
be selected.
Zoom
The zoom functions apply to the viewport.
Zooms out and in. Alternatively, you can use the scroll-wheel of the mouse.
Fits the entire work area into the viewport.
Fits the area defined by the cursor into the viewport.
Fits the selected layout object or the selected subobject (layer, path) into the viewport.
Zooms to fit all layout objects into the viewport. If there is no layout object, the workspace
is fitted into the viewport.
You can also use the scroll-wheel of the mouse to zoom in/out. If you keep the mouse wheel pressed, you can
move the view area in the viewport with mouse movement.
Display options
Toggle buttons to enable/disable the use of the main display options. For details, see page 26, View Options.
Display Grid
Display Guidelines
Display Jump Vectors
Display Vector Tips
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Tool

Explanation
Display sharp corners

Stroke width
Globally increases or decreases the line width of all graphics in the viewport. The value
corresponds to the number of pixels (relative to the screen resolution). Note that this is just
display-related. It does not affect the spot size of the laser beam on the material and
therefore has no impact on the process result.
Use the slider or enter a value in the input field.
Use the [Reset] button to reset to default.
Slice navigator
Use the navigator to select the index of the slice from the solid that can be seen in the
viewport.
NOTE: When using a solid file with a negative form, the slice may be empty as soon as
you navigate under the negative form.
Example:

Opacity
The sliders can be used to adjust the opacity of the background images.
Click to adapt
Transformation 1: Shift and rotate.
Adapts the position of the selected object by manually picking 2 source points and then
picking 2 target points.
The object selection is not scaled.
Transformation 2: Shift, rotate and scale (with the same factor).
Adapts the position and size of the selected object by manually picking 2 source points and
then picking 2 target points.
The scaling factors are the same for both dimensions (X/Y).
Transformation 3: Shift, rotate and scale (with different factors).
Adapts the position and size of the selected object by manually picking 3 source points and
then picking 3 target points.
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Tool

Explanation
The scaling factors are independent of each other for both dimensions (X/Y).

Tab. 4.3: 003

The tool bar is subdivided into groups that can be shown and hidden independently. See page 26,
View Options.

Tooltips
In many cases, a short explanatory text appears when you move the cursor over a GUI element,
such as a button or a field:

Fig. 4.3: AAK
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4.4

View Options
Select View from the menu to activate supporting information to be displayed in the viewport.
Viewing jumps, vector directions and identify certain vector angles will help you to investigate the
process order of layout elements or their current shortcomings.
Setting

Explanation

Grid

Toggles the display of viewport grid lines. The grid spacing automatically
adjusts to the zoom level.

Guidelines

Select this menu item to show/hide the guidelines..

Jump vectors

Toggles the display of the jump vectors. The display shows all jumps within
and between all current layout objects.
A limit for the display can be defined in System > Preferences > System > UI

Vector tips

Toggles the display of vector sequences/directions of all current layout
objects. A circle also marks the starting point of the object.
A limit for the display can be defined in System > Preferences > System > UI

Sharp corners

Switches the highlighting of specific vector transitions in all layout objects on
and off.
Useful, for example, when the Skywriting feature is active to see which vector
transitions are effected, depending on its “change of heading angle”. Also,
unintentional u-turns of consecutive vectors can be highlighted.
The angle limit to define a “sharp corner” is to be set in System >
Preferences > System > UI

Panels

Toggles the display of the various UI panels.

Layout

Offers a sub-menu to store/load panel arrangements per user.
You also find options to Reset panel layouts to default arrangement.

Toolbar

Switches the display of various groups in the toolbar on and off.

Zoom

Provides a sub-menu for using the various zoom functions.

Tab. 4.4: 004
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Related Presets
Select System > Preferences to adapt some preset variables related to view options.
Setting

Explanation

System (all users) > UI
Sharp corner limit [°]

If sharp corners in the layout are a critical issue, you may set a
minimum change of heading angle (in degrees) here. Corners
where the vector changes direction with at least this angle, will be
highlighted in the layout if the corresponding view option is set.

Path start / sharp corner
radius [pixel]

Radius (in pixel) of the circle that highlights path starts and sharp
corners

User (current user) > UI
Jump vectors in pen color

Displays the jumps in the color of the pen which defines also the
jump parameters – if the display option “show jumps” is activated.

Tab. 4.5: 005
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4.5

Viewport
The viewport is the central area of the RAYGUIDE GUI, where the job layout is defined and edited.

Fig. 4.4: AAL - as an example you see 2 overlapping scan fields

▪

The crosshair marks the origin of the so-called “workspace” to which all vector coordinates and
the offset of the object transformation refer.

▪

The maximum workspace area is framed by rulers.

▪

To view the area of a defined workspace, activate the display of grid lines. The grid lines show
up only in the workspace area.

▪

When multiple scan fields are used, they are displayed by dashed frames.

▪

The current cursor position in the corresponding coordinate plane is displayed at the bottom left.

▪

At the bottom right, the view of the coordinate plane (XY or XZ or YZ) can be selected, provided
that a correction file with a 3D volume is being used.
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Fig. 4.5: AEM – A solid and its slice in the XZ axis view are shown here, for example.
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4.5.1

Guidelines
The guidelines are tools for adjusting the layout along either a vertical or a horizontal line.
To add a guideline to the viewport, drag it from the ruler area into the viewport with the left mouse
button and release the mouse button to place it in the desired position.
The guidelines are magnetic to the corner thumbs of a layout object bounding box or when you
select a single thumb of a vector graphic.

Fig. 4.6: ADH

▪

Use the right-click context menu for the Modify or Delete options.

▪

Use the Modify option to enter a specific axis position for the guideline.

NOTE: The guidelines belong to a single job and are not saved.
HINT: To temporarily disable the "magnetic behavior" of guidelines, press the [Alt Gr] key.
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4.6

Panels
Program functions are available on a variety of panels.
In the default panel layout, some panels are stacked. Thus, the screenshot below does not show all
of them.
Use the tabs at the bottom of the panels to toggle between alternative panel contents.

Available Panels

3

4
1

2
5

6

Fig. 4.7: AAM

Panel contents are explained in detail in the respective chapters of this manual. Follow the links.
1 Jobs: Overview of main job properties and the job tree (see page 87, About Layouts)
or Vector list : List of graphic commands (see page 87, About Layouts)
2 Objects (see page 87, About Layouts)
3 Execution (see page 206, Running a Job)
4 Transformation (see page 132, Object Transformation)
or Process adjustment (see page 221, Process Adjustment)
5 Process monitor (see page 211, Process Monitor)
6 Pens (see page 165, Process Parameters (Pens))
or Templates (see page 164, Templates)
7 Notifications : Table which traces latest RAYGUIDE status information.

In addition, a Custom UI panel can be activated. This panel will host controls, which could be
added by customer UI plug-ins (see page 234, Custom Plugins).
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Rearranging Panels
The panel layout can be rearranged according to your current work objectives and personal
preferences.
▪

Select View > Panels in the main menu to toggle on/off the visibility of certain panels.

▪

Use the mouse to drag a panel to a new position:
Point at the title bar of a panel and hold the left mouse button pressed.
Now drag the panel towards a new position. A positioning tool appears on the screen.

Fig. 4.8: AAN

▪

To dock the panel beside another panel, drag the mouse point to one of the arrows and release
it there.
The circle in the middle of the positioning tool causes the panel to dock on top of another panel
In case two panels lay on top of each other, grasp the panel at its tab in order to detach it.

▪

Use the pin button on the panel's title bar to minimize the panel to a sidebar (pin bar). Click the
tabs of the pin bar to maximize a panel at the previous position.

▪

Use the [x] button on the panel's title bar to close the panel.

▪

Select View > Panels > Reset layout to return to the default panel layout.
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Save Panel Layout
▪

Go to View > Layout: You can save the actual panel layout or open already saved panel
layouts per user. Thus, one user can be allowed to define multiple panel layouts per task, for
example, one panel layout for job design tasks and another for job execution tasks.

Fig. 4.9: AAO
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4.7

Buttons, Icons, Shortcuts
Text Buttons
Throughout the GUI and its dialogs, text buttons are used for common functions:
Button

Meaning
Activates the setting changes and closes the dialog.
Activates the setting changes without closing the dialog.
Discards the setting changes and closes the dialog.

Other buttons are labeled appropriately.
Tab. 4.6: 006

Icon/Symbol Buttons
Throughout the GUI and its dialogs, icon buttons are used to access functions. Frequently used
icons are:
Button/icon

© 2022 RAYLASE GmbH

Referenced as

Function

[Add]

Adds a new item, e.g. a job, a pen set, depending on
context.

[Delete]

Deletes or closes the active/selected element(s).

[Edit]

Edits selected items.

[Save]

Saves to templates.

[Reset]

Sets the preferences/parameters back to the default
values.

[Refresh]

Refreshes the displayed information.

[Import]

Imports a file.

[Export]

Exports data into a file.

[Clear all]

In process monitor: Clears all jobs from the table.

[Abort]

In process monitor: Aborts job execution.

[Clear]

In process monitor: Clears one job from the table.

[Expand]

Shows dialog in dialog.
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Button/icon

Referenced as

Function

[Collapse]

Hides dialog in dialog.

[Expand all]

Expands list of items.

[Collapse all]

Collapses list of items.

[Previous/Next]

Goes to previous/next item.

[Reverse order]

Reverses order.

[Lock / Unlock]

In Pen panel: Makes all values of selected pens local.

[Reset pen]

In Pen panel: Restores default values for selected pens.

[Cut]

Deletes selected item to the clipboard.

[Copy selected]

Copies selected items to the clipboard.

[Transfers the pen
set]

Transfers the current pen set to the library by either
creating a new library pen set or overwriting an existing
one.

[Paste]

Pastes selected items from the clipboard.

[Create]

Creates selected item.

[Apply filling]

Applies a filling template to a selected object.

[Apply filling
without removing]

Applies a filling template to a selected object without
removing an existing filling.

[Copy settings]

Copies settings to adjacent dialog section.

[Execute]

Starts processing selected jobs/objects.

[Stop]

Stops processing.

[Search]

Searches the network for scan controller cards.

[Connect/
Disconnect]

Connects to or disconnects from the scan controller card
(IP address).

Tab. 4.7: 007
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Toggle buttons
Some icon buttons serve as toggle switches. Clicking them activates/deactivates the function. In
some cases the icon turns red when activated.
[Pointer]

Activates the pilot laser.

[Arm/Disarm]

Arms and disarms the laser. An armed laser is ready for
operation.

[Preview]

Starts/stops a preview.

[Show pen]

In the pen panel: Activates/deactivates the color highlighting
of elements in the tree structure that use the selected pens.

Transformation buttons
Buttons used for object transformation on the Process adjustment panel are described separately,
See page 221, Process Adjustment.
Tab. 4.8: 008

Keyboard Shortcuts
Some functions can be accessed by keys of the keyboard:
Function

Key

Help

[F1]

Rename

[F2]

System preferences

[F3]

Device configuration

[Ctrl]+[F3]

New Job

[Ctrl]+n

Save Job

[Ctrl]+s

Zoom to workspace

[F4]

Close job

[Ctrl]+[F4]

Exit application

[Alt]+[F4]

Object properties

[F5]

Pen Set Configuration

[F6]

Start preview

[F8]

Enable marking with keyboard shortcuts

[F10]

Job settings

[F11]

Job presets

[Ctrl]+[F11]

Stand-alone dialog

[Ctrl]+[F12]

Tab. 4.9: 009
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5

DEVICE CONFIGURATION AND
CALIBRATION
Before using RAYGUIDE to define and execute laser process jobs or any other tasks, the system
devices have to be configured. There are four types of devices available:
▪

Scan controllers

▪

Laser

▪

Deflection units

▪

System/Computer serial controllers

Suggested Workflow
The hardware devices must be configured according to their interfaces, characteristics, and optical
setup. Perform all following steps, however, the order is arbitrary.
Add the device to the Configured Devices section on the device configuration window. From the
menu, select System > Devices > Configure…, or press [F3].
Step 1
After the initial installation of RAYGUIDE, the right side of the dialog appears empty:

Fig. 5.1: ADT
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Configuration window with example content:

Fig. 5.2: AAP

To add devices such as a scan controller or a laser, use the mouse to drag it from Supported
Devices to Configured Devices. You can add a supported device type to the Configured devices
multiple times.
NOTE: We suggest to start by adding at least one scan controller device.
Step 2
Configure the device. Double-click the device to open the configuration dialog.
Settings and options in the configuration dialogs are described in the following sections of this
manual.
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Step 3
The scan controller needs to know which devices to communicate with: link laser and deflection
units to the scan controller card.
▪

Go to the scan controller's configuration dialog and select the respective device from the
dropdown field for lasers and deflection units. The scan controller's configuration dialog lists all
the devices currently present in configured devices.

▪

Use the edit button to configure the device, if not already done.

Result: After the devices are linked to a scan controller, the card’s label is displayed on the device
entry in the device configuration overview.
Light color code:
White: no connection available
Gray: connection status available, not connected
Green: connection status available and connected
The checkmark behind the scan controller indicates that this controller and its linked devices are
the default. Change it if you want to define a different scan controller as default.
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5.1

Scan Controller Configuration
Open the cardconfiguration dialog. There are three ways to do so:
▪

In the [Device Configuration] menu, double-click on the scan controller entry (right side) or use
the context menu of the scan controller and select [Properties].

▪

Select System > Devices > Scan controllers > (device name) from the menu.

▪

Double-click on the card entry in the job overview.

The scan controller configuration window has five tabs: Setup, General, I/O, MOTF, Serial.

5.1.1

Setup
Essential card configuration settings.

Fig. 5.3: AAQ
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Setting

Explanation

Card

Name and address of a scan controller card.
Click the [Search] button to search for available cards on the network.
The available cards within the network are listed showing their serial numbers and IP
addresses.
Identify the SP-ICE-3 card by its serial number and select it. In most cases, each card appears
once with its IP4 and once with its IP6 address.
NOTE: The selection of the card’s IP address family does not affect the card’s performance.
Alternatively, click the [Edit] button to add a card by entering its IP address.
Click the [Connect/Disconnect] button to connect with (or disconnect from) the card. An active
card connection is indicated by a green “traffic light”.
If you are setting up a system with multiple scan controllers involved, repeat this step per scan
controller and its individual configuration dialog.
NOTE: Before connecting, ensure that the card’s firmware version matches the RAYGUIDE
client software. If they do not match, you get an error message. The download link will state the
SP-ICE-3 Firmware Version, which is compatible to the RAYGUIDE installation.
[Auto connect at startup] Toggle button to define if the card should be connected when
RAYGUIDE starts. If you want to disconnect from the card and do not want to connect to this
card automatically again, untoggle the button. By default, the button is activated.
Click [Webinterface] to browse to the card's web interface. This interface can be used, for
example to update the card’s firmware. For details, refer to the SP-ICE-3 manual.

Laser

Select a suitable laser to be controlled by the card.
Click the [Edit] button to open the laser dialog.
Click the [Add] button to add another laser device to the configured devices list.
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Setting

Explanation

Head Protocol

Select a suitable scan head (deflection unit) protocol. This protocol defines the commandresolution and the number of controllable axes.
▪

XY2:
– 16 bit resolution protocol
– can control up to 3 axes
– Requires additional XY2-100 adapter board on SP-ICE-3
– Single head mode only
– Supports feedback channel

▪

SL2:
– 20 bit resolution protocol
– Can control 2 axes per protocol port/cabel. For a scanner with 3 or 4 axes, two SL2-100
connections (and consequently two cables) are required
– Dual head mode possible
– Supports feedback channel

▪

RL3
– 20 bit resolution protocol
– Can control 6 axes per control port/cable (A scanner with up to 6 axes can be run on a
single data connection)
– Dual head mode possible
– Supports feedback channel

NOTE: The subtype of the head protocol is defined by the chosen correction file on the
deflection unit dialog.
Scan head 1

Select the type of deflection unit head for head 1.
Click the [Edit] button to open the deflection unit configuration.
Click the [Add] button to add another deflection unit device to the configured devices list.

Scan head 2

Select the type of deflection unit for head 2. This is only applicable if you have chosen a head
protocol mentioning "Dual Head".
Click the [Edit] button to open the deflection unit configuration.
Click the [Add] button to add another deflection unit device to the configured devices list.

Enable logging

Activates the SP-ICE-3 API logging. The log file records all SP-ICE-3 API commands sent to
that scan controller. This is important for troubleshooting. See page 236, Error Handling and
Log Files.
Click [Reset] to reset the log file.

Log path

Path to the log file.
Click [...] to select a path or click [Go to] to open the respective folder.

Short label

A convenient name for this scan controller. It is recommended to name the scan controller by
its function or its arrangement within the system so that it can be easily allocated at any time
later.

Tab. 5.1: 010
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5.1.2

General
Basic information about the scan controller.

Fig. 5.4: AAR
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Setting

Explanation

Card Info

Display of the major card information such as its serial number
and firmware version.

System Time

Display of the cards operating system time

Stand-Alone

Indicates the operating status of the scan controllers and whether
a list is being executed.
The [Settings] icon takes you directly to the dialog of the standalone configuration.

Deflection Unit Monitoring

NOTE: If monitoring is activated and the number of consecutive
errors exceeds a defined limit, the scan controller terminates any
active execution. When operating in stand-alone mode, this will
call up the so-called “error list”.
The cause for the termination can also be communicated to
external devices using the "Error handling" option. See page 213,
Automated Error Handling.

Enabled

Activates the scan controller to monitor the status of the
connected deflection unit, by querying its head status word.

Period

Time interval, in which the card is querying the status word.
NOTE: We suggest not to set the period too short
(recommendation not below 500 ms), as this stresses the data
exchange unnecessarily.

Min. consecutive errors

Number of consecutive errors that is tolerated before all active
executions are terminated.

Tab. 5.2: 076
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5.1.3

I/O Port Configuration
Configures the SP-ICE-3 scan controller card's I/O ports.

Fig. 5.5: AAS

Setting

Explanation

Port mapping
Click [Add mapping] to start the configuration or to add a new port configuration.
Checkbox

Check the box to select the port for further actions (e.g.
delete).

ID

Use the ID to give the port a name under which it can
be selected later in the GUI.
ATTENTION: Existing references to this port, for
example, in automation objects, get cleared when the ID
is changed.

Data direction

Select In if the port receives signals from another
device, or Out if the port provides signals for other
devices.
NOTE: Some IO ports of the SP-ICE-3 card can be split
into an input and an output section.
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Setting

Explanation

Physical port name

Select an available port. Refer to the SP-ICE-3 scan
controller manual for a description of available ports,
their physical arrangement and names.

Bit range

Use the mouse to set the range of bits to be used. Click
at the first and the last bit. The range of available bits/
pins is determined by the selected port. Non-selected
bits are ignored.
Light color code:
▪

Green: Marks the selected bit range. To resolve the
range, click on the outermost marked box.

▪

Gray: This bit has already been assigned elsewhere.

▪

Red: This bit was assigned twice!

Polarity

Use the polarity to define whether a logic "1" is applied
at 0 V=Low or 5 V=High.

Delete

Click on [Delete] to delete the corresponding port
configuration.

Special functions In / Out
In

Out

▪

Start mark

Use the drop down menu and set the port and its signal
index
for the signal to be queried for incoming signals
for the signal to be set for outgoing signals.

▪

Abort mark

▪

Part sensor

▪

Arm Laser

▪

Pilot

▪

Mark in progress

▪

Marking active

NOTE: The SP-ICE-3 scan controller provides two
dedicated pins for the input of the start/stop signal on
the Laser In port (X907), which therefore need no
configuration.
Define the signal polarity in the second drop down
menu.
NOTE: If you configure the I/O pins for the start/stop
mark inputs as "High Active" but do not connect them
(=floating condition), you create a permanent logical
true state of the respective signals due to the internal
pull-up resistor. For more details consult the SP-ICE-3
manual.

Port level
Port A / Port B

Select the value of the port level to be 0 V, 3.3 V or 5 V.

General
Short label

Enter a name to recognize which ports are associated
with which scan controller.

Tab. 5.3: 012
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"Execution in progress" signal vs. "Mark in progress" signal:
Both signals are generated by the RAYGUIDE application. The "Execution in progress" signal is
already set while an execution is waiting for a trigger signal or a belt distance, for example.In
contrast, the "Mark in progress" signal is not set during a wait condition and thus is only active
when layout objects are actually being processed/marked.
NOTE: The MIP signal is active independently of whether the laser is armed or not. Thus, the
signal is also active during a preview, for example.

Binning
Using signal patterns from external devices, for example, a PLC can be used to control whether a
job (stand-alone mode only) or an object should be processed.
For details on binning, refer to page 215, Preparation of stand-alone operation of scan controller
and page 119, Common Properties of Marking Objects.

Port Masking
It is possible to configure the same physical port multiple times, each with a different bit selection.
Use case:
You want to control the execution of different job objects by "port masking". Let's assume you have
two objects within one job and three objectives:
▪

only object 1 should be processed

▪

only object 2 should be processed

▪

both objects should bet processed

You need to define the same binning port twice, where, for example, the first port checks only bit 0
and the second port checks only bit 1.
The control will now be as follows:

5.1.4

▪

only bit 0 = active

▪

only bit 1 = active

▪

bits 1 and 2 = active

MOTF Configuration
Use to configure settings in case your application required “marking-on-the-fly”.
For details, refer to page 194, MOTF Jobs.
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5.1.5

Serial Port Configuration
Configures the scan controller card's serial port for communication purposes. Set according to
commonly used general serial communication settings.

Fig. 5.6: AAT
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5.2

Laser Controller Configuration
Open the laser controller configuration dialog. There are three ways to do so:
▪

In the Device Configuration menu, double-click the laser source entry (right side) or select the
Properties item in the context menu.

▪

In the scan controller configuration dialog, click the [Edit] button next to the selected laser
device.

▪

Select System > Devices > Laser > (device name) from the menu.

NOTE: Some laser types offer special control options and, consequently, special pen parameters.
Laser

Specific parameters

Trumpf TruPulse Nano/SPI
(G4)

Waveform, simmer voltage

IPG YLPS AMB

2nd laser power

IPG YLPN APD

Optical pulse width

nLight AFX

Beam profile index

Tab. 5.4: 082
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The following configuration dialog for lasers contains all conceivable (generic) settings.

Fig. 5.7: AAU
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Setting

Explanation

Power control
Hot power target

Defines by which signal type the (primary) laser source receives its power
information (DAC0, DAC1 / Digital1bit, Digital2bit, Digital8bit, Digital16bit /
LmWidth, LmFrequency).
Depending on the selected "available" laser, a predefined entry is set already.
Select DAC, for example, for analog controlled laser, or LmWidth for standard
CO2 laser.

Simmer /Secondary power target Defines a further signal type (DAC0, DAC1/Digital1bit, Digital2bit, Digital8bit,
Digital16bit / LmWidth, LmFrequency) for power information.
This power information can either control the simmer voltage in a TruPulse
Nano/SPI Laser, or the power value of a secondary laser source (e.g. in a ring
mode laser such as the IPG YLS AMB laser).
NOTE: All functions for the dynamic adaptation of the power value of the laser
(e.g. power ramps, speed-dependent power correction, etc.) pertain solely to
the primary power value and not to the secondary power value.
Only while marking

Enable, if the simmer power is to be set only when marking.

Activation delay

Time the simmer current must be set prior to the marking.

Equipment features
Visible pointer

Defines whether the corresponding laser is equipped with a pilot laser so that
the preview function can be offered.

Off state when disarming*

Defines whether the nLight AFX laser goes into the off state when disarmed or
just goes into the ready state when inactive.
NOTES: For the nLight AFX laser, the interlock may only be opened in the off
state; otherwise, an error message will be output and the laser will be forced to
go into the off state.
Independently of this, a preview with the pilot laser is possible both in the
ready state and in the off state.

Laser modulation
Gate Signal polarity

Polarity of the Gate signal to high vs. low, according to the laser input interface
description

LM signal polarity

Polarity of the LM (laser modulation) signal to high vs. low according to the
laser input interface description.
On the laser side, this signal is often named “Trigger”, or PWM (Pulse Width
Modulation), or PRR (Pulse Repetition Rate).

Enable gate modulates LM

Required only if the dashed line feature is used with lasers that do not offer
gate input (e.g. CO2 laser).

Enable laser synchronization

For lasers which have an internal pulse train, in order to adapt the vector
position to laser timing

Gate setup [µs]

Time span in which the gate signal advances to the actual marking start.
Positive setup times extend the time the gate is asserted.
Negative setup times reduce the time the gate is asserted.
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Setting

Explanation

Gate hold [µs]

Time span in which the gate signal advances to the actual marking start.
Positive values extend the time the gate is asserted.
Negative values reduce the time the gate is asserted.

Laser trigger delay [µs]

Time, the optical pulse is generated after the trigger edge was received by the
laser.
The value must be provided by the laser manufacturer.

Enable equally spaced pulses

Enables the frequency being modulated in relation to the marking speed, in
order to achieve equally spaced pulses even with speed variation caused by
scanner delays, managed by the SP-ICE-3 scan controller.

First pulse suppression
Polarity

Defines the polarity of the laser FPS signal (high vs. low), according to the
description of the laser interface.

Setup time [µs]

Defines the time the FPS pulse needs to be set prior to the optical pulse.

Pulse width [µs]

Defines the pulse width of the FPS signal, according to the description of the
laser interface.

Power settings
Power scale [%]

Global power scale in [%]
Example:
If an analog-driven laser requires the power range controlled by 0 V to 5 V, you
can scale the power output to 50%.

Min. power [%]
Max. power [%]

Fields to define the laser power limits in [%] which can be used for pen value
validation. For example, some lasers can be a little unstable when operated in
a power range that is too low.

Enable power calibration

Use a laser power calibration file to linearize laser power over power range.
The SPICE3PowerCalibrator.exe program is used to create the calibration file.

Calibration file

Navigate to the desired laser calibration file in the Windows Explorer and load
it.

Power correction
Enable position dependent

Uses a position-dependent power correction file to influence the laser power
dependent to the actual scan field position. This file can be generated also in
the Multi-Point-Editor application, which is described in the respective
attachment in this PDF file.

Correction file

Navigate to the desired laser power correction file (*.pc3) in the Windows
Explorer and load it.

Signal timing
Operating mode

Select whether the laser operates only in the pulsed or continuous-line mode
or whether the mode should be selectable in Pen.
NOTE: The limits of the pulse frequencies can be defined as follows if
necessary. The Pens provide fields for setting the pulse frequency and
selecting the operating mode.

Min. frequency [kHz]
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Setting

Explanation

Max. frequency [kHz]

Maximum frequency the laser can manage

Pulse width definition

Fixed: The pulse width of the laser modulation signal gets set to a fixed value.
The value can be entered in the next field. Please check the related laser
manual for the expected default pulse width.
Relative: The ratio of pulse width and pulse duration is variable as it depends
on the frequency and laser power [in percentage] as defined by the pen.
Usually used by CO2 lasers with hot power target "LMWidth".
Manuel: Select this option if the pulse width is to be set individually per pen.
HINT: This pulse width value affects the control pulse, not necessarily the
optical pulse.

Pulse width [µs]

Fixed value for the pulse width of the provided LM signal

Max. duty cycle [%]

Define the maximum ratio of the pulse duration to the pulse period that the
laser accepts.

Power change setup [µs]

Time the laser needs to change the output power. The value is provided by the
laser manufacturer or evaluated by application tests.

Latch power delay [µs]

Time the power write signal is set to, according to the power command.

Latch power width [µs]

Pulse width of the power write signal

Tickle
Enable tickle

Enables the use of the tickle signal. Refer to the laser manual to find out if your
laser requires this signal.

Frequency

Frequency of the laser tickle signal, according to the description in the laser
manual

Pulse width [µs]

Pulse width of the laser tickle signal, according to the description in the laser
manual

General
Short label

Assign a name under which the laser is identified in the GUI. E.g.,
manufacturer, type.

Tab. 5.5: 013

* This feature is only available with the nLight AFX laser.
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5.2.1

Advanced configuration of lasers with serial interface
Some lasers are capable of exchanging additional data or receiving commands, usually via an
additional serial interface.
Currently, only PC serial interfaces (e.g. COM1) can be used. These are then automatically
configured by the respective laser module.
ATTENTION: Thus, the control options described below are only effective in job execution mode
"On host" or "Quick".
The laser configuration contains the option to enable the interface for the serial communication and
select the serial port.

Fig. 5.8: AEF

The color indicator is used as an indicator of the laser operating state.
RED = Laser is not responding (because it is not connected or not switched on)
Yellow = Laser is still in warm-up phase
Green = Laser is ready for operation
On a second tab, you can view the exchanged commands in the event log. These are also
recorded in the RAYGUIDE log.
Currently, 2 laser types feature the capability of an additional serial communication:

5.2.1.1

IPG laser type YLPN-APD
In this laser type, the pulse width values of the optical laser pulse can be set (these are preset by
IPG according to the individual laser).
The APD mode transmission to the laser is performed via the IO connection by the scan controller
and adapter board. This makes an additional connection via the serial interface optional.
ATTENTION: To enable the laser to implement the signal sequence to switch the "adjustablepulse-duration" via the IO interface of the IPG-compatible adapter of the SP-ICE-3 card, jumper W3
on the adapter board must connect contacts 2 and 3. This applies regardless of the IPG interface
type! For details, see the SP-ICE-3 Manual, chapter 4.3.4.
The pulse width values can be queried for the indices via the serial interface and read in. This
enables the display of the values in the pens.
NOTE: In IPG lasers, the so-called optical pulse width does not correspond to the pulse width of
the laser modulation signal.
NOTE: The values are stored in the Device.json file, but can be called up again manually via
[Refresh] if the laser source is changed.
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5.2.1.2

InnoLas laser type Nanio AIR / BLIZZ
In this laser type, information on the operating state of the laser can be called up via the serial
interface to avoid starting a job execution while the laser is still in the warm-up phase.
The laser status request is always issued automatically when a job is to be executed.
If the laser is not ready for operation, a corresponding device validation message appears in the
GUI.

Fig. 5.9: AEE

5.2.2

Additional laser-specific options

5.2.2.1

nLight AFX Laser
Device status
Device status

Off / Ready / Emission / Error
Indicates one of 3 possible states of the laser source. For further
details on the statuses, please see the manual of the laser
source.

Status water flow

Yes/No
Indicates whether the laser source is water-cooled.
Can be used to manually reset the error status of the laser
source.
NOTE: Only enabled if the laser source has an active error.

Tab. 5.6: 083

© 2022 RAYLASE GmbH

RAYGUIDE Manual V1.12

55

5 DEVICE CONFIGURATION AND CALIBRATION

5.3

Deflection Unit Configuration
Open the deflection unitConfiguration dialog for the laser control. There are three ways to do so:
▪

In Device Configuration menu, double-click the deflection unit device entry (right side) or use its
context menu, selecting properties.

▪

In the scan controller configuration dialog, click the [Edit] button next to the respective device.

▪

Select System > Devices > Deflection units > (device) from the menu.

The deflection unit configuration window has three tabs: General, Calibration, Deflection unit
status.
NOTE: If you use a deflection unit with different correction files and/or field sizes, you should ease
your work by "cloning" the existing unit as a second deflection unit with another correction file and
probably another calibration assigned.
ATTENTION: If you use several deflection units with the same optical setup and therefore the
same correction file, it is strongly recommended to duplicate the original correction file and add a
suffix to the file names for each unit to prevent the correction files from being mixed up.
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5.3.1

General

Fig. 5.10: AAV
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Setting

Explanation

Model / Article Number The data is automatically read out from the deflection unit. In order to
read this data from the deflection unit, the deflection unit must be
physically connected. In addition, the correct protocol must already have
been set on the "General" tab of the configuration dialog of the scan
controller.
Correction file

A correction file has to be selected.
Suitable correction files are provided by RAYLASE according to the
customer's optical setup.
Correction files should be stored to and loaded from: C:
\ProgramData\RAYLASE\CorrectionFiles\
The correction file format must be FC3 or GCD.
To make sure that the correction file is updated on the scan controller
immediately, click on [Apply] after selecting the correction file –
especially if you plan to continue with field calibration right away.
[…] opens the folder that contains the correction files to select a
correction file.
[Go to] opens the folder that contains the correction files but with no
further actions.
[+] adds another line to optionally select a second correction file, which
can be loaded onto and used on the same card.
ATTENTION: The second correction file can only be loaded if:
▪

It has the same optical setup as the first correction file

▪

The file name is not completely identical.

NOTE: For information on what correction file is used when, and how this
is assigned, see page 81, Setup, page 163, Setting the correction file
index and page 189, Job Properties.
These values are read from the correction file and cannot be edited.
Field size

Axes

Max. magnification

Dimensions

Working distance [mm]

Optical zoom

Aperture [mm]

Sensor axis

Focal length [mm]
Orientation

Defines the directions of the X-Y coordinate system of the RAYGUIDE
GUI relative to the actual deflection unit orientation. The layout directions
in the RAYGUIDE viewport should correctly reflect those of the working
area of the deflection unit. Can be set to 0, 90, 180, 270 degrees. If in
doubt, do a marking test to determine the correct setting.
By RAYLASE convention, an orientation of 0 degrees means, the +XAxis points in direction where the laser enters the deflection unit. For
those units where the laser beam enters from above (e. g. AS-FIBER),
the default +X-axis points in direction of the device front side.

Invert Axis
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Setting

Explanation

Set transfer delay

Enable this option if you have not yet defined a transfer delay for the scan
controller.
The transfer delay is made up of a value that depends on the protocol
and the interpolation time of the deflection unit.
The interpolation time is either read out automatically from the deflection
unit or can be entered manually. The [Refresh] icon can be used to
repeat the of interpolation time query at any time.
NOTES:

Speed limit [m/s]

▪

The transfer delay will have an impact on the timing between the laser
and deflection position.

▪

The option is implemented beginning with RAYGUIDE version v.1.17.

Sets an optional speed limit for the deflection unit. Standard setting is
100 m/s. This setting does not overrule the speed set in pens, but can be
used for job validation. See page 206, Running a Job.

Tuning
The data in the section below can be either read out from an internal database or from the
connected deflection unit itself.
Use the [Refresh Data] icon to update the tuning list and the related dynamic data, e.g. when a
different deflection unit has been connected.
NOTE: In order to get the data automatically, the axis article number information displayed above
is necessary. If an older deflection unit is connected that does not support the enhanced protocol,
the values must be entered manually.
The dynamic data for the X- and Y-axes is are always identical and is therefore listed as a bundle.
Storage

The storage index number (always starts counting from zero) is the internal
identifier of the tuning.

Name

The name specified for the tuning can be overwritten. This means that you
can enter a suitable name for each tuning that fits best to its associated
dynamic behavior in your application. This name is also shown to enable you
to select the tuning in the "Send Enhanced Command" automation object.

Tracking error
[µs]

The value is either read out from an internal database according to the axes
set article number, or, if the head is equipped with DICON2.5 electronic, read
out from the deflection unit itself.
HINT: The value can be corrected or entered manually if necessary (e.g. if the
deflection unit cannot provide information such as axes article number). Use
right-mouse-click > reset to default in order to return to the original value.
About the value:
Time interval that the respective optical axis requires to follow a new position
command.
The value depends on the sluggishness of the optical axis (and thus on the
substrate material and diameter) and the so-called tuning. If you have any
questions, the values can be found in the data sheet or in the deflection unit
manual.

Acceleration time The value is by default related to the tracking error value.
[µs]
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Setting

Explanation
HINT: The value can be corrected or entered manually if necessary (e.g. if the
deflection unit cannot provide information such as axes article number). Use
right-mouse-click > reset to default in order to return to the original value.
About the value:
Time (microseconds) the scanner needs to reach the intended speed set in
the pen.
This value is only used when marking bitmaps.

Default | Active

Short label

Select which of the available tunings is to be set.
▪

Default = Tuning that is loaded when the deflection unit is powered up.

▪

Active = Tuning that is active unless a different tuning is set manually via
the "Send Enhanced Command" automation object.

A convenient name for this deflection unit. You may include the field size as
part of the name, for example.

Tab. 5.7: 014

5.3.2

Deflection Unit Calibration
The field calibration must be performed to ensure that the marked geometry matches the precision
requirements. You can also use it to adapt the position of the scan field to the machine geometry.
Workflow recommendation:
Before starting to calibrate the deflection unit,
▪

ensure that the laser has already been configured and assigned to the card in order to perform
a laser marking.

▪

apply the assignation of the deflection unit to the scan controller in the scan controller dialog.

▪

apply the assignation of the correction file in the deflection unit dialog.

The file name of the correction file associated with the calibration (execution and preview) is
displayed via the two areas for "Execution" and "Preview".
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If more than one correction file was loaded onto the card, the correction file belonging to the
calibration can be picked out of a selection list here.
The Calibration dialog is divided into the following sections:
▪

Execution: calibration of the scan field while the actual laser source is working and executing
jobs.

▪

Preview: calibration of the visible pointer. This calibration data are therefore applied during a
preview.

Fig. 5.11: AAW

In the "Execution" section, the geometric correction is defined for the executions of laser process
jobs with the processing laser.
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Setting

Explanation

Fine focal adjustment (Scanner domain)
This option is only available if the correction file controls the pre-focusing optics, e.g. for deflection
units of the AXIALSCAN type.
Focal adjustment always applies to the position of Z-axis of the pre-focusing optics. It can be used
to adjust the global focus position.
Axis length [mm]

Length of the movement range of the Z-axis [mm] (read-only value as
provided by the correction file)

Offset [mm]

Offset value in [mm], which applies directly to the Z-lens position. Only
positive values are allowed, unless the correction file has a preset offset
included. A positive offset will shift the focus downwards.

Disable axis

The User can decide to disable each available Z-axis if necessary.

Field transformation (Field domain)
NOTE: Transformation values for offset and rotation as well as scale values larger than 100 %
reduce the available scan field as provided by the correction file.
NOTE: These transformations apply to the vectors and do not edit the correction file.
Gain [%]

Decreases/increases the length of the vectors, if the marking result does
not meet the designed sizes.
Editable for the X- and Y-axes.
To verify the correct scan results and gain settings, mark a square and
measure it. Transform the result into a scaling factor (in [%]) and enter it
for the X- and Y-axes.

Offset [mm]

Shifts the projected coordinate system relative to another coordinate
system (e. g. to adjust it to a machine coordinate system or another scan
field).
Editable for X- and Y-axes.

Rotation [°]

Rotates the projected coordinate system relative to another coordinate
system (e. g. to adjust it to a machine coordinate system or another scan
field).

Correction file
Multi Point Calibration always applied to the selected correction file.
Multi Point
Calibration

Opens the Multi Point Editor (MPE).
The MPE allows correcting possible field distortions and, in case of a 3 or
4 axes deflection unit, also correcting the focus dependent on the field
position. It applies to the correction file selected on the General tab.
You can use pens for marking as defined in the default library pen set.
Continue with an edited duplicate of the original correction file. The MPE
application will automatically exchange the employed file and backup the
original file.
Detailed information on functions and operation can be found in the
separate Multi Point Editor manual attached to the PDF.

Tab. 5.8: 015
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In the Preview section, the geometric correction of the preview is set up. This may be necessary as
the pilot laser emits at a different wavelength than the actual laser and, due to a different
diffraction, is projected differently on the workpiece.
See Details on page 203, Preview.
Setting

Explanation

Fine focal adjustment (Scanner domain)
The same principles apply as in the Laser section.
Pilot-laser-specific: You can deactivate the Z-axis operation during the preview to reduce stress
on the Z-axis galvo-motor. Check the option “disable z-axis” and the lens will pause in the default
position while the preview is running – likely causing a larger pointer spot.
Field transformation (Field domain)
The same principles apply as in the Laser section. See the table above for details.
To start calibration of the pilot laser, the values from the Execution section can be transferred into
the Preview section with the arrow button.
Pattern
To define a calibration test pattern.
Size [mm] and Pen

Choose a size for a square to mark and a pen from the default pen set as
process parameters. By default, the square is positioned in the field
center.

Mark and Trace

First, mark the square using ([Mark]).
Then, trace the shape of the square with the pilot laser using ([Trace]).

Adjust

Use [Gain], [Shift]), and [Rotate] to superimpose the preview shape on
the marked square.

Delta fields

Define the delta of the scale, shift, and rotate effects when the adjust
buttons are clicked.
Specify the delta values in the corresponding units for gain / offset /
rotation.

Tab. 5.9: 016

5.3.3

Deflection Unit Status Information
If you use a digital deflection unit (e.g. SUPERSCAN IV) and a fitting protocol was selected, this
tab will display status information of the deflection unit.
Use the "Automatic refresh" option if the displayed values are to be continuously refreshed. Several
virtual status LEDs indicate the current device status. For the interpretation of the LEDs, see the
deflection unit's manual.
Status information can be useful in case you have trouble with the deflection unit performance or
wish to check the currently active tuning.
The current mirror position can be read here, too.
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Fig. 5.12: ADM
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5.4

Configuring the PC/computer serial interface
Open the dialog for the serial interfaces. There are two ways to do so:
▪

In Device Configuration menu, double-click an entry for the serial interface or select the
Properties item in the context menu.

▪

Select System > Devices > Serial controllers > (device name) from the menu.

You can now set up a serial RS232 port at the computer for communication purposes.

Fig. 5.13: AAX

Setting

Explanation

Ports

Click [Add port] to define a new serial port. A new dialog opens. Multiple ports can
be defined. The columns represent common settings for a serial port communication.

General
Short label A convenient name for this PC serial port.
Tab. 5.10: 017
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5.5

Configuration Backup and Replication
Saving/Restoring the Device Configuration
Device configuration settings are automatically saved and stored in configuration files. The settings
are preserved in case of a software update.
Nevertheless, it is recommended to save the current configuration as a backup file (JSON format).
In the device configuration window,
▪

click the [Export] button to create/save a configuration backup file.

▪

click the [Import] button to import/apply a configuration backup file.

System Replication
A configuration backup file is also convenient if you move to another computer or if you want to
replicate your complete system. Replication means having one or more laser processing systems
(scan controller, laser, deflection unit, computer with RAYGUIDE) similar to the original one. Using
the configuration backup saves the time for configuring another system from scratch. However, a
new system typically needs to connect to its own scan controller, using a unique IP address. This is
a manual process, even if a configuration backup is used:
1. Search for scan controller (IP address).
2. Select the card.
3. Connect with the card.

Cloning Devices
In the Configuration menu, an already configured device can be duplicated by cloning. This is
useful
▪

if you use multiple cards and want to use the same or similar hardware (lasers and deflection
units) with them. In this case it is necessary to add additional instances of the hardware to the
managed devices.

▪

if you use the same deflection unit with different optical setups, for example, different f-theta
lenses (with different field sizes). Instead of switching the correction file each time you change
the lens, it is more convenient to have a deflection unit configuration for each, especially as
each setup requires its own calibration.

To clone a device, point at it in the Configured devices list and select [Clone] from its context
menu.
When the clone is created, it can be reconfigured if necessary.
You can also clone the scan controller configuration, but you must connect the cloned scan
controller configuration to a different physical scan controller.

Correction Files
Any employed correction file is not saved with the configuration, as any edits to it can only be valid
for a specific system and are not suited for replication.
For a new system, you must always start with an original correction file.

© 2022 RAYLASE GmbH

RAYGUIDE Manual V1.12

66

5 DEVICE CONFIGURATION AND CALIBRATION

5.6

Laser Diagnostics
The laser diagnostic tool can only be used to control the laser in order to measure its power output,
e.g., to create a laser calibration file.
To open the laser diagnostics dialog, select System > Devices > Laser diagnostics… from the
menu:

Fig. 5.14: AAY

WARNING
Laser operation
Observe all applicable precautions for safe laser operation.
Refer to the user manuals of the laser system and the deflection unit (scan head) for safety
information.
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To measure, proceed as follows:
1. Select the scan controller card with the laser attached. Verify that the laser is switched on.
2. Enter the coordinates for the 2 or 3 dimensions where the laser beam is to be fired. Be sure
that a suitable target is at that position, for example, a laser power measuring probe.
3. Enter all relevant laser parameters for the measurement. The available laser parameters may
vary depending on the laser type and visibility settings for pens. See also page 172, Pen
Properties.
4. Arm the laser if it isn't already armed.
Click the [arm/disarm] button.
An armed laser shows a red fire icon on the button.
5. Click the [Switch laser on/off] button to begin the laser emission.The laser continues to emit
until the button is clicked again.
6. Close the dialog with [OK] or [Cancel]. OK stores the settings until the feature is used again.
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6

PREFERENCES
The RAYGUIDE software can be configured with respect to UI properties, process behavior,
permissions, etc.
Some preferences may be set once when you prepare the system after installation, others may be
edited when working with related features.
View options set some user interface options.
System preferences apply to all users. With permissions settings, the changing of system-wide
preferences can be blocked for selected users (e.g. for all but the administrator).
User preference can be set for each user separately. A logged in user can decide on his/her own
preferences.

6.1

System Preferences

6.1.1

General
Select System > Preferences from the menu or press [F3] to open the Preferences dialog. Go to
the System (all users) tab and to the General sub-tab to set some basic options.

Fig. 6.1: AAZ

© 2022 RAYLASE GmbH

RAYGUIDE Manual V1.12

69

6 PREFERENCES

Setting

Explanation

Initialization
Arm laser on startup

Sets the laser to ready-for-operation at software start up. Once
checked, it is no longer required to manually arm the laser prior to the
job execution (unless you disarm manually).

Reset process
transformation,
Reset power scale,

Select when to reset all process transformations and scale settings for
the laser power value and/or speeds made on the Process
adjustment panel:

Reset speed scale

▪

Per Startup

▪

Per Execution

▪

Never

Logger
This refers to the RAYGUIDE log (not to the scan controller log file).
Levels

Set the checkmark for the log data to be recorded.
By default, all but Trace is checked. Trace data is very detailed and
creates huge log files. The Trace option should only be selected if this
data is requested by RAYLASE support.

File name

Name of the log file.
Click [Go to] to open the respective folder

Tab. 6.1: 018
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6.1.2

UI
Select System > Preferences from the menu or press [F3] to open the Preferences dialog. Go to
the System (all users) tab and to the UI sub-tab.

Fig. 6.2: ABB

Setting

Explanation

UI
Performance
Vector tip limit

Defines the maximum number of vector tips that can be displayed
so as not to overload the graphic display.

Jump vector limit

Defines the maximum number of jump vectors that can be
displayed so as not to overload the graphic display.

Display
Sharp corner limit [°]

See page 26, View Options.

Path start / sharp corner
radius [pixel]

See page 26, View Options.

Toolbar icon size [pixel]

Size of the toolbar icons in pixels. This function is helpful if the
user interface is operated on a touch monitor.

Tab. 6.2: 020
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6.1.3

Process Adjustment
Select System > Preferences from the menu or press [F3] to open the Preferences dialog. Go to
the System (all users) tab and to the Process adjustment sub-tab.
Specify the lower and upper limits of laser power and speed scale.
For a detailed description, see page 221, Process Adjustment.

6.1.4

Visibility
You may hide or show parts of the GUI or its dialogs, depending on your needs.
Select System > Preferences from the menu or press [F3] to open the Preferences. Go to the
System (all users) tab and to the Visibility sub-tab.

Fig. 6.3: ABC

Make your selection in the following categories:
▪

Bars: Enables/disables the display of the toolbar and the status bar.
The status bar is the gray bottom bar of the GUI which displays current status information, like
permission role, cursor position, etc.

▪

Pen-related settings, to adapt the pen dialog according to your needs. For a description, see
page 172, Pen Properties.

▪

Job overview information to be displayed: For a description, see page 79, About Jobs.
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6.1.5

Permissions
With permissions , various user roles can be defined, each having specific permissions for using
RAYGUIDE functions.
NOTE: After initial software installation, no users are set up. That means that anyone who starts
the software will have all permissions. It is advisable to set permissions soon.
Select System > Preferences from the menu or press [F3] to open the Preferences dialog. Go to
the System (all users) tab and to the Permissions sub-tab.

Assign Users and/or User Groups to Roles
Go to the User/groups tab.

Fig. 6.4: ABD

Initially, the administrator, designer, and operator roles are pre-defined, but no users. You can add
other roles or delete present roles according to your needs. Only the administrator role cannot be
deleted. It is mandatory to have at least one user assigned to the administrator role. This should be
the first thing to do.
NOTES:
▪

RAYGUIDE utilizes the users / user groups as defined by Operating System Level.

▪

In case your operating system is a WINDOWS Home Edition, RAYGUIDE automatically adds all
defined users to the list by default; therefore, the [Add user] button is not available.

Click [Add user]. A Windows dialog opens, where you have to enter the user's log-in name (more
names can be entered by semicolon separation). If the designated RAYGUIDE user is not
available, it has to be created at Windows level first!
To add a windows defined user group, the “Objecttype” has to be switched from “User” to “Group”.
For details on the PC user management, ask your IT administrator.
Click check names. If the user or the user group is found, confirm with [OK].
The user/user group name should now be listed in the user/group column. Next you can define
which user/user group shall have which role. Multi-selection is possible. You can rename the preset
roles if required.
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Assign Permissions to Roles
Go to the Operations tab.

Fig. 6.5: ABE

In the table you can assign various functions to the roles by setting checkmarks. The administrator
has always all the permissions. New roles can also be added here.
NOTE: The name of the currently active user is displayed in the status bar at the bottom left of the
RAYGUIDE main window.
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6.2

User Preferences
All preferences in the User section are stored per PC user and are not locked by any user
permission setting.

6.2.1

General
Select System > Preferences from the menu or press [F3] to open the Preferences dialog. Go to
the User (current user) tab and to the General sub-tab.

Fig. 6.6: ABF

Setting

Explanation

General
Language
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Select from the list of available GUI languages. The following
languages are currently available: English, German, Chinese, French,
Spanish, Italian, Japanese.
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Setting

Explanation

Default Job

Activate the option and select a job file that is loaded by default when
the RAYGUIDE application is started. Deactivate this option if you want
to have a blank job when you start RAYGUIDE.

Job Template

Activate the option and select a job file if you want a predefined job
content when starting a new job. Deactivate the option if you want to
have a blank job when you create a new job.
Use case: Each job must start with a "Wait condition" and end with a
"Set IO output" object.

Job validation
Set the checkmark if you want a job to be validated prior to execution – with regard to the
following issues:
Refer to page 206, Running a Job for further details.
▪

Whether the layout fits into the workspace / scan field

NOTE: In case on a MOTF job, validation is performed only for the configured workspace.
HINT: If a tiler container is used, it is also checked whether the layout fits into the tile pattern.
NOTE: Job validation also will consider field calibration and process transformation, however, it
does not consider vector extension by SKYWRITING or any wobble geometry.
▪

Whether the scanner-related pen values exceed a limit (e.g. the speed limit as defined in the
deflection unit dialog).

▪

Whether the laser-related pen values exceed a limit (e.g. the power range as defined in the
laser dialog).

▪

Whether pen settings with regard to ramping, in particular the accumulated ramp length, will
exceed the length of the respective path.

NOTE: Job validation is not available in stand-alone mode.
By default, all validations are set active.
Preview objects
Ignore binning

Setting to display all objects in a preview, regardless of possible
binning conditions.

Logger
This refers to the RAYGUIDE log (not to the scan controller log file).
Levels

The system default settings, i.e., the system pre-settings, are used by
default. The current user can also use other protocol levels as needed.
NOTE: The trace protocol level should only be set when requested by
RAYLASE support as otherwise a large number of unnecessary files
will be created.

File name

Name of the log file
Click [Go to] to open the respective folder.

Tab. 6.3: 021
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6.2.2

UI
Select System > Preferences from the menu or press [F3] to open the Preferences dialog. Go to
the User (current user) tab and to the UI sub-tab.

Fig. 6.7: ABG

Setting

Explanation

General
Show actual coordinates

Check if you want to show the coordinates of an entity including
its transformations in its properties dialog.

Center selected command

Check if you want to show the entity you have selected in the job
tree in the center of the viewport.
Check one of the following settings:

Hide other objects while
editing

▪

Never

▪

Always

▪

If not in Viewport: Only if the selected entity is not already
visible in the current image section of the viewport.

Check if you only want to see the actively edited object in the
viewport (which is particularly useful when multiple graphic
objects are superimposed onto each other).

Hide other layers while editing Check if you only want to see the layer actively selected in the job
tree in the viewport (which is particularly useful when multiple
layers are superimposed onto each other).
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Setting

Explanation

Keyboard nudge [mm]

Sets how much selected objects or graphic elements are moved
with one keyboard stroke (arrow keys) in [mm].

Jump vectors in pen color

When the display option “show jumps” is activated:
Displays the jumps in the color of the pen which also defines the
jump parameters,

Complex undo redo operation For complex undo redo operations (e.g. when objects with a large
number of vector objects are deleted or modified), a larger
amount of memory is required to undo the operation.
This function defines how complex undo redo operations are
handled.
Units
Speed

Select the global speed unit:
▪

[m/s]

▪

[mm/s]

If a change is made, you must restart the software to apply the
change to all forms and dialogs.
Power & Max. power [%]

Select the global unit for the laser power: [%] or [Watt]. When
selecting the unit [watt], also enter the maximum laser power
value in [watt] that is emitted at 100%.
If a change is made, you must restart the software to apply the
change to all forms and dialogs.

Tab. 6.4: 022

6.2.3

Process Adjustment
Define the preset deltas that edit the process transformation (offset, rotation, scale) when using the
buttons.
Select System > Preferences from the menu or press [F3] to open the Preferences dialog. Go to
the User (current user) tab and to the Process adjustment sub-tab.
For a description, see page 221, Process Adjustment.

6.2.4

Tolerances
Before applying automated vector optimization functions, some settings can be made in advance.
Select System > Preferences from the menu or press [F3] to open the Preferences dialog. Go to
the User (current user) tab and to the Tolerances sub-tab.
For detailed use cases, see page 136, Automated Vector Optimization.
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7

LASER PROCESS JOBS

7.1

About Jobs
A job is a combination of graphic elements, process parameters, job parameters and job execution
settings.
To generate a new job, you can click on File > New in the menu or on [Add] in the main tool bar.
Alternatively, you can also use the key combination [Ctl]+[n].
The number of open jobs is not limited. A * on the job tab indicates that the job has been modified
since it was opened or created.
The figure shows an example with two open jobs:

Fig. 7.1: ABH

The Job panel is divided in 2 sections:
On top, important job settings and the job-linked scan controller cards are shown. You may
collapse/expand the job overview. You may also enable/disable the display of the single job
information per preset.
Select System > Preferences from the menu or press [F3] to open the Preferences dialog. Go to
the System (all users) tab and to the Visibility sub-tab Job.
The lower section provides the so-called job tree.
All job elements are listed in the order in which they get processed. For details see page 87, Job
Content Creation.
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7.1.1

Save and Open Jobs
To save a created job, click on [Save] or the File > Save or Save as… item in the main menu. The
job file type is *.rg.
NOTE: We strictly advise against processing job files in any application other than RAYGUIDE.
To open an existing job, click on [Open file] or on File > Open in the main menu to navigate to the
desired job file. Alternatively, use “recent documents” to select one of the last used jobs from the
provided list.
To open multiple jobs simultaneously, select all job files in the Explorer and drag them into the
open RAYGUIDE GUI using the mouse.
When opening a job, which was created on another RAYGUIDE, installation, that job does refer to
a different scan controller and possibly to further different hardware devices. Therefore,
RAYGUIDE prompts you to reference the missing devices to available devices in the actual
RAYGUIDE installation. Suitable devices are listed in the respective drop down options.

Fig. 7.2: ADC

NOTE: If any of the requested devices or ports do not get assigned a new reference, the job cannot
be properly processed.

7.1.2

Job Presets
In this menu option, you define and store presets for jobs such as the workspace setup, commonly
used MOTF settings and automated job optimizations.
Select Job > Presets in the menu or press [Crtl]+[F11] to open the Job preset dialog.
As a user, you can define multiple configurations as a preset:
▪

Click [Add] and enter the name for a new preset.

▪

Click [Edit name] to change the name of an existing preset.

▪

Click [Delete] to remove an existing preset.

▪

Check Default if you want each new job to use this preset definition.
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7.1.2.1

Setup
This tab is used to define the setup of the workspace.

Use Cases
▪

If you use multiple scan controllers and therefore multiple scan fields.

▪

If you want to limit the usable workspace with regard to the available scan field.

▪

If you want to display part of the MOTF application's virtual field and predefine common MOTF
trigger settings.

Appearance in viewport
The defined workspace area itself can be made clearly visible by activating the display of grid lines.
Additionally, the brighter displayed sectors indicate areas that can basically be reached by the
deflection units, especially when considering the selected multi-field mode.

Fig. 7.3: ABA
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Setting

Explanation

Deflection units
Multi field mode

If more than one scan controller is connected, the controlled defection units
and their scan fields can interact in a variety of ways.
Individual fields: The different scan fields do not overlap. Use this option if
you want to execute the same job on multiple deflection units in parallel.
Check all SP-ICE-3 cards to be used for this scenario.
NOTE: The field offset is not applicable in this mode and is ignored by the
software.
Unified field: All scan fields are used together to cover a combined
workspace where layout objects can be positioned.
HINTS:
▪

If a layout object fits completely within the intersection area of the scan
fields, it is automatically processed by the scan controller listed first. This
automatic behavior can be changed in the dialog for the object settings.
For this purpose, select the Manual option and then the desired scan
controller.

▪

If a layout object extends over several scan fields, it must be split so that
each scanner can process its accessible part. RAYGUIDE splits the
layout object according to the rules listed below and taking into account
the Boundary overlap value.

Case a): If the value of the boundary overlap = 0 [mm], all paths are split
where necessary so that as few separation points as possible are created.
Example:
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Setting

Explanation

Complete layout
layout
Complete

Tiled
field
Tiledpart
partfor
forright
left field

Tiled part for right field

Case b): If the value of the boundary overlap ≠ 0, the required paths are split
in the middle of the field intersection area, and half of the boundary overlap
value extends the vectors for each scanner to the other side of the field. In
this way, the paths from both sides have a defined overlapping, which
prevents the line ends from being connected at points.
Example:
field #1
field intersection area

RAYGUIDE split line

boundery overlap

field #2
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Setting

Explanation

Overlap

Intersected field: Use if only the intersection of all scan fields is to be used to
define the available workspace where to position the layout objects.
HINT: To divide the processing load among all the scan controllers involved,
you must manually assign each layout object to one of the scan controllers.
Therefore open the object settings dialog, select Manual and select the
respective scan controller. All objects that are set to Auto are always
processed by the scan controller listed first.
Bounding box

Shows the dimensions of the shared field areas or, for 3D correction files,
the shared volume.

List control cards

The table shows the connected scan controllers. Check the ones to be used
in this configuration.
Use the offset to define how the individual scan fields are actually positioned
to each other. When using correction files with a z-area, the offset of the
zero layer is displayed in the column for the z-values. The figure next to it
shows you the result.

Correction file index

Define the index of the correction file that is to be active when the execution
of the job begins.
NOTE: The option is only usable if at least one deflection unit has been
assigned two correction files in the configuration. See section page 57,
General.

Workspace
Defines the size and position of the workspace in relation to the scan field. Typically, the workspace size matches
the scanner's field size. However, there may be special cases, such as the following:
Use case 1: A smaller workspace size will limit the area of operation. This can be necessary, for example,
because machine parts reach into the scan field area that are not hit by the laser beam. However, this may result
in a warning when the layout exceeds the defined workspace.
Use case 2: Visualize a part of the virtual field for MOTF applications so that the user can place the layout objects
accordingly. In this case, the workspace size may well exceed the size of the scan field.
Use matching size

Set the flag to force that the workspace size matches the scan field size.
Uncheck the flag if you want to edit the workspace and/or offset it.
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Setting

Explanation

Size

Desired workspace size in X-Y-Z dimension in [mm].

Field offset

Define an offset to manually arrange the workspace in relation to the scan
fields or click [Align] to use one of the predefined arrangements.

Background

Option for inserting an image as a background picture in the work area.
Valid formats are: JPG, JPEG, BMP, PNG, GIF, EXIF.
Select:
▪

Embed if the image is to be saved as part of the job.

▪

Link if you only want to link the image file to the job locally.

NOTE: The image is scaled to the size of the work area in both dimensions.
NOTE: The opacity of the background image can be set using the opacity
slider, which is part of the toolbar. See page 22, section 4.3.
Tab. 7.1: 019

7.1.2.2

MOTF

Setting

Explanation

Enable Mark-On-The-Fly

For explanations and settings for Mark-On-the-Fly (MOTF),
see page 194, MOTF Jobs.

Start trigger
Distance
Repeat trigger
Execution pitch [mm]
Tab. 7.2: 072
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7.1.2.3

Optimizations
On the following tab, you can define a selection of optimizations that are performed by RAYGUIDE
in the background and before the actual execution on the scan controller.
Setting

Explanation

General
Merge vector graphics

Merges all vector graphics to one graphic object.
Rules considered when merging: If objects vary in their main
settings such as sequences or binning, they are not merged. If
automation objects are placed in the job tree between vector
objects, the collection of the objects to be merged is terminated.
RECOMMENDATION: Since the "Sort by direction" option sorts
the paths per individual object and layer it’s recommended to use
this option if your job encompasses multiple objects that are not
sorted in the process order and the job will be executed with
MOTF condition.

Join Layer

Activate this option if, for example, you want to ensure that
concatenated paths are merged in advance.
RECOMMENDATION: Since the "Sort by direction" option sorts
the paths per single object and layer, use this option if your job
encompasses objects with multiple layers and the job is to be
executed with the MOTF condition.

Sort to minimize jumps

Activate this option to ensure that concatenated paths are merged
and jumps are re-sorted to avoid superfluous jumps.

Mark-On-The-Fly
Auto segment & Max. Width
Sort by direction & Range

For explanations and settings for Mark-On-the-Fly (MOTF), see
page 194, MOTF Jobs.

Tab. 7.3: 073
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7.2

Job Content Creation

7.2.1

About Layouts
A graphic layout defined for a laser process is always part of a specific job.
All created or imported layouts elements are displayed in the viewport by contour lines. Bitmaps
are displayed as images. Drill dots are represented by small circles.
Each layout element is also listed in the job tree on the Jobs panel.

7.2.1.1

Objects Overview
Graphic elements which make up the processing layout are called objects.
For a detailed description of the graphic elements, refer to page 93, Basic Marking Objects and
page 93, Extended Marking Objects.
Essential types of graphic objects:
▪

Vector: geometric object made of lines. Examples: circle, polygon.
Pre-formed vector objects (as available in the object toolbar) are described by mathematical
properties (e. g. diameter).
Free-formed vector objects (often imported from a graphics file) are made out of layer(s),
path(s), command(s), and the vector coordinates.
Text and code objects are made of vectors, too, defined by the actual text/code content.

▪

Drills: a single point of laser emission.

▪

Bitmaps: a raster image, processes as line of pixels, where the pixel intensity generates the
picture contrast.

▪

Graphic content of a SP-ICE3 log file.

Besides graphic objects, the following special types of objects are available:
▪

Automation objects - refer to page 158, Automation Objects.

▪

Containers - refer to page 181, Containers.
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7.2.1.2

Job Panel
This panel provides an overview of the major job properties. To open a specific job setting directly,
double-click on the corresponding entry.
Below the Job overview, the assigned scan controller(s) are shown. To open the scan controller
dialog directly, double-click on the corresponding entry.

Job Tree and its controls
All objects which are part of a job are listed in the job tree on the Job panel. The default order is the
sequence in which they have been added.
Setting

Explanation

Tree controls
Use the [Expand/Collapse] icons to expand or collapse all freely
shaped marking objects in a single step across all hierarchy
levels.
Use the [Up/Down] arrow keys to navigate step-by-step through
the job elements and their individual thumbs.
NOTE: Collapsed hierarchy elements are automatically
expanded.
Instead, use the up/down arrow keys of the keyboard if you only
want to scroll, step-by-step, in the currently expanded hierarchy of
the tree.
Use the [Hide / Unhide all] buttons to hide/show all current
layout objects in the viewport.
This option works superordinate to the single object setting.
Use the [Lock / Unlock all] icons to lock all current layout objects
in the viewport against mouse modifications in the viewport.
This option works superordinate to the single object setting.
HINT: Locked objects are always displayed with less intensity.
Use the [Reverse order] button to reverse the order of all current
job elements.
Tab. 7.4: 069

To re-arrange the order of the objects according to process requirements, use the mouse to pull
the object(s) to the desired position in the tree. Multiselection is possible.
Free-formed vector objects are always structured in the hierarchy (object > layer > path >
command). They can be expanded or collapsed by using the grey carets left of the object names.
Each single layout object listed in the job tree also provides action icons to hide/show and lock/
unlock the object in the viewport.
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7.2.1.3

Objects Panel
The objects panel (like the equivalent Objects menu) offers shortcut buttons (icons) to add objects
to the layout or draw markable objects.
The panel is divided into 4 sections separated by a red line above its section. Its appearance can
be rearranged in various ways:

7.2.1.3.1

▪

A double-click on the red line collapses/expands the section.

▪

The order of sections can be rearranged by dragging the red line of a section above another red
line.

▪

The icons within each section can also be rearranged with the mouse.

Add an Object from the Panel
▪

Click on an object icon. The object properties dialog opens, with tabs for properties, pen, filling,
and statistics (if applicable).

▪

A right click on the triangle corner opens the action menu. To add an object, select Create, and
the object properties dialog also opens.
When the properties are defined, press the [Apply] button.
The object is created and shown in the job tree and in the viewport (in the center of the
workspace if no offset has been defined).

▪

With the left mouse button, drag and drop the object onto the viewport. The object appears at
the workspace position where it was dropped. In the job tree, the object is inserted before the
previously selected object (similar to pasting it from the clipboard).

▪

With the left mouse button, drag and drop the object into the job tree. This way, the object is
inserted in the desired order position in the job tree. In the viewport, the object is positioned in
the center of the workspace if no offset has been defined.

NOTE: When a layout object was saved as a default template (see page 164, Templates), the
properties of a newly added layout object will match the template. In addition, Filling and
Transformation may be predefined in a template.
7.2.1.3.2

Draw an Object from the Panel
The small triangle corner indicates all markable objects that can be added or drawn:

Fig. 7.4: ADI

Click on the corner and select Draw if you want to draw the object with the mouse cursor.
Drawing of objects
Line

Define the start and end points of the line by clicking on the corresponding
positions in the viewport.
NOTE: If you want to draw a line chain, use the drawing mode of the
vector graphic.
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Drawing of objects
Rectangle

Define the first and second (diagonal) corners of the rectangle by clicking
on the corresponding positions.
Press [Ctrl] to fix the X/Y ratio.
When drawing, the general default settings of the object are still used (see
object-related settings).

Circle, Ellipse

Define the first and second (diagonal) corners of the object bounding box
by clicking on the corresponding positions.
Press [Ctrl] to fix the X/Y ratio.

Polygon, Spiral, Text, Define the first and second (diagonal) corners of the object bounding box
Code
by clicking on the corresponding positions.
Press [Ctrl] to fix the X/Y ratio.
When drawing, the general default settings of the object are still used (see
Object-specific settings).
Vector graphic, SPICE-3 log

First, define the start position of a path by clicking on the corresponding
positions (a single blue point appears). Right-click on the point to open the
context menu for drawing paths:

The path can now be assembled using the basic graphics commands:
Line, Circular Arc, Elliptical Arc, Quadratic Curve, and Cubic Curve.
Keep [Ctrl] pressed as long as you want a chain of the same commands.
Keep [Shift] pressed to draw vertically/horizontally only.
RULE: Each new path entity is always appended at the end of the path.
Tab. 7.5: 067
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7.2.1.4

Object Properties Dialog
To open an object settings dialog:
▪

Double-click the object in the job tree or in the viewport.

▪

Right-click the object and select [Properties] from the context menu.

▪

Select the object and press [F5].

The figure shows the object panel on the left, the workspace with an ellipsoidal object with its outer
enclosing-rectangle (red), and the ellipsoid’s [Properties] dialog:

Fig. 7.5: ABI
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The object settings dialog provides the following tabs:
▪

Properties
For further information, refer to the following sections of this manual in the appropriate chapter
for the respective object type.

▪

Pens
For details, see page 172, Pen Properties.

▪

Fillings (optional)
Layout objects that contain closed outlines/paths can also fill these areas with a line patterns,
so-called fillings.
For further information on fillings, refer to page 125, Object Fillings.

Transformations
Every layout object carries transformation information:
▪

The object's offset and therefore the position of the object center with respect to the workspace
origin.

▪

The object's size and scale factor and thus the ratio with respect to the original size (after
adding or importing a layout object).

▪

The angle of the object's coordinate system in regards to the workspace coordinate system.

For further information on transformations, refer to page 132, Object Transformation.

7.2.1.5

Object Statistics Tab
On this tab, you can display the object-related statistics. Detailed information on the provided
values is explained on page 192, Job Statistics.

7.2.1.6

Vector List Panel
To open the Vector list panel, click the corresponding tab below the job panel.
The Vector list panel shows the absolute coordinates of paths plus the end-coordinate of each
command of the currently selected object.
Coordinates are rounded to one decimal digit. Bitmaps provide no vector information.
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7.2.2

Basic Marking Objects
Basic objects and their essential properties
Basic objects in the layout are pre-formed vector objects which can be processed in one
continuous path.
Object type

Panel icon Essentially defined by (mathematic properties)

Line

Length [mm]

Rectangle

Width, height [mm], Corner radius [mm] (for rounded corners)

Polygon

Type (regular or star shaped), Radius outer circle [mm], Corner
radius [mm] (for rounded corners), number of edges

Circle

Radius [mm]

Ellipse

Radius [mm], Ratio, Orientation

Spiral

Radius [mm], Pitch [mm], Chord length [mm], Start angle [°], Inner
radius [mm],Turn direction,Feed direction
Chord length controls how smooth the spiral is rounded by defining
the length of the polyline segments.

Tab. 7.6: 023

Additional properties
Additional properties include:

7.2.3

▪

Common properties for all marking objects; refer to page 119, Common Properties of Marking
Objects.

▪

Transformations; refer to page 132, Object Transformation.

Extended Marking Objects
Compared to basic objects, extended marking objects are more complex and have more
properties.
▪

Drills (see page 94, Drill)

▪

Texts (seepage 95, Text)

▪

Barcodes (see page 99, Barcode)

▪

Vector graphics (see page 102, Vector Graphic)

▪

Bitmaps (see page 115, Bitmap)
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7.2.3.1

Drill
A drill object is used to apply the laser beam to one or more points on the material, for example, to
drill a hole or mark a dot/dot array.
Panel icon:

Essential Properties
Setting

Description

Drill
Mode

Pulse: The dwell time per drill point is defined on the basis of the number of
pulses and the frequency defined in the pen and the resulting pulse period.
Time: The dwell duration per drill point is defined directly as the target value.

Pulses / Time Number of laser pulses or duration [ms]
Import
A table of X-Y coordinates can be imported (CSV, TXT), defining a drill pattern. Click the [Import]
button to select a file. The [Reset] button dismisses the pattern and returns to a single drill point
mode.
NOTE: The first line of the import file must already contain coordinates (no text/headlines).
If you aim for a pattern with regular distances in both X and Y directions, you may integrate the
drill object in a matrix copy container. See page 181, Containers.
Unit

Unit to be applied to the coordinates being imported.

Tab. 7.7: 024

Additional Properties
Additional properties include:
▪

Common properties for all marking objects; refer to page 119, Common Properties of Marking
Objects.

▪

Transformations; refer to page 132, Object Transformation.
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7.2.3.2

Text
A text object adds text, numbers, and date/time items to your layout.
Panel icon:

Essential Properties

Fig. 7.6: ADU

Setting

Description

Text style icons
Use the well-known icons to define a bold, italic, underlined text style.
NOTE:
The underlined style is not available for circular text.
Each style will always apply to the entire text content.
Multiline adjustment icons
Use the well-known icons to define whether multiline text is left-, center- or right-aligned.
Process direction icons
Use the icons to define whether all text lines are processed from left to right, from right to left
or in both directions.
Font
Type

True Type fonts are defined by an outline. All True Type fonts installed on the PC are
available.
Stroke fonts are simple lines, provided internally by RAYGUIDE.

Font name
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Select the font to be applied.
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Setting

Description

Font height [mm]

The value defines the height of the font based on the upper case character "M".

Circular

If the text is to be fitted to an circular arc, choose between convex or concave arrangement.
Also set the radius of the circular arc.

HINT: Pay attention to the different options related to the attachment point selection.
Fixed size [mm]

Specify a fixed frame size into which the text content must fit, independent of the number of
characters and text size.
NOTE: If you only wish to fix the text length, but the text height is to be a function of the type
size, enter the fixed text length as an X value for the frame and "Zero" or the Y value.
NOTE: This option is not usable for a circular text arrangement.

Attachment point

Click on one of the fixing points:
▪

Left / middle / right points: The text is extended from this point.

▪

Upper / base / bottom points: The text is fixed for all character heights on this line.

If the text varies in length, its fixation point is also adjusted.
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Setting

Description

Data
Source

Select a source for the text.
String: Uses the text as entered from the text field below.
File: Text from a source file. In the file, the text can run over one line or over multiple lines.
Multiple lines are used with the following settings:
▪

Start: Defines the number of the line in the source file to start with.

▪

Increment: Delta of lines after the batch has been processed.

▪

Batch: The increment is only applied after n executions.

▪

File: Browse to select the data source file (TXT, CSV format)

▪

Current iteration: Displays the current increment status.

▪

Auto reset:
– Never
– Execute > Resets the iteration value every time a job get executed.
– Load > Resets the iteration value whenever a job is loaded.

▪

Flag “Wrap around”: Enable this flag if you want to continue again with the first line of the
source file when the end of the source file is reached.

▪

Flag “Cache”: This flag is set by default, as RAYGUIDE usually caches the content of the
source file in the working memory.
Disable the flag if you want to edit the content of the source file during runtime.

Date: Select one of various date format presets. In the Format field, Custom and Sortable
formats can be manually edited.
Increment: Creates a number that will be incremented as follows.
▪

Start: Number to start with.

▪

Increment: Delta in counter after the batch has been processed.

▪

Batch: The increment is only applied after n executions.

▪

Digits: How many leading zeros are added to the number.

▪

Current iteration: Displays the current increment status.

▪

Auto reset:
– Never
– Execute: Resets the iteration value every time a job gets executed.
– Load: Resets the iteration value whenever a job is loaded.

Custom: Text/number characters and date/time items can be combined.
Click the [Placeholder] icon to display a list with predefined placeholders for several formats.
You may combine them according to your needs.
Optional fields in case the custom string contains an incrementing number:
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▪

Start: Number to start with.

▪

Increment: Delta in counter after the batch has been processed.
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Setting

Description
▪

Batch: The increment is only applied after n executions.

▪

Digits: How many leading zeros are added to the number.

▪

Current iteration: Displays the current increment status.

▪

Auto reset:
– Never
– Execute > Resets the iteration value every time a job get executed.
– Load > Resets the iteration value whenever a job is loaded.

HINT: The date separator character corresponds to the local format in the operating system.
Add character

Click on the label and a dialog opens where to select special characters that are not part of
the regular alphabet.

Log

Available option if the content of the text is variable. You can define a file (name and location)
which then logs all text content that is processed. The log always adds a timestamp per
processed content.

Text

Text for the string source. In case of a custom source, it shows the date format or the
placeholders.
HINT: The size of the text field in the dialog can be adjusted. Click on the black triangle in the
lower right corner and drag it using the mouse until it reaches the desired size. Otherwise,
the text will wrap automatically.

Resulting text

In this line you see the resulting text that appears after you have pressed the [Apply] button.

Tab. 7.8: 025

NOTE: Variable text content features are not supported when a job is executed on card level.

Additional Properties
Additional properties include:
▪

Common properties for all marking objects; refer to page 119, Common Properties of Marking
Objects.

▪

Transformations; refer to page 132, Object Transformation.
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7.2.3.3

Barcode
Barcode is a layout element which codes contents either by a barcode using lines with different
widths or by 2D codes using filled cells.
Panel icon:

Essential Properties
Setting

Description

Barcode
Type

List of all available standard code types. The last three code types used are shown in
extra list on top.
The most common 2D codes like Datamatrix, QRCode, MicroPDF, PDF417, as well as
common barcodes like Code 128, Codabar and many more are offered.

Optional code settings: Depending on the selected code type, one or more optional settings are available. A
detailed explanation of their purpose and the available parameters can be found in the code library manual
contained in this PDF.
Below, some of the generic settings are explained.
Subset

Some codes are grouped to certain types. The specific code is defined here, e. g. Type
= Postal > SubType = AustralianPstRouting
See the code library manual for details.

Code format

Code format, available for some types.

Size mode

Choose if you want to fix the size of the 2D code or the size of a code cell.

Cell size [mm]

Enter the size of code cells in [mm].
Usable only for 2D codes

Size

Enter the size of the complete code in [mm].
For other codes than 2D, the size value refers to X-dimension.

Invert

Inverts the appearance of the code pattern. In case of inverted it is recommended to
define the “Quiet zone” as well to get a black frame surrounding the code pattern.
Useful when marking on a dark material.

Quiet zone [cells]

An area free of any printing or marks that precedes the start character of a barcode
and follows the stop character of the barcode.
See the code library manual for details.

Translate escape
sequences

Check this box if you want to use non-printable or special characters in a barcode,
preceded by an escape sequence, e.g. a backslash. It is recommended to specify the
values for the ASCII characters primarily in HEX format and not in decimal format.
Some typical examples are:
GS (Group Separator) = \x1d
RS (Record Separator) = \x1e
EOT (End of Transmission) = \x4
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Setting

Description

Show text

This option is only available for 1D barcodes.
Deselect this option if the code is to be created without the readable text. Otherwise, it
will be included with the 1D barcode by default.

Data
Source

Select a source for the text.
String: Uses the text as entered from the text field below.
File: Text from a source file. In the file, the text can run over one line or over multiple
lines. Multiple lines are used with the following settings:
▪

Start: Defines the number of the line in the source file to start with.

▪

Increment: Delta of lines after the batch has been processed.

▪

Batch: The increment is only applied after n executions.

▪

File: Browse to select the data source file (TXT, CSV format)

▪

Current iteration: Displays the current increment status.

▪

Auto reset:
– Never
– Execute > Resets the iteration value every time a job gets executed.
– Load > Resets the iteration value whenever a job is loaded.

▪

Flag “Wrap around”: Enable this flag if you want to continue again with the first line
of the source file when the end of the source file is reached.

▪

Flag “Cache”: This flag is set by default, as RAYGUIDE usually caches the content
of the source file in the working memory.
Disable the flag if you want to edit the content of the source file during runtime.

Date: Select one of various date format presets. In the Format field, Custom and
Sortable formats can be manually edited.
Increment: Creates a number that will be incremented as follows.
▪

Start: Number to start with.

▪

Increment: Delta in counter after the batch has been processed.

▪

Batch: The increment is only applied after n executions.

▪

Digits: How many leading zeros are added to the number.

▪

Current iteration: Displays the current increment status.

▪

Auto reset:
– Never
– Execute: Resets the iteration value every time a job gets executed.
– Load: Resets the iteration value whenever a job is loaded.
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Setting

Description
Custom: Text/number characters and date/time items can be combined.
Click the [Placeholder] icon to display a list with predefined placeholders for several
formats. You may combine them according to your needs.
Optional fields in case the custom string contains an incrementing number:
▪

Start: Number to start with.

▪

Increment: Delta in counter after the batch has been processed.

▪

Batch: The increment is only applied after n executions.

▪

Digits: How many leading zeros are added to the number.

▪

Current iteration: Displays the current increment status.

▪

Auto reset:
– Never
– Execute > Resets the iteration value every time a job gets executed.
– Load > Resets the iteration value whenever a job is loaded.

HINT: The date separator character corresponds to the local format in the operating
system.
Statistics

Characters = Displays the number of characters from the defined content, as the code
size depends on it.
Cells = Displays the number of cells per code row/column (available only for 2D codes)

Tab. 7.9: 026

NOTE: Variable code content features are not supported when a job is executed on card level.

Additional Properties
Additional properties include:
▪

Common properties for all marking objects; refer to page 119, Common Properties of Marking
Objects.

▪

Transformations; refer to page 132, Object Transformation.
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7.2.3.4

Vector Graphic
A vector graphic consists of a collection of geometric figures such as lines, polylines, Beziercurves, circles and ellipses, which can be mathematically described.

Panel icon:

Structure of vector graphics
A vector graphic always has a hierarchical structure:
object > layer > path > command
A layer is a group of paths, a path is a chain of commands, and a command is a mathematically
described geometric figure. This manual refers to layers, paths, and commands as (graphic)
elements.

Fig. 7.7: ADA

▪

Layers: All graphics content is contained in one or more layers. A layer contains one or more
paths. Its entity entry also displays the count of its paths.

▪

Path: A path is a continuous line or outline (straight and/or curved) that can be processed with
continuous laser emission. A path can be open (start and end point are not identical) or closed.
All path segments are described by commands.

▪

Commands: A command is either a geometrical object (described mathematically) or a processrelated instruction. There are 5 plus 2 types:
─ Polyline: A straight line or a combination of straight lines, defined by vector coordinates
─ Arc: A segment of a circle, defined by an angle and by the center point
─ Ellipse: A curve surrounding two focal points
─ Quadratic curve: A parabola that is the graph of a quadratic function
─ Cubic curve: A curve described by cubic equations
Two commands control the laser behavior within a path:
─ Laser on: Turns the laser on for a defined amount of time. Similar to drill object.
─ Set pen: Selects another pen to switch to different process parameters.

NOTE: The start point coordinate of each command is either the coordinate of the path-entity (if
first command) or the end point of the previous command.
In the command dialog, however, the "start coordinate" is additionally displayed as read-only
information.
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HINT: Some commands additionally display information like length or radius.
For each type of hierarchical graphic element, a settings dialog is used to define the element's
properties. Double-click an element or choose Properties from its context menu.
The following table explains all settings for layers.
Setting

Explanation

Tree Icon
Index

When adding a layer: Order number of the layer within an object

Name

Optional name of a layer

Sequences

The sequence "inherits" the layer from the object structure layer.
The process runs defined in the sequence cannot be changed in
the layers structure layer, but the pens used can be changed if
necessary.

Mark

Selection indicating whether this layer is to be executed with all its
paths or not.
NOTE: If you merge multiple layers with different settings, you
obtain 2 layers: one that contains all paths to be marked, and one
that contains all paths that are not to be marked.

Tab Fillings
The layer itself can be filled with the default fill options.
NOTE: Only closed areas of paths are considered by the fill routine.
NOTE: When you are processing a layer, you are in the processing mode. This means that the
filling will not be visible until you leave the processing mode. The layer symbol is now grayed out.
Tab. 7.10: 027

The following table explains all settings for paths.
Setting
Tree Icon

Explanation
for closed paths
for open paths

Index

When adding a path: Order number of the path within a layer

Sequences

The sequence "inherits" the path from the object structure layer.
The process flow defined in the sequence cannot be changed in the
path structure layer, but the pens used can be changed if
necessary.

Location

Coordinates of the path's start point
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Setting

Explanation

Tab Fillings
A closed path itself can be filled with the standard fill options.
Open paths can either use the inset fill with a counted number of contour lines or the filling ends
at virtual closing lines.
NOTE: The path filling routine does not consider closed areas that arise in combination with other
paths.
NOTE: When you are processing a path, you are in the processing mode. This means that the
filling will not be visible until you leave the processing mode. The path symbol is now grayed out.
Tab. 7.11: 028

For commands, the settings depend on the command type. The following table explains the
settings for commands.
Setting

Explanation

Polyline
Adds a coordinate point before or after the actual coordinate point
command.
Removes a point with or without closing the gap by connecting the
next nearest points.
Moves a point up and down in the sequence of the points.
Splits the command in two polylines before the marked point.
Arc
Angle [°]

Angle in degrees. Positive values turn counterclockwise, negative
values turn clockwise.

Center [mm]

Coordinates of the virtual center point of the arc.
The radius results from the distance between start and center.

Ellipse
Sweep angle [°]

The angle the contour will cover.

Orientation angle [°]

The angle of the longer side axis in relation to the coordinate
system of the object.

Axes ratio

Ratio of the longer axis to the shorter axis.

Center [mm]

Coordinate of the center point.

Quadratic curve
Control point [mm]

Coordinates to define the point positions.

End point [mm]

This curve is defined using one Control point.
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Setting

Explanation

Cubic curve
Control point 1 [mm]

Coordinates to define the point positions.

Control point 2 [mm]

This curve is defined using two Control points.

End point [mm]
Laser on
Same concept as the drill object. The laser turns on for a defined amount of time. The coordinate
is either the coordinate of the path-entity (if first command) or the end point of the previous
command.
Mode

Select Pulse to enter the number of laser pulses to apply at this
point.
Select Time to enter the duration of laser application at this point.

Pulses or Time

Number of pulses or time in µs

Set pen
Pen number

Pen (from the job's base pen set) to be used for the succeeding
commands. Use the [Edit] button to edit the pen's properties.

Tab. 7.12: 029

You can add any hierarchy element by using the context menu of the superior hierarchy element.
For example, use a layer's context menu to add a new path.

Import, conversion or creation of a vector graphic
In most cases, the vector graphic is generated in a CAD or design program and imported into the
workspace from a file.
To add a vector graphic to the job by import it, you have the following options to choose from in the
corresponding import dialog:
▪

Click on [Vector graphic] in the object panel.

▪

Main menu: File > Import > Vector graphic

▪

Main menu: Objects > Vector graphic and then double-click on the corresponding entry in the
job tree.

▪

Drag the mouse from the [Vector graphic] button in the object panel (holding down the left
mouse button) to the desired position in the job tree and then double-click the corresponding
entry.

Alternatively, you can also drag the vector file(s) directly from the Explorer folder into the viewport.
In this case, the import dialog is skipped for the time being, as the default settings for the import are
applied.
The subsequent import dialog for vector graphics makes the following settings available:
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Fig. 7.8: ADS
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Setting

Description

Import settings
File

Opens a file browser to navigate to the graphic file you want to import. After selecting
the file, click [Open] in the browser and the preview displays the file content.
If files were already previously imported, these are made available in the drop-down
list for renewed selection.
Supported file types are: DXF, PLT, SVG, DWG, CGM, HPGL, GBR, CSV*, TXT*.
*You can import an outline realized as polyline defined as a coordinate table: X / Y /
(Z) / Pen Number.
Valid separators are: Space, Semicolon, and “\\t”.

Scale to size

Activate to scale the size of the imported graphic to the specified size in [mm].

Unit

Defines the unit of the imported vectors. This is usually the value=1 and the unit in
which the layout was created. Select from [mm], [µm] and [inch]. A value ≠ 1 would
additionally add a scaling factor to it. Only applicable if scaling is not used.

Center XY

Incorporates the vector graphic centered on the XY axes of the workspace.

Align Z [mm]

Specification of the Z position in [mm], according to which either the upper side,
center position or underside of the 3D vector graphic file aligns itself when importing.

Import hidden elements

Some file formats (e.g. DXF) can contain hidden layers. By default, these layers get
skipped when ignored. Use this option if to import them anyway.

Mirror direction

Activate the toggle icons for the X/Y/Z direction if the vector graphic is to be mirrored
accordingly when imported.

Overwrite pens

Overwrites the pens defined for the job (only the color and the dashed line pattern
setting) by the pens defined in the imported file.

Unify colors/pens

Assigns the job’s default pen to all layout elements of the imported graphic. Thus, all
original multiple colors are unified to one color = one pen.

Optimizations
Optimization functions applied in the import process.
Sort vectors

Optimizes the vector order to reduce jumps and to get a time-optimized vector
sequence.

Set z-coordinates to zero

If the imported graphic contains Z coordinates that are not zero, they will be reset to
zero.

Remove drills

Deletes inadvertent drill points from the graphic.

Join layers

Merges multiple layers to one layer.

Remove straight points

Deletes unnecessary intermediate points from polylines. If points are on a straight
line between the end points, they can be removed. This speeds up the marking
process.
A corresponding tolerance value can be set in the system preferences: System>
Preferences > User (current user), Tolerances tab, Collinear distance.

Replace straight curves by Converts curve elements that are straight into straight line elements.
lines
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Setting

Description
The corresponding tolerance value, which determines how close the curve shape
equals a straight line, is defined under System > Preferences > User (current
user), Tolerances tab, Collinear distance.

Concatenate similar arcs

Combines multiple arcs to one arc, if they appear to have same radius and the same
center coordinate.
The corresponding tolerance value to determine if the center points are equal is:
System > Preferences > User (current user), Tolerances tab, Location.

[Save as default]

Icon to save the created settings as default settings for future imports of vector
graphics.

Tab. 7.13: 030

NOTE: Once a vector graphic file has been imported, the object properties provide only the most
common settings: General, Bounding Box, Transformation.

Additional Settings
Additional settings include:
▪

Common settings for all marking objects, refer to page 119, Common Properties of Marking
Objects.

▪

Transformations; refer to page 132, Object Transformation.

Additional layers, paths, and commands can always be added to a vector graphic in RAYGUIDE
even after import.
It is also possible to convert a pre-formed vector object into a free-shaped vector graphic: Open an
object's context menu and select Convert to vector graphic.
Alternatively, you can generate a vector graphic performing the following base-steps:
1. Add a new vector object with no import file associated to it to the job-tree
2. Add a new layer to the empty object
3. Add a new path to the empty layer
4. Add a new command to the empty path
Another alternative is to “draw” the graphic directly, refer to page 89, Draw an Object from the
Panel.

7.2.3.5

Dynamic vector graphic
Dynamic vector graphics primarily differ by the kind of usage compared to regular vector graphics.
Every time the job is reloaded, the graphic is to be automatically imported again from the
referenced source file. Likewise, when job execution is repeated, this graphic can be imported
again from the referenced source file. This enables you to mark graphics that change dynamically
with the changing content of the source file.
In return, the dynamic vector graphic does without the basic structure in the job tree of the regular
vector graphic (Object > Layer > Path > Entity). Modifications to the graphic can only be made
directly during the import using the standard import options. See page 102, Vector Graphic.
Panel Icon:
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Dynamic vector graphics can only be added to a processing job by importing a corresponding
graphic file.
▪

To add a dynamic vector graphic to the job by importing it, you have the following options to
choose from in the corresponding import pop-up dialog:

▪

Click on [Dynamic vector graphic] in the object panel.

▪

Main menu: File > Import > Dynamic vector graphic

▪

Main menu: Objects > Dynamic vector graphic and then double-click on the corresponding
entry in the job tree.

▪

Drag the mouse from the [Dynamic vector graphic] button in the object panel (holding down
the left mouse button) to the desired position in the job tree and then double-click the
corresponding entry.

The subsequent import dialog for dynamic vector graphics makes the following settings available:
Setting

Explanation

Import settings
Primarily the same import settings are available to you here that are also available for the regular
vector graphic; see page 102, Vector Graphic.
Automatic reload

Check if the vector graphic is to be re-imported from the
referenced source file every time the job execution is repeated.

Optimizations
Optimization functions applied in the import process.
The same optimization functions are available to you here that are also available for the regular
vector graphic; see page 102, Vector Graphic.
Tab. 7.14: 087

NOTES on application:
If the changing graphics have slightly different dimensions or positions in the original graphic file,
but should always be marked in the same position and more or less with the same size in the
RAYGUIDE job, it is useful to use the following import settings: Center XY and Scale to size. An
additional object transformation then acts equally on all automatic graphic imports.
If graphics are imported in the sequence that otherwise are partially or completely outside of the
workspace area, the geometry validation will not be able to catch this. Consequently, there will also
be no marking.

Dynamic vector graphics within a copy container
In general, the graphic is reloaded per copy during execution, provided that the container option
Single output is not selected. The decisive factor here is whether you manage to exchange the
contents of the referenced source file fast enough before marking of the subsequent copy starts.
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7.2.3.6

Solid
A solid represents a 3-dimensional volume, or its surface. The surface is described using triangular
facets in the STL file format currently in use.
The solids being imported are primarily used for laser processes such as deep engraving, "in-glass
marking" and additive manufacturing. The solid is always divided into horizontal slices that are
processed in a specific order, and are usually also provided with a filling. The focal position is
changed between the filled slice geometries. This requires the use of an appropriate deflection unit
(e.g. RAYLASE FOCUSSHIFTER, AXIALSCAN, AS-FIBER, AM-MODULE) and the corresponding
configuration with a 3-dimensional correction file.
Panel Icon:
To add a solid object to a job, you have the following options:
▪

Click on [Solid] in the object panel.

▪

Main menu: File > Import > Solid

▪

Main menu: Objects > Solid and then double-click on the corresponding entry in the job tree.

▪

Drag the mouse from the [Solid] button in the object panel (holding down the left mouse button)
to the desired position in the job tree and then double-click the corresponding entry.

The subsequent import dialog for solid objects makes the following settings available:

Fig. 7.9: AEN
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Setting

Explanation

Import settings
File

Opens a file browser to navigate to the file of the solid you want to
import. After selecting the file, click [Open] in the browser. The
preview displays the file content.
If files were already previously imported, these are made
available in the drop-down menu for renewed selection.
The supported file format is: *.STL (stereolithography file)

Scale to size

Activate to scale the size of the imported solid to the specified
size in [mm]. It is always the longest edge of the bounding box
that is scaled to the value.

Unit

Defines the unit of the coordinates being imported. This is usually
the value = 1 and the unit in which the file was created. Select
from [mm], [µm] and [inch]. A value ≠ 1 would additionally add a
scaling factor to it. This can only be applied if the "Scale to size"
option was not yet used.

Center XY

Incorporates the solid object centered in the XY axis view
(corresponds to the view from above) of the workspace.

Align Z [mm]

Specification of the Z position in [mm], according to which either
the upper side, center position or underside of the solid aligns
itself when importing.

Mirror direction

Activate the toggle icons for the X/Y/Z direction if the solid is to be
mirrored accordingly when imported.

[Save as default]

Icon to save the created settings as default settings for future
imports of body objects.
NOTE: For solid objects, the standard also contains the settings
for the slices.

Tab. 7.15: 085

The following settings are available for importing solid objects and can be found in the object
settings:
Setting

Explanation

Slices
∆Z [µm]

The distance between the slices in [µm]. Depending on the
process direction, the value is specified either from the upper
edge or the lower edge of the solid.

First layer offset [µm]

The distance between the absolute highest point of the solid and
the first slice shown in the navigator (see page 22, Toolbar).
NOTE: Due to the nature of STL files (triangular facets of the
surface), it can happen that individual points minimally protrude
beyond a surface that appears to be flat. If a slice was displayed
here, it would consist of only one point or a fragment of a slice.

Processing direction
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Select whether the slice of a solid is to be processed from top-tobottom (e.g., for deep engraving) or from bottom-to-top (e.g., for
additive manufacturing).
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Setting

Explanation

Negative (mold)

Define whether the STL file being imported contains the solid as a
negative form.
This selection determines which areas of the slices are filled, for
example for the engraving process.
Example of an STL file with a negative form for deep engraving:

Number of slices

Shows the number of slices resulting from the object height and
∆Z.
NOTE: This display is only available in the object settings, not in
the import dialog.

Tab. 7.16: 086

NOTES on the character of the solid:
We recommend, regardless of the laser application, to primarily use solids that do not represent a
negative form.
If negative forms are used, note the following:
The number of slices is not based only on the depth of the negative form, but also on the total
component height. Thus, empty slices can also occur in the slice navigator.

© 2022 RAYLASE GmbH

RAYGUIDE Manual V1.12

112

7 LASER PROCESS JOBS

Special case of a negative form
When the negative form reaches to the edge of the solid.
Example:

Fig. 7.10: AEO

In this case, the outer contour is interrupted in some slices, which would lead to an unusable filling
result when using the regular filling routine. For this reason, the Invert fillings option must be used
in these cases (see page 125, Object Fillings). At the same time, the "Filling only" marking mode
must be used as otherwise the outermost boundary contour for the filling is executed for all slices.
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Further special case of a negative form
The surface to be engraved is not flat.
Example:

Fig. 7.11: AEP

This type of solid for deep engraving is not supported.
NOTE on solid objects and sequences:
▪

In solids, each slice geometry is treated as a Layer hierarchy element.

▪

For this reason, the Execution loop assignment option is set to Layer by default.

▪

The Alternate contour/filling option is likewise set by default.

NOTE on solid and execution options:
▪

The Quick mark option only executes the currently selected slice.

▪

The preview likewise only shows the selected slice.

NOTE on solid and statistics:
▪

For a solid object, the statistics (regardless of whether object statistics or job statistics) only
show the values for the active slice. In addition, the number of slices based on the height of the
complete solid is indicated.
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7.2.3.7

Bitmap
A bitmap graphic is a two-dimensional array of pixels, representing an image. It is always imported
from a file. The grayscale value of each pixel is either translated into a laser power value or into the
time of laser emission per pixel.
Panel icon:
To add a bitmap graphic to the job, it must be imported.
To open the import dialog, you can choose between the following options
▪

Click on [Bitmap] in the object panel.

▪

Main menu: File > Import > Bitmap

▪

Main menu: Objects > Bitmap (Bitmap), and then double-click on the corresponding entry in
the job tree.

▪

Drag the mouse from the [Bitmap] button in the object panel (holding down the left mouse
button) to the desired position in the job tree and then double-click the corresponding entry.

Alternatively, you can also drag the bitmap file(s) directly from the Explorer folder into the viewport.
In this case, the import dialog is skipped for the time being, as the default settings for the import are
applied.
The subsequent import dialog for bitmap graphics makes the following settings available:
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Fig. 7.12: AEQ

Setting

Description

Image processing
File

[Load file...] opens a file browser to select a bitmap file.
Choose the Insert option to embed the file content into the job file (important if you
want to send the job file to another user).
Choose Link to File to store only the file path in the job file.
Supported file formats: JPG, BMP, EXIF, GIF, PNG, JPEG.

Mode

Sprint: The scanner moves in lines with continuous speed and emits one laser pulse
per pixel.
The grayscale value of the pixel modulates the laser power, resulting in the desired
degree of contrast.
The grayscale value has a resolution of 16 bit.
PointAndShoot: The scanner jumps from pixel to pixel and stays at the pixel for a
certain duration, according to the grey value, in order to reach the desired degree of
contrast.
NOTE: "White" pixels are automatically skipped.

Bidirectional
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Setting

Description

Scan direction

Sets the major processing direction:
Horizontal: Starts at the bottom row and continues line wise upwards.
Vertical: Starts at the left side and continues line wise to the right side.
APPLICATION HINT: For bitmaps with a vertically orientated rectangle shape,
vertical processing is more time-saving as it reduces the number of bitmap lines and
therefore the number of line wraps.

Invert pixel

Inverts the grayscale value of each pixel. The appearance of the bitmap in the GUI
does not change.

Power scale [%] Min/Max

Scales the laser power per pixel grayscale value in a linear fashion between the
minimum and maximum power.
Example: If 80% laser power already results in a completely black pixel, any excess
would probably cause laser burns and consume time. For this reason, 80 should be
set as the maximum value in this case. Likewise, a minimum value may be
necessary for the laser effect in order to generate any effect on the material at all.

Exposure time [µs]

Only relevant for PointAndShoot mode.
Maximum duration [µs] that the laser emits on a pixel. The actual time is modulated
by the grayscale value of the pixel.

Modulation type

Time: The grayscale value of the pixel modulates the emission time, resulting in the
desired degree of contrast.
Power: The grayscale value of the pixel modulates the laser power, resulting in the
desired degree of contrast.

Trim scan lines / Threshold Bitmaps are always imported as rectangular objects. However, the lines of the
bitmap do not necessarily begin or end with visible pixels.
Enable this feature to shorten the marking time for the bitmap by completely omitting
pixels which are equal to or exceed the specified threshold value (255 = White).
Instead of moving to any pixel position in any line regardless of visibility, the
scanners move immediately from the last visible pixel of the current line to the first
visible pixel of the next line.
Size
Resolution [dpi]

Sets the pixel resolution in [dpi] (dots-per-inch) for the X and Y directions. More dots
per inch result in a finer resulting image, however, the image will take more time.
The X-Y ratio can be locked/unlocked with the [Lock / Unlock] button.
Keep size forces the resulting image dimensions to remain at the original size regardless of the specified resolution.

Pixels
Pixel distance [mm]
[Save as default]

Displays values for the number of pixels in the X-Y direction and the pixel spacing
corresponding to the currently set resolution.
Click on [Save as default] to save the created settings as default settings for future
imports of bitmaps.

Tab. 7.17: 031
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Additional Settings
Additional settings include:
▪

Common settings for all marking objects, refer to page 119, Common Properties of Marking
Objects.

▪

Pen settings, detailing object-related process parameters; refer to page 172, Pen Properties.

NOTE on display: Bitmaps are always displayed in gray scale, with the opacity of the pixels
corresponding to their grayscale value. This makes it possible to see the superimposed graphics in
the same way as they are marked on the material, regardless of their sequence in the job tree.
Example:

Fig. 7.13: AEL
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7.2.4

Common Properties of Marking Objects
The table shows settings that are similar for all object types. They are included in the setting
dialogs of all objects.
Setting

Explanation

General
Short label

Appropriate name for the object, according to its content/purpose. For
imported files, the file name is used by default.

Enable binning

Starts object processing only if a specified condition is fulfilled. A dialog
opens where bit patterns are defined on an inbound port:
I/O controller: Select the scan controller where the IO Signals will arrive.
I/O port: Select the preconfigured I/O port of the respective scan controller
(see page 40, Scan Controller Configuration, I/O section).
Binning Value: Set the bit pattern to be received to process this object.
You can also use the masking technique. For details, see page 40, Scan
Controller Configuration, Port Masking section.
The "Ahead-of-time evaluation" option is set by default and ensures that
the binning value (bit pattern) is checked in advance so no time is lost
during the process. In cases in which the condition may only be set when
the object is about to be processed, this option should be disabled. This
may be the case after a preceding wait condition, for example.

Sequences

The pens that the object uses are assigned here, arranged by outline and
filling. The pen for the filling is, as a rule, preselected in accordance with
the pen for the outline.
In addition, the number of passes is defined. The number of passes can
also be set to "Infinite". This infinite loop can only be exited by canceling
the execution either using the [Abort] button or with an external stop
signal at the scan controller. However, this leads to the fact that
subsequent objects or sequences will never be executed.
The number of executions is also passed on to all lower-level structure
layers and cannot be changed there.
The number of execution loops and the pens used in the process are
referred to as sequences.
The "+" can be used to add more sequences, which are executed one
after the other.
NOTE: The colored depiction of the pens always corresponds to the 1st
sequence.
NOTE: If, in a sequence, a pen with power ramp(s) is used in order to
repeat one or more closed contours with n-iterations, the execution loop
must be assigned to the path structure-level in order to obtain only one
start ramp at the beginning and one end ramp at the end of the execution
loop.
Below the table, further explanations are presented on the basis of various
examples.

Mark
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Setting

Explanation

Marking mode

Use the available options to select whether contour and/or filling are to be
executed and in which order to each other.
Select if only filling or outline is to be marked, or filling before outline, or
filling after outline.

Alternating contour /
filling

Use this option if you want to change between outline and filling per
executions within one sequence. REQUIREMENT: The filling must have
been used on the same structure layer as selected in the subsequent
assignment.

Execution loop
assignment

Defines whether the whole object, only a whole layer, or only a path is to
be executed in the loop before the next loop, if any, starts.

Scan controllers

Only appears if the job is assigned to several scan controllers. Set to
"auto" by default.
In auto mode, RAYGUIDE logic automatically assigns the layout object to
the first listed scan controller. Select "Manual" if you want to manually
select the explicit scan controller for the object.
HINT: This setting is only relevant if the complete layout object can in
principle be executed by several scan controllers.

BoundingBox
Size, Center

Read-only values, showing the size of an imaginary orthogonal rectangle
surrounding the whole object.

Tab. 7.18: 032

An additional group of common settings are object transformations; see page 132, Object
Transformation.

Examples for sequences
How a sequence will be executed ultimately depends on the sequence itself, the execution mode,
the assignment of the execution loop and the option to alternate between the filling and outline.
Legend:
▪

[…] = encloses a sequence

▪

{…} = encloses a pass (= execution loop)
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Example 1: (2 sequences with different pens for outline and filling, outline before filling)

Fig. 7.14: AEG

Executed order:
[2 x complete outlines with pen 1 > 2 x filling with pen 2] > [3 x complete outline with
pen 3 > 3 x filling with pen 4]
Example 2: (here, in contrast to example 1, the alternate outline/filling option is enabled)

Fig. 7.15: AEH

Executed order:
[{1 x complete outline with pen 1 > 1 x filling with pen 2} > {1 x complete outline with
pen 1 > 1 x filling with pen 2}] >
[{1 x complete outline with pen 3 > 1 x filling with pen 4} > {1 x complete outline with
pen 3 > 1 x filling with pen 4} > {1 x complete outline with pen 3 > 1 x filling with pen 4}]
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Example 3: (here, in contrast to example 2, the assignment of the execution loops is set on the
path layer)

Fig. 7.16: AEI

Executed order:
[2 x 1st path with pen 1] > [3 x 1st path with pen 3] >
[2 x 2nd path with pen 1] > [3 x 2nd path with pen 3] >
…
[2 x 6th path with pen 1] > [3 x 6th path with pen 3] >
[2 x filling with pen 2] > [3 x filling with pen 4]
Each path is run through in accordance with the number of executions of a sequence before the
next path is started. However, there is no alternating between outline and filling. The reason for this
in this example is that the filling is on the object layer while the sequence was assigned to the path
layer.
NOTE: Alternating between outline and filling only works if the filling is assigned to the
corresponding structure layer; see the following example 4:
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Example 4: (here, 2 of the circles on the path layer were filled)

Fig. 7.17: AEJ

Executed order:
[2 x 1st path with pen 1] > [3 x 1st path with pen 3] >
[{1 x 2nd path with pen 1 > 1 x filling 2nd path with pen 2} >
{1 x 2nd path with pen 1 > 1 x filling 2nd path with pen 2}]>
[{1 x 2nd path with pen 3 > 1 x filling 2nd path with pen 4} >
{1 x 2nd path with pen 3 > 1 x filling 2nd path with pen 4} >
{1 x 2nd path with pen 3 > 1 x filling 2nd path with pen 4}]>
[{1 x 3rd path with pen 1 > 1 x filling 3rd path with pen 2} >
{1 x 3rd path with pen 1 > 1 x filling 3rd path with pen 2}] >
[{1 x 3rd path with pen 3 > 1 x filling 3rd path with pen 4} >
{1 x 3rd path with pen 3 > 1 x filling 3rd path with pen 4} >
{1 x 3rd path with pen 3 > 1 x filling 3rd path with pen 4}] >
[2 x 4th path with pen 1] > [3 x 4th path with pen 3] >
[2 x 5th path with pen 1] > [3 x 5th path with pen 3] >
[2 x 6th path with pen 1] > [3 x 6th path with pen 3] >
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7.2.4.1

Edit common object properties
It may be necessary to assign the same number of passes for all marking objects, for example.
Instead of changing this parameter object by object, you can change it for a multi-selection of
objects:
▪

Select all required objects in the tree.

▪

Right mouse click > context menu

▪

Select Common properties.

▪

Edit the desired parameter and it will apply to all selected objects.

Fig. 7.18: ADY

NOTE: If all objects are of different types, only the general properties are available for editing. If the
objects (only basic marking objects) are of the same type (e.g. rectangles), you can also edit the
object-specific parameters.
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7.2.5

Object Fillings
A two-dimensional vector object which has at least one closed path, can be filled with a pattern.
Individual layers or path elements of a freeform vector object can also get filled. Please note the
rules mentioned in the tables, refer to page 102, Vector Graphic.
The example shows a vector graphic before and after filling with a spiral pattern:

Fig. 7.19: ABJ

Fig. 7.20: ABK

A filling applies only to a selected object.
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If an object contains paths which lay inside each other, the filling starts with the outermost area,
skips the next area, and continues with the next area, and so on.
If the closed paths create intersecting areas, the filling algorithm will fill or not fill these areas
alternatingly.
Example:

Fig. 7.21: ABL

To create a filling, select an object, open its properties dialog, and go to the Fillings tab. To add a
filling, click the red [Add] sign. Select a filling type:
Type

Explanation

Hatching

Parallel lines

Inset

Duplicates the outline contour of the respective area continuously
towards the inside of the object.
The inset fill follows the outer contour, while inner contours are cut
out of the fill pattern like a stencil.

Spiral

The fill pattern is defined by a single spiral. Here, the object contour
acts like a mask that lies in front of this spiral and whose closed
areas alternately show the background spiral.
Spiral-specific value: Chord length.

Drill points

The fill pattern consists of a homogeneous arrangement of drill points.

Cell hatching

Defines a discrete number of fill lines per cell. Only available with
barcode type objects, most useful for 2D codes.

Cell drill

Define the number of point grids per cell. Only available with
barcode type objects, most useful for 2D codes.
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Type

Explanation

Cell circle

Fills a 2D code cell with circles.
Only available with barcode type objects, most useful for 2D codes.

Tab. 7.19: 033

Multiple fillings can be added and combined.
NOTE: If you have chosen a small pitch value and you do not see the fill lines as separated lines,
you can reduce the display stroke width (in the main toolbar).
Each filling type has its own properties dialog:
Setting

Explanation

Common settings for all fill styles
Pitch [mm]

Distance between fill lines

Invert*

Inverts the filling logics. A virtual rectangular frame is always drawn
around the layout object as the outer filling boundary. In doing so,
the following parameter of the quiet zone is taken into account.

Quiet zone*

Entry in [mm] indicating the distance between the virtual
rectangular frame and the layout object. The value always has a
positive sign, and zero is permitted.
NOTE: The object size is adjusted according to the filled quiet
zone. The red, enclosing rectangle continues to be in relation to the
actual layout object.

Sort

Select whether the processing sequence of the fill-lines and thus
the jumps should be optimized automatically to save process time.
Check, if you want the filling to be processed with the minimum
number of required jumps to save process time.
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Setting

Explanation

Padding [mm]

Creates a non-filled frame between filling and respective filling
outline.
Positive values generate a distance toward the inside (from the
contour to the filling), while values with a negative sign generate a
distance toward the outside.
NOTE: For 2D codes, connected cells are filled together. The
parameter operates differently depending on whether a specific cell
filling or a generic filling is used:

Additional settings for hatching
Angle [°]

Angle of fill lines related to the object's own coordinate system!
NOTE: The fill lines are processed from the bottom to the top by
default (with respect to the object). To change processing from the
top to the bottom, an angle of 180° must be entered.

Delta angle

Angle in degrees by which the filling rotates per execution.

Offset [mm]

Shifts the filling vertically to the fill line direction by the respective
value.

Delta shift

Shift of the fill lines in [mm] by which the fill lines move per
execution.

Cross hatch

Select to define a cross hatch filling style. Equal spacing is used for
both directions and the cross angle is fixed to 90 degrees.
If you want the filling directions to be at a different angle to each
other, simply add a second filling and define the angles accordingly.
If you require a different cross angle, simply add a second hatch
filling and adjust the angles accordingly.

Direction

Unidirectional / Bidirectional / Meander
Bidirectional provokes alternating processing directions of the fill
lines.
The meander is equally bidirectional, but the u-turn jumps are
marked.
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Setting

Explanation

Additional settings for inset fill
Inbound

Select the checkbox (tick the box) if you want to process the filling
from the inside to the outside (standard setting). Deselect it if you
want to process the filling from the outside to the inside.

Number of insets

▪

Auto: closed contours get filled completely

▪

Defined Number: Useful to create a defined number of contour
lines equidistant from the master path. Therefore, it is also ideal
for open paths. Algebraic sign of the pitch value defines whether
the contour copies are added to the left or right from the path.

Example:

HINT: To design a contour copy as in the example, the advanced
fill option End Type must be set to Open butt.
Additional settings for spiral
Angle [°]

Inside starting angle of the spiral line.

Offset [mm]

Shifts the center of the spiral relative to the center of the object
bounding box

Chord length [mm]

Length of the polyline segment that represents the spiral shape

Additional settings for drill points
Distance X/Y
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Setting

Explanation

Mode

Pulses: The dwell time per drill point is defined on the basis of the
number of pulses and the frequency defined in the pen and the
resulting pulse period.
Time: The dwell duration per drill point is defined directly as the
target value.

Pulses / Time

Number of laser pulses or duration [ms].

Additional settings for circular filling of code cells
Count

Number of circles per row/column or number of concentric circles.

Roundness [%]

A value of 100% corresponds to a circle. A value of 0%
corresponds to a square. All values in between yield squares with
rounded corners.

Scale [%]

Scales the diameter of the circle(s), which otherwise adjusts itself to
the cell size.

Concentric

Activates the concentric arrangement of the circles instead of a
matrix arrangement.

Advanced settings
Click [Expander] to open the advanced settings section.
It is not recommended to use all available settings in the advanced sections. The advanced
settings options are only relevant for “Outline” filling pattern.
Below, only two relevant settings are listed.
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Setting

Explanation

Join type

Varies the way, the filling lines meet on inner corners:
Miter vs Round vs Square

Square

Miter

Round

End type

▪

Open butt: use for contour copy of open paths

▪

Closed polygon: use to close an open path with a virtual line as
a fill border

Example:

Tab. 7.20: 034

* Not available for spiral filling and special code fillings.
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Type

Explanation

Use of fill dialog icons
Use the [Expand/Collapse] buttons to expand or collapse the
various sections of fillings.
Use the arrow keys for [Up/Down] to change the order
(corresponds to the processing sequence) for a multiple-fill pattern.
Use the [Save] button to store the actual filling as a filling template.
Use [Load] to list all filling templates available to add one.
Tab. 7.21: 066

7.2.6

Layout Modification

7.2.6.1

Object Transformation
Every layout object carries transformation.
When an object is placed on the workspace for the first time, it is registered in the job file with its
initially defined parameters. The initial/original values are not changed by a transformation. Instead,
any change to the object is additionally stored as either a transformation or a direct edit of a
command or vector position.

Types of transformations
▪

The object's offset and thus the position of the object center in relation to the workspace origin.

▪

The size and scale factor of the object (or the surrounding rectangle) and thus the axes ratio in
relation to the original size (after adding or importing a layout object).

▪

The rotation of an object around its transformation center.

Access to transformations
Transformations can be performed with the mouse in the viewport or by entering values. You can
use three GUI locations:
▪

The viewport, using the mouse (cursor) or the arrow keys (limited to translation in the XY plane)

▪

Transformation panel

▪

Object Settings Dialog

© 2022 RAYLASE GmbH

RAYGUIDE Manual V1.12

132

7 LASER PROCESS JOBS

Transformation panel
The point in the software that is primarily used for transformations is the Transformation panel
(usually found to the right of the working field). Here, all transformation options are available.

Fig. 7.22: ABM

Object Settings Dialog
The settings in this dialog reflect the settings provided in the Transformation panel.
To open an object's settings dialog, go to the Settings tab, section Transformation.

Fig. 7.23: ABN

The table shows the current offset and the dimensions of the object, and thus its scale factors, in
relation to the original values (i.e. at the time of initial creation).

Object selection
Transformations can be applied to pre-formed objects and to free-formed graphics as a whole, to
an object’s layers, paths, and commands, or even at container level. When a container element is
transformed, the transformation is applied to the container as a whole and to all of its subordinate
objects (so-called "children"). (If a pattern object is taken out of the container again, it loses this
transformation.)
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Coordinate systems
Note that there are two coordinate systems to be considered when performing transformations:
▪

The coordinate system of the workspace.

▪

The coordinate system of a graphic object. Each object has its own coordinate system.

Each transformation always relates to an object (or a group of selected objects) transformation
center. Note the following definitions:
▪

Coordinate origin of the workspace: Zero coordinates of the workspace, which can be a
combination of multiple scan fields. In case of multiple scan fields: The workspace origin is
equal to the origin in the workspace definition and its scan field offsets.

▪

Object Center: Center of the enclosing rectangle which encloses an object

▪

Object origin: Mathematical starting point of a pre-formed object. The origin of the object is
generally the center of the object, with the exception of polygons and spirals, for example.

▪

Transformation center: By default, the transformation center is the object center.
Transformations of scale and rotation relate to the transformation center. The absolute position
of the transformation center is available in the panel under “Center point”. The position can be
shifted with the mouse and reset to the object center by using the [Reset] icon next to the
“Center point” coordinates.

The following example figure shows the essential items regarding transformations:

Fig. 7.24: ABO
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Transformation details
The following transformation operations are available:
Setting

Explanation

Mode

Absolute: transform to … (can only be applied at the Object hierarchy level)
Relative: transform by …

Offset [mm]

In Absolute mode: Shows/defines the offset (and thus the position) on the X-Y-Z axes
from the object origin to the coordinate origin of the workspace.
In Relative mode: Shifts the selection by the entered value in the X-Y-Z-direction.
Applicable to containers, objects, or individual layers, paths, graphic commands or
groups of thumbs.

Size

In absolute mode: Indicates/defines the absolute size of an object or of the
surrounding rectangle.
Use the [Lock / Unlock] toggle icon to fix the side ratio.
Note that size and scale values are intertwined.

Scale [%]

In absolute mode: Shows/defines the scale factor as a percent relative to the original
size of the object. The center point of the transformation is the transformation center,
which usually coincides with the object center.
In relative mode: Shows/defines the scale factor as a percent by which the current
selection is scaled relative to the current size.
Can be applied to containers, objects, layers and paths.
Multiple selections are possible, but only in the same hierarchy level. By default, the
transformation center is at the center point of the shared, enclosing bounding box.
Use the [Lock / Unlock] toggle icon to fix the side ratio.
Note that size and scale values are intertwined.

Flip

Toggle icons to flip/unflip the selection in direction of the respective coordinate axis.
X direction / Y direction / Z direction

Rotation [°]

Shows/defines the angle in degrees by which the current selection is rotated around
the transformation center.
In absolute mode, the angle is specified relative to the respective coordinate axes.
In relative mode, the angle is specified relative to the current orientation.
Can be applied to containers, objects, layers and paths.
Multiple selections are possible, but only in the same hierarchy level. By default, the
transformation center is at the center point of the shared, enclosing bounding box.
The [Reset] icons reset the respective absolute transformation to the original object
position/size/orientation.

Fixed rotation angle

Icons for the fixed rotation per spatial axis by 90 degrees each, clockwise/
counterclockwise around the center of transformation.
Orientation of the rotational axis through the transformation center:
Parallel to: X-axis / Y-axis / Z-axis

Center [mm]
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Setting

Explanation
The [Reset] button resets the transformation center to the object center.

Tab. 7.22: 035

The [Reset] icon actively resets the respective transformation to absolute zero in case of offset,
scaling and rotation, both in absolute and relative mode.
The [x] buttons in “Relative” mode set values to zero.

Command buttons
Click on [Checkmark] to apply the transformation.
Click on [Apply to copy] to copy the object and transform it at the same time.

7.2.6.2

Edit Mode
The Edit mode must be activated to be able to edit vector-based layout objects or parts thereof,
such as individual thumbs.
To access the Edit mode, go to Edit vectors in the context menu of the object.
Alternatively, you can directly select the layout element in the tree directory to switch directly to the
Edit mode.
In Edit mode, outlines are displayed but not fillings. View options such as the display of jump
vectors, vector tips and sharp corners are ignored in this mode.

7.2.6.3

Automated Vector Optimization
Many imported layout files are not optimally prepared for laser processing. Thus, RAYGUIDE offers
a broad range of optimization functions:
▪

Rearrange the vector sequence.

▪

Optimize the processing result.

▪

Adapt the geometry to the real situation if necessary.

To obtain an impression of how the layout object will be processed, use the "Display vector tips"
and "Display vector jumps” view options. You may also navigate through the object tree and follow
the highlighted thumbs in the viewport.
Some optimization functions require a tolerance parameter. The corresponding parameters are
mentioned with each optimization function and explained in the section on the associated settings
at the end of this chapter.
Right-click an item of the object tree to open the context menu and select Vector optimizations.
The table provides an overview of all functions, and at which entity level you can use them. The
following sections explain each function in more detail and provide examples. The examples show
the situation before and after applying the function.
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Function

Available at level
Object

Layer

Minimize jump distance

✓

✓

By direction

✓

✓

Close paths

✓

✓

Close gaps

✓

✓

Change orientation

✓

✓

Set z-coordinates to
zero

✓

✓

Sort

Path

✓

✓

Split path
✓

✓

✓

Touching paths

✓

✓

✓

Polylines

✓

✓

✓

Straight lines

✓

✓

✓

Similar circular arcs

✓

✓

✓

Selected points with lines
Remove

Replace

✓
✓

Split commands
Merge/Join

Command

✓

✓

✓

Drills

✓

✓

✓

Duplicates

✓

✓

✓

✓

Straight points

✓

✓

✓

✓

Empty layers

✓

Empty paths

✓

✓

Lines/Polylines by ...

✓

✓

✓

✓

✓

✓

✓

✓

✓

✓

✓

✓

✓

✓

✓

✓

Rearranged polylines,
Circular arcs,
Quadratic curves,
Cubic curves
Circular arcs by ...
Lines,
Polylines,
Elliptical arcs,
Quadratic curves,
Cubic curves
Elliptical arcs by ...
Lines,
Polylines,
Circular arcs,
Quadratic curves,
Cubic curves
Quadratic curves by ...

© 2022 RAYLASE GmbH

RAYGUIDE Manual V1.12

137

7 LASER PROCESS JOBS

Function

Available at level
Object

Layer

Path

Command

✓

✓

✓

✓

Straight curves by lines

✓

✓

✓

Circles by Drills

✓

✓

✓

Drills by Circles

✓

✓

✓

All commands by polylines

✓

✓

✓

✓

✓

✓

Lines,
Polylines,
Circular arcs, cubic curves
Cubic curves by ...
Lines,
Polylines,
Circular arcs, quadratic
curves

Double points in
polylines

✓

Tab. 7.23: 036
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Sort to minimize jump distance
This function rearranges all paths and, if necessary, the command order to avoid unnecessary
jumps. This may also imply that a path succession gets reversed. If a subsequent path has a start
point matching its predecessor’s end point, the paths are joined after sorting.
The function should be executed before all other optimization functions, because other functions
work better if the elements are already sorted.
Available for the following hierarchy levels: Object, layer
Related tolerance values: Min. point distance (for sorting) [mm]
Example:

Fig. 7.25: ABP

Sort by direction
This function rearranges all paths by considering a belt angle to optimize MOTF execution. Enter
an angle that is opposite to the direction of belt movement through the scan field.
Available for the following hierarchy levels: Object, level
Example: Three lines of text processed line by line by default

Fig. 7.26: ADN
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Close paths
This function closes open paths by connecting the end point of the last command to the path
coordinate with a single line command.
Available for the following hierarchy levels: Object, layer, path
Example:

Fig. 7.27: ABQ

Close gaps
This function closes gaps between adjacent open paths by inserting a line between the paths and
joining the paths. The corresponding tolerance value sets the maximum size of the gap that can be
closed by this routine.
This routine does not identify gaps, which might appear on a T-crossing.
Available for the following hierarchy levels: Object, layer
Associated tolerance value: Min. point distance
Example:

Fig. 7.28: ABR

Because the "circular"-looking path is closed, it is not joined with its predecessor and the gap
remains open.

Set z-coordinates to zero
This function will reset all Z-coordinates to zero. Thus you can convert a 3D vector geometry into a
2D geometry. Also, the function is useful if, by mistake, coordinates have been generated with a Zvalue unequal to zero.
Available for the following hierarchy levels: All
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Split path
This function splits a path into two path elements. The selected graphic command becomes the
first graphic command of the new path element.

Split
This function splits polylines, circular arcs, quadratic and cubic curves into two commands of the
same type, preserving the original shape.
If points of a polyline are selected (not the path the polyline belongs to), the polyline is split at these
points.
If the path of the polyline is also selected, the polyline is split into two polylines - the selected
polyline points are ignored.
Available for the following hierarchy levels: All
Example:

Fig. 7.29: ABS

Merge touching paths
This function merges two adjacent paths if the end coordinates of one path and the start
coordinates of the next path are within a given tolerance. Compared to the “close gaps” function,
the subsequent path start is adapted and no additional line command is added.
Available for the following hierarchy levels: Object, layer, path
Associated tolerance value: Min. point distance

Join polylines
This function joins two polylines if both polyline graphic commands follow the same path.
Available for the following hierarchy levels: Object, layer, path

Merge straight lines
This function joins two adjacent straight lines within a path if they are collinear.
Available for the following hierarchy levels: Object, layer, path
Related tolerance value: collinearity distance
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Merge similar circular arcs
The function merges two adjacent circular arcs in one path if their center points (almost) coincide,
and they have the same radius.
Available for the following hierarchy levels: Object, layer, path, command – multiple selection
Associated tolerance value for evaluating the center points: Min. point distance
Example:

Fig. 7.30: ABT

Join selected points with lines
This function joins two selected points with a line, which represents a new path.
If more than two points are selected, the sequence in which the points are connected is undefined.
Available for the following hierarchy levels: Path, command
Example:

Fig. 7.31: ABU

Remove drills
This function removes all drills (Laser on command) from the selected graphic command. This can
affect single drill as well as Laser on commands within a path sequence.
Available for the following hierarchy levels: Object, layer, path
Example:

Fig. 7.32: ABV
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Remove duplicates
This function removes adjacent duplicate points and adjacent loops in polylines if the points have a
distance less than location.
HINT: This function will not detect two separate paths, which are completely or partially identical.
Available for the following hierarchy levels: All
Associated tolerance value: Min. point distance
Example:

Fig. 7.33: ABW

Remove straight points
This function removes all points within a polyline that lie on a “nearly straight line”. The user can set
the tolerance of what is considered a “nearly straight line”.
Available for the following hierarchy levels: All
Related tolerance value: collinearity distance
Example:

Fig. 7.34: ABX

Remove empty layers
This function removes all layers which contain no paths.
Available for the following hierarchy levels: Objects

Remove empty paths
This function removes all paths which contain no commands.
Available for the following hierarchy levels: Object, layer
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Replace
Replace functions are used to convert one type of command to another.
Available sub-functions are listed in the preceding table.
Some of the sub-functions require explanation:
Replace Lines / Polylines by rearranged Polyline
This function can split one polyline command into several polyline commands. The user must
select the section(s) of the polyline (a section must always contain more than one polyline point)
that will become a new polyline command.
NOTE: This function works opposite to the “Join Polylines” function.
The example shows a single polyline command describing an elliptical arc where two sections are
selected (row of red thumbs).
After the function was applied, the elliptical arc is represented by five polyline commands.
Available for the following hierarchy levels: Polyline, command
Example:

Fig. 7.35: ABY
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Replace Lines/Polylines by Circular Arcs
This function converts either complete polylines (a) or a selected section of points of a polyline (b)
by circle arcs approximating the polyline shape.
Use case a)
The complete polyline describes a closed circle/ellipse. In this case, you can use this function
directly for the following hierarchy levels: Object, layer, path.
Use case b)
A section of the polyline describes an arc. In this case, you need to select all thumbs that belong to
the arc section and apply the function to this section only. Multiple-selection of sections is not
advisable.
Available for the following hierarchy levels: All/polyline command
Example:
a)

Fig. 7.36: ABZ
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b)

Fig. 7.37: ACA

Replace Lines/Polylines by Quadratic Curves
This function replaces each single-line segment of a polyline by a quadratic curve, preserving the
polyline’s shape.
Available for the following hierarchy levels: All
Example:

Fig. 7.38: ACB
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Replace Lines/Polylines by Cubic Curves
This function replaces each single-line segment of a polyline by a cubic curve, preserving the
polyline’s shape.
Available for the following hierarchy levels: All
Example:

Fig. 7.39: ACC

Replace Circular/Elliptical Arcs by Polylines
This function replaces a circular or elliptical arc by a polyline approximating the original shape.
The replacement is done in two steps:
In the first step, the circular arc is replaced by a polyline with the number of points set in the
Number of points tolerance parameter.
In the second step, all superfluous points are removed from the straight lines using the Collinearity
distance parameter.
With carefully chosen parameters, the result is a polyline with enough points to approximate the
circular arc smoothly even in areas with strong curvature.
NOTE: If you select too few points, the adjustment to the arc shape is not very precise, regardless
of the value you set for the collinearity distance.
Available for the following hierarchy levels: All
Related tolerance values: number of points, collinearity distance
Example:

Fig. 7.40: ACD

© 2022 RAYLASE GmbH

RAYGUIDE Manual V1.12

147

7 LASER PROCESS JOBS

Replace Circular/Elliptical Arcs by Elliptical/Circular Arcs
This function replaces a circular arc by an elliptical arc or an elliptical arc by a circular arc.
In the first case, an elliptical arc is created with both semi axes having the same radius as the
original circular arc, preserving the original circular arc’s shape.
In the second case, a circular arc is created with the same start and end points as the original
elliptical arc and a radius that is a type of average value of the ellipse’s semi axes. Therefore, the
shape cannot be preserved.
Available for the following hierarchy levels: All
Example:

Fig. 7.41: ACE

Replace Circular/Elliptical Arcs by Quadratic Curves
This function replaces a circular or elliptical arc by a set of quadratic curves approximating the
original shape. A full circle or ellipse is replaced by eight quadratic curves, smaller arcs are
replaced by a suitable smaller number of quadratic curves.
Available for the following hierarchy levels: All
Example:

Fig. 7.42: ACF

© 2022 RAYLASE GmbH

RAYGUIDE Manual V1.12

148

7 LASER PROCESS JOBS

Replace Circular/Elliptical Arcs by Cubic Curves
This function replaces a circular or elliptical arc by a set of cubic curves approximating the original
shape. A full circle or ellipse is replaced by four cubic curves, smaller arcs are replaced by a
suitable smaller number of cubic curves.
Available for the following hierarchy levels: All
Example:

Fig. 7.43: ACG

Replace Quadratic/Cubic Curves by Lines
This function replaces a quadratic or cubic curve by a single line connecting the original start and
endpoint.
Available for the following hierarchy levels: All
Example:

Fig. 7.44: ACH
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Replace Quadratic/Cubic Curves by Polylines
This function replaces a quadratic or cubic curve by a polyline approximating the original shape.
The conversion logic is similar to replacing a circular/elliptical arc by a polyline.
Available for the following hierarchy levels: All
Related tolerance values: number of points, collinearity distance
Example:

Fig. 7.45: ACI

Replace Quadratic/Cubic Curves by Circular Arcs
This function replaces each quadratic or cubic curve by an arc approximating the original shape.
Since this conversion is performed via the intermediate step of a polyline, the tolerance values
number of points and collinearity distance are taken into account.
As shown in the example: If a rather small collinearity distance is selected, the center points of all
arcs are close together and can be optimized further.
Available for the following hierarchy levels: All
Related tolerance values: number of points, collinearity distance
Example:

Fig. 7.46: ACJ
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Replace straight curves by lines
This function replaces quadratic or cubic curves by lines, but only if the control points are on the
line defined by the curves’ start and end points; i. e. the curve has no curvature, it is straight.
How much the control points may differ from the line can be adjusted by the collinearity distance.
Available for the following hierarchy levels: Object, layer, path
Related tolerance value: collinearity distance
Example:

Fig. 7.47: ACK

Replace arcs with drills/drills with circles
This function replaces "small" arcs (circles) with drills (laser-on command) or vice-versa.
The arcs do no necessarily need to describe an angle of 360°.
In the reverse case, i.e. when drills are converted to circles (360° arc), the radius of the resulting
circles corresponds to the respective tolerance value.
Available for the following hierarchy levels: Object, layer, path
Associated tolerance value: Radius for replacement of arcs with drills
Example:

Fig. 7.48: ADZ
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Replace All Commands by Polylines
This function replaces all commands (if not already a polyline) by polylines as described in the
above sections.
Available for the following hierarchy levels: Object, layer, path

Double points in polylines
This function inserts an additional point between two existing polyline points.

After doubling
of the points in a
polyline

Fig. 7.49: ACL

Related settings
Select System > Preferences [F3] > User (current user) > Tolerances.
Setting

Explanation

Min. point distance [mm]

The distance two points must have to be considered as the same
point. Example: 0.5 means that two points at a distance of less than
0.5 mm are interpreted as the same point.

Min. point distance (for
sorting) [mm]

Same as tolerance described above but for using the Sort function.

Collinearity distance [mm]

Parameter to decide whether a point lies on the same line defined
by its two predecessor points. If its distance to that line is less than
the specified value (e.g. 0.1 mm), the point is considered to lie on
the line.

Number of points

You can convert each command into a polyline. This is done in two
steps:
The first step creates a polyline containing the number of points
given here.
In the second step, the number of points that are entirely or almost
entirely in a straight line is reduced using the collinearity distance
tolerance value.

Tab. 7.24: 037
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7.2.6.4

Manual Vector Editing
In the edit mode, you can manipulate an object's vector directly in the layout as displayed in the
viewport.
The edit mode always works per object. The display options (e. g. display of jumps) and fillings are
turned off while in edit mode.
You can start the edit mode in the object’s context menu or select the object’s layer or path in the
object tree. When entering the edit mode, all points (transition points and control points) are
displayed and colored.
When a sub-unit of an object, e.g., a layer, path or command, is selected in the job tree, its thumbs
are highlighted to be able to more easily see its position in the viewport.
Light color code:
Red = Polyline or command transition points
Blue = Starting point of path.
Orange = Control point
▪

Transition points are points between the geometry elements or between the line segments of a
polyline.They are displayed as square dots, which are also called "thumbs".

▪

Control points are points to define, for example, arc center, quadratic / cubic curves. Control
points are visible as round dots.

How to select points:
▪

Using the mouse: first click in the empty area so that no thumbs are selected.Then select
individual thumbs by clicking the mouse.
Multiple selection: [Ctrl] –click, [Shift] –click, or dragging the mouse cursor around the points.

▪

In the tree: All points of the selected command become active.
Polyline: Open the point list to select a partial sequence.
Keep [Ctrl] pressed to add other item(s) to your selection.

NOTE: The selected thumbs are always filled, while the remaining thumbs are displayed with a
colored frame.
Example:

Fig. 7.50: AEA
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How to move a point or edit its position:
▪

With the mouse: Keep the left mouse button pressed and shift the point to the desired position.
To move a complete path, select the path in the tree (all thumbs are selected) and then click on
and drag one of the thumbs.
NOTE: The cursor icon changing from an arrow to a hand indicates that the selection can be
moved.
NOTE on circular arc: During manual editing, the circular arc has 3 points on the contour (start
and end points and a point on the arc). The center point is displayed but cannot be moved
separately. All 3 thumbs must be selected to move the arc as a whole.

Fig. 7.51: AEK

7.2.6.5

▪

With the arrow keys: You can use the arrow keys on the keyboard to move points horizontally/
vertically. Usable for single or multiple selection of points.

▪

Apply relative transformations, see page 132, Object Transformation.

▪

To adapt a graphic element position-specifically, you can also edit its point coordinates directly
in the command settings dialog.

More Object-related Operations in the Context Menu
The context menu is always available when you right-click on an item or on a selection of items.
The table below lists all possible functions, however, which context functions are offered depends
on the object selection and whether you open the context menu in the viewport of the jobtree.

Function

Explanation

Available in Viewport and/
or Tree

Available
on Entity
Level

Properties

Opens the element's properties dialog.

Tree

all

Edit vectors / Finish
edit

Starts or ends the edit mode of a free-shaped
vector graphic.

Tree / Viewport

Freeshapedobject

Rename

Renames the element.

Tree

Object

Save as template...

Saves an object as a template for this type of
object. See page 164, Templates.

Tree / Viewport

Object

Export as…

Allows the export of the selected layout object to
another file format, such as DXF.
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Function

Explanation

Available in Viewport and/
or Tree

Available
on Entity
Level

Change pen...

Changes the linked pen of the selected item(s)
or path sequence.

Tree

Object /
Layer /
Path /
Comman
d(s)

Unify pens...

Reduces the pens used by the selected
Tree
element(s) to a single pen, so that all its
subordinate paths use the same pen. This pen is
selected by the user.

Object /
Layer /
Path

Edit pens...

Opens the pen settings dialog. Useful to edit pen Tree
values of items using different pens. The value
field will display "Multiple" if the respective pens
have different values. After editing the pen
values, choose a reasonable pen saving option.
For details refer to page 165, Process
Parameters (Pens).

Object /
Layer /
Path

Edit laser-on
commands…

Opens the property dialog of laser on command
to edit multiple commands properties in one
operation. E.g. all laser on commands in one
layer can be set to the same duration.

Tree

Object /
Layer /
PathMultiselection

Cut

Copies the item to the clipboard and removes
the original [Ctrl-X].

Tree / Viewport

Container
/ Object /
Layer /
Path

Copy

Copies the item to the clipboard but keeps the
original [Ctrl-C].

Tree / Viewport

Container
/ Object /
Layer /
Path

Delete

Deletes the selected item(s).

Tree / Viewport

Container
/ Object /
Layer /
Path

Paste

Pastes the item from the clipboard to the position Tree / Viewport
in the tree / viewport.

Container
/ Object /
Layer /
Path

Center

Positions the object at the workspace center.

Tree / Viewport

Container
/ Object

Align

Option to align a multi-selection of objects
relative to each other. The alignment refers to
the bounding box of the selection.

Tree / Viewport

Object
Multiselection

In horizontal you can align Left / Center / Right
and in vertical Top / Middle / Bottom.
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Function

Explanation

Available in Viewport and/
or Tree

Available
on Entity
Level

To vector graphic

Converts a pre-shaped vector object into a freeshaped vector object, built on the entity
structure.

Tree / Viewport

PreshapedObject

Group / Ungroup

Puts the selected objects into a new group
container / Dissolves the selected group
container.

Viewport

Object
Multiselection

Move to combined
vector graphic

Combines two or more selected elements (freeformed or pre-formed) to a single vector graphic
object. The resulting object always is a freeshaped vector graphic. Existing layers are
preserved. One layer is created for each former
pre-formed object.

Tree

Object

NOTE: When you move graphic elements
manually (e. g. by dragging in the objects list)
into another object which has already undergone
transformations, the element is transformed in
the same way as the target. In contrast, when
using the Move to combined ... command, the
element is not transformed but remains
unchanged. In fact, the new combined object
starts as a new object free of transformations.
NOTE: The resulting object always uses job
pen#1, independent of what pens have been
used before.
NOTE: If the filling is active for one or more
selected objects, the filling algorithm applies to
the combined layout and the filling styles get
stacked.
Add layer/ Add path/ Adds a sub-entity to the higher-order item, e. g. a Tree
Add command
path to a layer.

Object /
Layer /
Path

Extract layers as
new objects

All layers of the selected object are copied and
created as separate objects, which in turn are
combined in a group container.

FreeShapedObject

Extract into
combined object

You can select sub-entities, for example, layer(s) Tree
or paths(s), and extract them into a single new
vector object which contains the selection.

Tree

Layer/
Path

Multiple selections are possible.
The combined selection of layer/paths is
possible, however, the path must not be part of
an already selected layer.
Cross-selection over different objects is possible.
Each selected path-entity element gets its own
layer entity within the newly created object.
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Function

Explanation

Available in Viewport and/
or Tree

Extract into
individual objects

You can select sub-entities for example, layer(s) Tree
or paths(s) and extract them into new vector
objects. One object is created per selected entity
element.

Available
on Entity
Level
Layer /
Path

Multiple selections are possible.
The combined selection of layer/paths is
possible, however, the path must not be part of
an already selected layer.
Cross-selection over different objects possible.
Each selected path-entity element gets its own
layer entity within the newly created object.
Split

Splits the corresponding object above the
Tree
selected element, creating a second vector
object containing all elements from the selection
and below. Depending on whether the selected
element is a geometry element, a path or a layer,
the new vector object is completed with the usual
hierarchy.

Layer /
Path

Reverse order

Reverses the order of commands in a path, i. e.
swaps the path processing direction.

Tree

Path

Delete without
closing

Deletes a command without closing/bridging the
gap. The resuming commands after the deleted
command create a new path.

Tree

Comman
d

Set as path start

Defines the selected command point as the new
starting point of the path.

Viewport in edit mode

Path
thumb

Viewport in edit mode

Path
thumb

Measure the
Defines the selected command point as the end
distance to the point point of a distance measurement (coordinate of
the selected measurement end point).

Viewport in edit mode

Path
thumb

Show ruler

Viewport in edit mode

Path
thumb

NOTE: Can only be used for closed paths
Define the starting
point of the
measurement

Defines the selected command point as the
starting point of a distance measurement.
Current (displays the coordinate of the defined
measurement start point)

The measurement ruler is shown, starting with
the last defined "starting point" (or, if none has
been defined yet, at 0/0). Once releasing the
ruler again by the next left-mouse-click, the
measured distance is written into the notification
panel.

Tab. 7.25: 038
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7.2.7

Automation Objects
Automation objects are primarily used to create interactions - with the operator or with external
control devices.
Automation objects can be added directly by dragging them to the desired flow position in the job
tree. When dragged into the viewport they are added after the current selected object.
If you click the icon, the properties dialog opens. The object is added after the earlier active object,
once you click [OK].

Common Properties of Automation Objects
Setting

Explanation

Short label

A convenient name for this object

Enable binning

To open the detailed port and signal configuration

I/O controller

The scan controller card which receives the signal

I/O port

Port of the scan controller card which receives the signal

Tab. 7.26: 039

There are five automation objects:

7.2.7.1

Wait for External Start
Panel icon:
This object causes the execution to wait for a trigger signal - for the primary start and for each
execution loop. Thus, it is often the first object in the job. It is also usable as a pause within a job.
NOTE: The job is active even when waiting.
NOTE: The input for the trigger signal on the SP-ICE-3 scan controller (Pin: START_MARK) acts
edge-sensitive.
Specific properties are:
Setting

Explanation

I/O controller

Select the controller card that receives the trigger signal. Currently,
only SP-ICE-3 scan controllers can be selected.

Tab. 7.27: 040

Setting

Explanation

Short label

A convenient name for this object

Enable binning

To open the detailed port and signal configuration

I/O controller

The scan controller card which receives the signal

I/O port

Port of the scan controller card which receives the signal

Tab. 7.28: 039
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7.2.7.2

Delay
Panel icon:
Inserts the waiting period before the next object is executed. Specific properties are:
Setting

Explanation

Delay

Duration of the delay in [ms]

Scan controller

Defines the target scan controller with which the object is executed.

Tab. 7.29: 041

7.2.7.3

Dialog
Panel icon:
Makes a dialog box pop up in the viewport, for example, to ask for process continuation.
The message box offers two different choices:
▪

[OK] icon to continue the execution

▪

[Cancel] icon to abort the execution

NOTE: The dialog object is executed in the "On host" execution mode only, which is to say that the
dialog is displayed in the GUI accordingly.
The job execution pauses as long as there is no reply to the message. Specific settings are:
Setting

Explanation

Title

Heading of the message box

Message

Suitable message text

OK label

Suitable text to indicate continuing the execution

Cancel label

Suitable text to indicate aborting the execution

Tab. 7.30: 042

7.2.7.4

Write Port
Panel icon:
Used to define a bit pattern which is set on a specific I/O port of the scan controller.
Typical use cases:
▪

Another control device is polling this information.

▪

Trigger a specific device that will react on a trigger edge, for example, the START_MARK input
of another SP-ICE-3 scan controller.

IMPORTANT: The I/O properties remain like this until they are reset by another write port object,
unless the “Pulse” option is used.
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Setting

Explanation

I/O controller

Defines the target I/O controller card with which the object is
executed. Currently, only SP-ICE-3 scan controllers can be
selected as I/O controller.

I/O port

Configured output port to be used at the selected scan controller.
Refer to page 40, Scan Controller Configuration
NOTE: In case the IO port bit area has been changed after adding
the automation object to the job, a warning will be shown in the
Write Port dialog simultaneously offering a direct option to refresh
the port bit area.

Port value

Define the bits (port pins) to be activated.

Mode

Select one of the available modes:
▪

Write value

▪

Create edge

▪

Create pulse

Setup time [µs]

Defines the time in [µs] that the complementary bit value is set in
advance to generate a signal edge or a pulse

Pulse width [µs]

Defines the time in [µs] that the value is held before the second
signal edge to create a pulse

Timing Diagram

Shows live how the time values affect the signal sequence.
Use expander to view the signal sequence of each bit.
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Setting

Explanation
NOTE: The polarity of the logical edge/pulse does not have to be
the same as the electrical polarity of the signal. This depends on
the High/Low configuration of the port.

Tab. 7.31: 043

7.2.7.5

Arm / Disarm Laser
Panel Icon:
The automation object can be used in any flow position to switch the laser status between "armed"
and "disarmed".
In addition, the visible pointer can be switched on and off.
NOTE: Most lasers do not permit laser emission while the pointer is active. For this reason, we
recommend activating the pointer only if the laser is "disarmed".
Application example: This switch may be necessary, for example, to return a laser that is in the
error state to the operating state.
Application example with pointer: Lets you define a job that runs in stand-alone mode for preview
purposes.

Fig. 7.52: AED

Setting

Explanation

Laser

Select the corresponding, configured laser.

Laser action

Select whether, at this point in the job flow, the laser is to be
armed, disarmed, disarmed and power set to zero, or if no action
is to be performed.
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Setting

Explanation

Write complement before

Define whether an action that is complementary to the defined
action (arm, disarm) is to be performed for the laser to ensure a
signal edge.

Setup time [µs]

Enter a time in [ms] for which the complement status is set in
advance.

Pointer action

Select whether, at this point in the job flow, the pointer is to be
activated, deactivated or if no action is to be performed.

Tab. 7.32: 078

7.2.7.6

Send Enhanced Command
Panel Icon:
The automation object can be used to send an extended command to the deflection unit in any
sequence position, e.g. to switch the tuning and therefore the dynamic behavior of the deflection
unit.
Setting

Explanation

Scan head

Select the corresponding, configured deflection unit.

Axes

Select the axes to receive the command.
NOTE: Currently, only the XY-Axes are available as a bundle to
receive enhance commands.

Command

Select the type of command.
NOTE: Currently, the only available command is the command to
set an available tuning of the deflection unit.

*Tuning

Select an available tuning of the chosen deflection unit.
The selection lists the tunings by name.

*Delay

Enter the time required for the deflection unit to switch to another
tuning set.

Tab. 7.33: 079

* The appearance of these fields depends on the selection of the command.
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7.2.7.7

Write to Serial Port
Panel icon:
Send a command line to a preconfigured serial port. Refer to page 40, Scan Controller
Configuration. Specific properties are:
Setting

Explanation

Serial Controller

Select the target serial port controller. A possible selection may be
the PC serial port or the SP-ICE-3 serial port.

Serial Port

Port name to be used

Add message

Open a field to enter the message text. The text can be copied for
multiple messages with individual responses.

Expected response

Activate if a response is expected. A response string has to be
entered.
If the response is the expected string, the execution continues. If
not, you get a timeout warning.
See the documentation of the recipient device for available
commands and response.

Delay

Set a time delay between a response and sending the next
command line.

Tab. 7.34: 044

7.2.7.8

Setting the correction file index
Panel Icon:
If configured accordingly (see page 57, General), this automation object can be used to define, and
thus change, the correction file used on the card. The definition is created by specifying the index
of the correction file.
Setting

Explanation

Scan controller

Selects the card on which the index for the correction file is to be
set.

Index

Defines the index of the correction file that is to be set by the
automation object.

Tab. 7.35: 084
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7.2.8

Templates
Templates can be stored to apply job elements with specific properties any time again.
Templates can be applicable for any job element (1st tab) including container and automation
objects or exclusively for fill patterns (2nd tab).

Job Element Templates
Select an object (in the viewport or in the job tree) and select Save template from the context
menu. In the dialog, the following setting are made:
Setting

Explanation

Name

A convenient name for this job element

Use as default

When creating a new object of this type, use this template with its
specific properties as default.
Importable layout objects, for example, bitmaps or vector graphics, do
not allow a default template definition.
There can only be one default template for each object type. If no
template is set as default, the system provides the default.
The default object is indicated by a checkmark in the object menu list
as well as in the template panel.
NOTE: The currently assigned pen is not saved as part of a default
object template.

Include filling

Includes the object's filling as part of the template.

Include transformation

Includes the transformations which have been made for this object so
far. This is useful to always apply the template in a specific position of
the workspace.

Tab. 7.36: 045

NOTE: The object's assigned pen is only stored as the pen number, not with the pen’s properties.

Fill Templates
To store a fill pattern as template, use the [Save] button on the fill tab in the object properties
menu.
Click the [Load] button for a list of all available fill templates that can be used directly.

Template Panel
The Template panel hosts all stored templates split on two tabs, so you can manage / apply them
from here.
The [Create] button adds the job element to the active job.
The [Single check] button applies the filling to all selected layout objects. Any previous fill patterns
are replaced.
The [Double check] button applies the filling in addition to any existing fill pattern for the selected
layout objects.
The [Delete] button removes the template entry.
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7.3

Process Parameters (Pens)

7.3.1

About Pens
A pen is a collection of process parameters, telling the laser system (laser and deflection unit) how
to process a specific job, a specific object, or even a single graphic element.
The name "pen" reflects a hand-held pen used for writing or drawing. Just as each type of handheld pen (pencil, ball pen, felt pen, marker, etc.) has a different effect on the drawing paper, each
RAYGUIDE pen processes your graphic object in a different way. Thus, the pen properties
essentially define the application result.
Pens are clustered in pen sets. RAYGUIDE administrates pen sets as a kind of library, called.
library pen sets. The library pen sets can be seen as templates. Every job is provided with a pen
set that is assigned to the job and called base pen set.
▪

The base pen set is always a duplicate of the default library pen set, and can be edited as part
of the job without any impact on the stored template.

▪

The base pen set is connected to its job. It is saved within the job file and shows up wherever
and whenever the job is loaded.

Once you load a job, the possible scenarios are:
▪

The job’s base pen set has the same name as a library pen set. The pens of both pen sets may
or may not be equal. In any case, only the current properties of the loaded job’s base pen set
apply.

▪

The job’s base pen set comes from another RAYGUIDE system, and no homonymous library
pen set exists. In this case, the pen set is shown as "Unlinked".

If a pen of the default library pen set is modified, the change has no effect on the job’s base pen
set, unless you refresh the base pen set in the job properties menu. In the job properties menu you
can also switch the base pen set to another library pen set.
By design, pens and layout elements are managed separately. However, every layout element is
linked at least to one pen. A newly created layout uses the default pen of the base pen set.
The pens of the base pen set are listed and maintained in the Pen panel. See page 168, Pen
Panel.
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7.3.2

Pen Set Configuration
Open the pen sets configuration dialog from the RAYGUIDE menu: System > Library pen sets >
Configure….
You can access all library pens sets, add new library pen sets, add pens to a pen set, edit pen
parameters, rename pens, etc.
The Configure… option in System > Library pen sets, lists all available pen sets. One pen set is
intended to be the default pen set, indicated by a checkmark in front. To change the default pen
set, right-click another listed pen set. Also, the pen set owner is indicated.
Click on a listed library pen set to directly access it.
RAYGUIDE distinguishes two types of library pen sets:
▪

System pen sets are available to all users - listed on the System tab

▪

User-created pen sets are available only to their owners - listed on the User tab

Available library pen sets are available via a drop-down list.
After installation, RAYGUIDE comes with one sample library pen set, named system built-in pen
set. The system built-in pen set is the only pen set that cannot be removed.
Inside a library pen set, all pens from pen #1 upwards derive their parameter values from master
pen #0. Master pen #0 cannot be deleted.
Tool Bar
All functions of the Pen panel's toolbar apply to the selected pens. To select a pen in a pen set list,
click on the pen entry and it will highlight in gray. Use [Ctrl] to select multiple pens.
Tool

Function

[Copy/Cut/Paste/Special paste] A pen selection can be copied or cut out and saved in the clipboard and
pasted into another pen set – and thus also in another library pen set or the
base pen set of an open job.
When you paste pens from the clipboard into a pen set, the target pen set
probably already contains pens with the same number. If so, a confirmation
dialog is displayed:
▪

Replace: Replace all pen parameters.

▪

Merge: Replace only pen parameters that are not protected (protected
parameters are shown in italics and bold).

▪

Copy as new: Add the pens as new pens, which get subsequent pen
numbers in the target pen set.

Click [Skip] to do nothing and proceed to the next pen. Mark Repeat for all
conflicts to select the same option for all pens in the clipboard.
If multiple pens are in the clipboard, the confirmation dialog is repeated for
each pen.
When using the “special paste” option, the pen from the clipboard will replace
master pen #0 instead of the respective pen number.
[Lock / Unlock/Reset]

Use [Lock / Unlock] to ensure that all parameters are protected against
overwriting in case of a pen paste-in.
Use [Reset] to remove all previous parameter changes (reset to master pen
values) and at the same time unlock all pen parameters.
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Tool

Function

[Edit selected pens]

This option allows to edit parameters of multiple pens at the same time. The
pen form opens and parameter fields where several pens contain different
parameters are indicated by Multiple.
Editing the parameters affects all selected pens and the linked layout objects.
Untouched parameters remain as before.

[Delete]

Deletes the selected pen.

[Edit name]

Releases the name field of the library pen set for processing.

[Set as default]

Defines the current library pen set as the default pen set.

[Add pen]

Adds an additional pen with the default parameters to a pen set.

[Transfers the pen set]

A transfer of the current pen set is only partially helpful since you are already
in the pen library.
There are a total of 4 options. The first two options can be used to adopt a
system pen set as the user pen set or vice-versa.
For details, see page 169, Pen Panel Tool Bar.

[X]

Deletes the respective library pen set.
Add a new library pen set.
Any new library pen set always has eight pens.

(located right lower corner of the
dialog)
Tab. 7.37: 046

Otherwise, the pen list in the pen configuration menu behaves similar to the pen list in the Pen
panel, which is described in the following chapter.
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7.3.3

Pen Panel

Fig. 7.53: ACM

This is the location to edit, add, and manage the pens used in the current job.
ATTENTION: A pen number occurs only once within a pen set. Therefore, you can assign a name
for each pen to be able to distinguish it better from other pens sharing the same pen number.
An * (asterisk) indicates that this pen differs from its reference pen. The [Reset] button is activated,
in case you want to reset the pen back to the original parameters.
The list shows:
▪

Default Pen ─ this pen is used for all newly added layout objects. Will be highlighted in bold.

▪

Indication columns ─ there are two columns (O = outline, F = filling) indicating whether a pen is
linked with at least one layout object. If you have selected a layout object, the column shows
checkmarks at the linked pens. If no layout object is selected, all linked pens are indicated by a
dash.

▪

Parameter columns ─ in the default view, only the major values of the pen are shown. How to
edit the columns, see page 171, Customize Pen Panel View.

▪

To edit a value directly in the column, double-click on the cell to open it for editing. A double
click in any cell with predefined content switches the selection to the next possible content in the
sequence.

▪

Pen color ─ the pen color can be changed. Right-click on the color block to display a wide color
range for selecting a new color.
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7.3.3.1

Pen Panel Tool Bar
All functions of the Pen panel's toolbar apply to the selected pens. To select a pen in a pen set list,
click on the pen entry and it will highlight in gray. Use [Ctrl] to select multiple pens.
Tool

Function

[Copy/Cut/Paste]

A pen selection can be copied or cut out and saved in the clipboard
and pasted into another pen set – and thus also in another library
pen set or the base pen set of an open job.
When you paste pens from the clipboard into a pen set, the target
pen set probably already contains pens with the same number. If
so, a confirmation dialog is displayed:
▪

Replace: Replace all pen parameters.

▪

Merge: Replace only pen parameters that are not protected
(protected parameters are shown in italics and bold).

▪

Copy as new: Add the pens as new pens, which get subsequent
pen numbers in the target pen set.

Click [Skip] to do nothing and proceed to the next pen. Mark
Repeat for all conflicts to select the same option for all pens in the
clipboard.
If multiple pens are in the clipboard, the confirmation dialog is
repeated for each pen.
[Lock / Unlock/Reset]

Use [Lock / Unlock] to ensure that all parameters are protected
against overwriting in case of a pen paste-in.
Use [Reset] to remove all previous parameter changes (reset to
master pen values) and at the same time unlock all pen parameter.

[Edit selected pens]

This option allows to edit parameters of multiple pens at the same
time. The pen form opens and parameter fields where several pens
contain different parameters are indicated by Multiple.
Editing the parameters affects all selected pens and the linked
layout objects. Untouched parameters remain as before.

[Delete]

Deletes the selected pen(s), unless one of them is linked to a layout
object.

[Highlight pen]

Highlights the selected pen in the job tree (blue color). Thus, you
can easily detect all layout elements linked to this pen –
sometimes, the color signature in the viewport may not be
sufficient.
NOTE: Expand the job tree fully to see the highlighting.
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Tool

Function

[Forward current pen
values]

Sends the current pen values to recalculate the object and job
statistics. In the process, the "expected execution time" is also
updated.

[Transfers the pen set]

Transfers the pen set of the current job to the pen library. Four
different options are available for selection:
The job pen set:

[Update pen list]

▪

Created as a new system pen set

▪

Created as a new user pen set

▪

Overwrite the pen set currently defined as the default

▪

Overwrite the corresponding base pen set

This function is used to update the pens of the job with the values
of the corresponding base pen set.

Tab. 7.38: 047

Editing Pens
Newly generated pens probably do not have the appropriate process parameter for your
application. So it is necessary to edit the pen parameters.
You can edit pens…
▪

In the pen configuration, after selecting the desired library pen set.

▪

In the Pen panel, listing the Job/Objects/Container pens used in the current job.

▪

Via the Edit Pens tab of the object.

▪

Via the properties tab of each layout element, using the [Edit] shortcut button.

▪

Via the Filling tab, using the [Edit] shortcut button.

After editing a pen, select the appropriate saving option. See the pen saving options in the table in
the following chapter.
NOTE: The option Apply to object pen is only selectable when coming from any Container/Object/
Entity Element/Filling.
Object Pens
The object pen is a special type of pen, which is not owned by the job. While a job pen can be
shared with other objects, the object pen is owned by a single object only.
Containers are also treated as objects and therefore also may use object pens.
Another feature of the object pen is that the object pen inherits all parameters from a related job
pen number, except for the protected parameters.
An object pen may be useful if the object shares its major parameters (for example, speed, laser
power, …) with another object, but will additionally require an individual property, for example,
special wobble settings.
The number of an object pen is marked with an asterisk (*) in the pens’ drop down list in the related
object properties pen tab.
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If an object is selected in the job tree or in the viewport, the Pen panel will list only pens (job pens
and object pens) used by that object.
An edited pen typically contains valuable process parameters which may be applied to upcoming
jobs as well. We recommend storing edited pens in an appropriately named library pen set.
HINT: The Pen panel always indicates if the listed pens are job-related pens or object-related pens.

7.3.3.2

Customize Pen Panel View
In order to display all desired values of the pens in the column overview, you can select the values
to be displayed yourself. The related context menu offers you all the necessary options.

Fig. 7.54: ADV

Setting

Explanation

Display

Under Display you will find all pen values grouped in subselections.
Check the ones you want to display or uncheck them if you no
longer want to display them.

Options

The Short header option reduces the column header to an
acronym to reduce the column width, while the tool tip continues
to display all the information.
The Enum as Index option displays the enumeration of the value
instead of the drop down text value, also to reduce the column
width.

Refresh

You can select one or more cells (keep [Ctrl] pressed) and reset
these values to the default pen values.

Set as default pen number

Define the default pen to be used for all new graphic objects.

Export

This option allows you to export selected (referring to the column
view) or all pen values to a CSV table.

Tab. 7.39: 075
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7.3.4

Pen Properties
Pen parameters are specified in a dialog. The pen properties dialog covers all possible process
parameters, regardless of your system's actual capabilities.

Fig. 7.55: ACN
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In the pen properties dialog, a red-colored label indicates which parameter fields were edited since
the dialog was opened.
Edited pen parameters are displayed in italics and bold (dirty flag indication). These parameters are
protected against overwriting in case the pen itself gets overwritten or "refreshed". To reset these
parameters to the original value, use [Reset].
The Edit Pen dialog can be reached using the [Edit pen] button from a pen set list (configuration
menu of stored pen sets / base pen set in the Pen panel), via the Edit Pens tab of a layout object,
or by using the [Edit pen] shortcut button next to the assign pen drop-down fields.
Setting

Explanation

Pen *

Select a pen to be edited.

Name

Optional name of this pen.

Should mark

Check this if objects/elements assigned to this pen shall actually be marked.
Deselect the option to unmark objects that should not be assigned.. (The
selection is set to active by default.)

Color

Select an on-screen color for a better overview of which graphic element uses
which pen.

Laser
Laser power [%]

Laser power in [%]. The percentage does always refer to a 100 % scale. The
range limitation in the laser configuration will not restrict this value entry, but
will report warnings when the respective job validation is activated. See page
206, Running a Job.
Can also be defined in absolute units, i. e. in [watts], with the appropriate
preselection. Refer System > Preferences > User > UI.

Laser frequency [kHz]

Value in [kHz]. Defines the pulse rate of the LM signal.

Laser on delay [µs]

Values in [µs] to synchronize the laser activity with the mirror position at the
start and end of a laser path. Can also be set with a negative sign.

Laser off delay [µs]
Optical pulse width [index]/[ns]**

Select the index for the APD mode.
Depending on whether you have set up the additional serial connection to the
laser, values for the respective pulse duration are displayed in addition to the
index. See page 54, IPG laser type YLPN-APD.
NOTE: An APD mode change always means that the laser emission must be
switched off briefly. For this reason, avoid making the change within a laser
path.

Beam profile index**

Select the index for the beam profile of the nLight AFX laser.
NOTE: A beam profile change always means that the laser emission must be
switched off briefly. For this reason, avoid making the change within a laser
path.

Power correction

Check to activate the SP-ICE-3 feature "velocity -based power correction".

Operating mode**

Choose between the Pulsed or CW (continuous wave line) operating modes.

Waveform **

Number of the pulse form, which then defines the pulse width.

Simmer power [%] **

Value in [%], which will be translated to the 0–10 A range for simmer current.
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Setting

Explanation

Secondary power [%] ***

Power value of the laser in [%] for a possible secondary laser source, such as
for the ring mode when using an IPG YLS AMB laser.
IMPORTANT: No functions used to dynamically adapt the laser power (e.g.
power ramps, speed-dependent power correction, etc.) have an influence on
the secondary laser power.

** NOTE: The availability of these pen parameters depends on the configured lasers and on the settings under
System > Preferences > System (all users) > Visibility > Pen.
*** NOTE: This parameter is an alternative to the simmer power parameter and is only available if an IPG YLS
AMB laser has been configured.
Mark timings
Mark speed

Speed in [m/s] of the laser spot on the material.
If desired, it can also be defined in [mm/s] by corresponding preselection.
Refer System > Preferences > User > UI.

Mark delay [µs]

Value in [µs]. The value relates to the dynamic of the deflection unit. Value will
apply after a mark vector, prior to a jump vector.

Poly delay [µs]

Value in [µs]. The value relates to the dynamic of the deflection unit. The delay
will apply at the transition point of two consecutive mark vectors.

Variable poly delay

Check to activate the SP-IC3-3 feature "Variable poly delay" to trim the
effective poly delay value dependent on the change of heading angle.

Jump timings
Jump speed

Relative speed in [m/s] or [mm/s] when the deflection unit changes position
without laser emission.

Jump delay [µs]

Value in [µs]. The value relates to the dynamic of the deflection unit. The delay
will apply after a position jump.

Variable jump delay

Trim the effective jump delay dependent on the length of the jump vector. This
is useful to adapt the jump delay automatically in cases where jumps are short
and the deflection unit cannot reach full speed.

Min. jump delay [µs]

When using a variable jump delay, enter a value for the minimum delay,
independent of the jump length.

Jump lenght limit [µm]

When using a variable jump delay, enter a value for a jump length limit. If
exceeded, the main jump delay value is used.

Skywriting
Skywriting mode

Select the suitable skywriting mode:
▪

None = Skywriting not active

▪

Force at ends = Skywriting is always performed at each vector start and
end independent of the heading angle between the jump-to-mark or markto-jump transition. The heading angle is only taken into account at the
mark-to-mark transition.

▪

Min. Angle = The CoH angle is taken into account for all transitions (jumpto-mark, mark-to-mark, mark-to-jump).

"CoH" stands for "Change of heading"
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Setting

Explanation

Min. Angle [°]

Enter a heading angle, which if exceeded determines whether Skywriting will be
applied between two consecutive marking vectors.

Extension time [µs]

Time used to calculate the length of the acceleration/deceleration vectors in
consideration of the mark speed of the related mark vectors.

Deceleration delay [µs]

Delay in [µs] which appears after the deceleration vector, prior to the “u-turn”
jump.

Acceleration delay [µs]

Delay in [µs] which appears after the “u-turn” jump, prior to the acceleration
vector.

Skywriting Laser off delay [µs]

Delay in [µs] to synchronize the laser emission on transition from mark-todeceleration vector.

Skywriting Laser on delay [µs]

Delay in [µs] to synchronize the laser emission on transition from accelerationto-mark vector.

Ramping
Defines a linear laser power ramp that is applied to every path of the layout that is linked to this pen.
RULE: The ramp always applies per path entity. Therefore, the ramp needs to be defined in the pen that is
assigned to the path level. Any new power value or other ramps due to a pen change within the path will be
ignored.
NOTES: The overall length of both ramp segments can be validated to not exceed the length of the affected path.
See page 206, Running a Job.
For drill objects, use only time-based ramping.
Not applicable for bitmaps.
Ramping mode

Select No ramp if you do not want to create a ramp.
Select Time if the ramp segment x-axis is to be defined by time intervals
(unit = [ms]).
Select Distance if the ramp segment x-axis is to be defined by length
(unit = [mm]).
If you select Time or Distance, the fields for entering the ramp values for start
and end segment ramps are displayed.

Start segments / End segments

The “coordinates” to define the ramp slopes are entered “Xcoordinate –blankYcoordinate-semicolon”…and so on.
Alternatively, you can enter the coordinates via a table. Click on the [Table]
Icon to open the Edit ramping dialog.
X-coordinate = Time or Distance
Y-coordinate = Laser power [%] or [Watt]
To ramp-up-to/ramp-down-from the power defined as the pen power, you can
use "*" as a variable.
In case you do not refer to the pen power, the middle segment can also have a
slope that depends on the length of the middle segments.
RULES:
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▪

You must also define the Y-coordinate for X=0.

▪

For the ramp end segments, the values have to be defined inversely,
meaning going backwards from the end of the path.
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Setting

Explanation
Example:

The second sample shows a ramp definition with slope along the middle
segment:

Power change time [µs] /
Power change distance [mm]

Time in [μs] / distance in [mm] over which the power value shall increase or
decrease.

Dashed line
Feature to modulate the laser emission (on/off) along a path while the process speed is kept constant (without
any jump/mark delays, similar to a bitmap line)
RULE: At the beginning of a new path, the pattern starts anew. Accordingly, the pattern from the previous path is
not continued.
NOTES:
Not applicable to drill points and bitmaps.
The pattern is displayed in the viewport, but is not visible when in edit mode.
Dashed line

Activate to use the dashed line feature.

Dashed line pattern [mm]

Define the dashed-line pattern by entering length values for laser on/off.
Enter at least two numbers.
The first value defines the dash length that the pattern starts with.
Separate values for dash/gap with blanks.
You can also create a pattern that consists of more than two parameters.
Example: 2 3 2 1 creates repeated patterns of 2 mm line, 3 mm gap, 2 mm
line, 1 mm gap.
The preview below displays the pattern according to the values.

Dashed line offset
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Setting

Explanation

Magnification
Used to increase the diameter of the laser spot.
Magnification applies only if a RAYLASE AXIALSCAN, AS-FIBER or AM MODULE deflection unit is used. Either
SL2 or RL3 must be selected as the protocol. Also, the correction file must support the 4th dimension (labeled, for
example, 3D+M).
The magnification factor is transmitted to the card as the 4th dimension of a vector coordinate. The correction file
translates these values to the defocussing (AXIALSCAN, AS-FIBER) or zoom (AM MODULE) function or even to
zoom followed by defocussing.
NOTE: RAYGUIDE visualizes the magnification factor in the viewport by drawing the affected outlines n-times thicker.
Speed

Defines a time ramp in [1/µs] over which the spot magnification is reached.
NOTE: This value shall never be 0.

Factor

Magnification factor.
Default: 1 = no magnification

Zoom async

Deactivate if the magnification is to be achieved immediately without a
designed time ramp.
NOTE: With this option deactivated, the laser is briefly switched off during the
transition from no magnification to magnification.

Wobble
The wobble function imparts additional complex harmonic motion to the laser beam in the X-Y plane, when the
laser is active.
To understand the mathematical correlation of the wobble parameters, refer to the SP-ICE-3 manual, chapter
9.2.2.
On the right side of the input fields, a preview of the resulting wobble shape is displayed while making the entries
because the wobble shape is not shown in the viewport.
Wobble

Select No wobble if you do not want to use the wobble function at all.
Select Circular if you want a circular wobble shape.
Select Eight if you want a figure-of-eight wobble shape.
Select Custom if you want to define a Lissajous-figured wobble shape.

Frequency

Set a frequency in [kHz] at which the wobble shape is repeated.

Amplitude [mm]

Set an amplitude in [mm] to define the size of the wobble shape.

Phase [°]

Only for Lissajous-figured shapes. Set a phase offset for each of the two sinus
functions.

Pen saving option
Apply to current pen

Changes will apply to the current selected job pen.

Apply as new pen

A new job pen with the current values is created and added to pen-set.

Apply to object pen

The values are stored in a new so-called "object pen" that belongs to a single
object.
This option is only available if the pen settings dialog was opened via an object
dialog (Object Settings dialog, Pen tab)!

Tab. 7.40: 048
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IMPORTANT: Modifying a pen changes the processing parameters of all objects (and layers, etc.)
to which this pen is assigned. When in doubt, it may be advisable to select the Apply as new pen
or the Apply to object pen options to avoid unwanted effects.

Related Presets
For some pen properties, you can preset the visibility in the dialog. Those presets act “global” on all
used pens.
ATTENTION: Hiding the display of a pen feature does not disable the related functionality.
Therefore, before hiding the display of a pen feature, make sure, that no part of the feature is used.
Select System > Preferences from the menu to open the Preferences dialog. Go to the System
(all users) tab and to the Visibility sub-tab, Pen section.

Fig. 7.56: ACO
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Setting

Explanation

Skywriting

Select if this option shall be available in pen settings.

Ramping

Select if this option shall be available in pen settings.

Dashed line

Select if this option shall be available in pen settings.

Wobble

Select if this option shall be available in pen settings.

Pulse width

Select if the laser pulse width is to be shown in the pen settings.
You can select from the options Show, Hide and Auto.
If Auto is selected, the parameter is only displayed in the Pen
dialog if the pulse width definition is set to manual in one of the
configured laser.

Simmer /Secondary power
signal

Select if this laser parameter is to be shown in the pen settings.
You can select from the options Show, Hide and Auto.
If Auto is selected, the parameter is only displayed in the Pen
dialog if a corresponding laser has been configured.
NOTE: If using a TruPulse Nano/SPI G4 laser, the parameter for
the simmer voltage would be displayed, while if an IPG YLS AMB
laser is used, the parameter for the secondary laser power would
be displayed.

Operating mode

Select if this laser parameter is to be shown in the pen settings.
You can select from the options Show, Hide and Auto.
If Auto is selected, the parameter is only displayed in the Pen
dialog if a corresponding laser (e.g. TruPulse Nano/SPI G4) has
been configured.

Waveform

Select if this laser parameter is to be shown in the pen settings.
You can select from the options Show, Hide and Auto.
If Auto is selected, the parameter is only displayed in the Pen
dialog if a corresponding laser (e.g. TruPulse Nano/SPI G4) has
been configured.

Optical pulse width

Select if this option shall be available in pen settings. You can
select from the options Show, Hide and Auto.
If Auto is selected, the parameter is only displayed in the Pen
dialog if a corresponding laser (e.g. IPG YLP APD) has been
configured.

Beam profile index

Select if this option shall be available in pen settings. You can
select from the options Show, Hide and Auto.
If Auto is selected, the parameter is only displayed in the Pen
dialog if a corresponding laser (nLightAFX) has been configured.

Spot Magnification

Select if this option is to be available in the pen settings. You can
select from the options Show, Hide and Auto.
The setting is available/visible if one of the configured deflections
units has at least four axes, according to its correction file.

Tab. 7.41: 049
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7.3.5

Pen Assignment
Assigning a Pen Set to a Job
Each job has a base pen set which corresponds to the stored default pen set (see page 165, About
Pens).
To assign a different pen set than the default pen set, open the job settings dialog (Job >
Settings). In the Base pen set drop-down field, select the desired pen set.
NOTE: If the job already contains layout objects that are linked to pen numbers, the links to the
specific pen numbers persist when the pen set is changed. However, after the change to the pen
set, each pen number points to a pen with different pen parameters.

Assigning a Pen to an Object, a Layer, a Path, or a Command
By default, a newly created object (as well as its layers and paths) in the layout uses the default
pen (e. g. #1) of the job's base pen set. After this, it is possible to assign another pen to this object
or layout element.
The pen for a layout object is assigned by one of the following methods:
▪

On the "Properties" tab of the layout object, in the "General" area. For layers and paths, pens
are assigned via the respective settings dialogs. Next to the Pen selection, there is always an
icon for direct navigation to the Pen dialog, where the respective Pen parameters can be edited
as necessary.

▪

By selecting the graphic element, either in the job tree or in the viewport (multi-selection
possible) and then using the [Assign pen to selection] action icon in the line of the desired
pen in the pen panel.

NOTE: If a pen was changed at a lower hierarchy level, then this new pen assignment is protected
from future pen assignments at higher levels.
To change the pen inside a path:
▪

Add a "set pen" command between existing graphic commands

▪

Select the outline area in the viewport, for example by dragging the mouse, and right-click on
the highlighted selection in the job tree. In the context menu that opens, click on the Change
pen... option and select the desired pen number in the drop-down field.

Filling graphic elements may require a different pen than an outline (by default, RAYGUIDE
assigns the same pen as for the outline). Therefore, via the filling tab, you can also change the pen
used to process the filling. A manual change of the filling pen causes a change protection against
pen changes of the outline pen.
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7.4

Job Organization

7.4.1

Organizing Process Order and Affiliations
Process Order
The sequence of objects and graphic elements in the job tree is also the order of processing. After
layout creation, the sequence of graphic objects often is not optimal. The sequence of objects/
items can be re-organized, if, for some reason, an object, an item, or groups of them shall be
processed before others. The graphic layout itself is not altered by re-organizing.
To move elements to another place in the job tree, select one or more elements and drag them to
the desired position in the job tree. A horizontal line indicates a possible new position.

Affiliations
The affiliation of an item to a higher-level element, for example, of a path to a layer, can be
changed. For example, you may group paths to another/new layer for a specific reason. The
graphic layout itself is not altered by re-organizing affiliations.
In the same way, you can pick a layer and shift it into another free-shaped vector object. Paths can
also be shifted from one object into another. Only commands cannot be transferred this way.
When shifting items from one object to another, the following rules apply.
RULE: If you shift an element (layer, path) from one object to another, the shifted element
assumes the transformation of the new object.
RULE: The pen assignment of the "target" pen assigned to the "target" object is used for the newly
affiliated element, unless a pen was explicitly assigned to that element before.

7.4.2

Containers
Containers build a kind or new job object, in which all inserted objects get treated collectively. For
example, a transformation applied to a container will transform the entire contents.
The most simple container type is the Group container.
Matrix Copy and Polar Copy containers additionally multiply their inserted objects as defined by the
container settings. These reproduction objects, called children, act like clones of the inserted
master objects and cannot be picked or edited by themselves. In the viewport, children objects are
displayed a bit lighter than the master objects.
NOTE: As soon as you pull an object outside a container, it will lose all properties of the container.
You can add a container the same way as any other job object.

Add/Remove objects to/from a container:
Case A: The objects you want to insert to the container are already listed in the job tree:
Select the objects with the mouse drag them to the container object.
To remove an object from a container, drag the object out of the container or delete the object.
Case B: You start with the container object.
If you now add a new object and would like to have it in the container, drag it directly to the
container item in the tree.
When you drag the new object into the viewport, it will be inserted after the container object in the
job tree.
HINT: To edit a container as a whole by transformation, it must be selected in the job tree.
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There are four types of containers:

7.4.2.1

Group Container
Panel icon:
A group of objects/items. The purpose of a group container is to treat all objects/items as a whole,
for example, to define binning conditions or the number of iterations, or to transform/shift all
objects/items together.
Therefore, you always pick up the group as a whole in the viewport.
To pick single elements, select them in the job tree.
To group the objects, select all objects by cursor selection in the viewport or in the job tree. Open
the context menu and select “Group”.
To ungroup, select the group container and select “ungroup” in the context menu.
The container and thus the groups can also have their own transformation, which transforms the
objects in the container. If the group is ungrouped, this transformation is transferred to the objects
that were in the group.
Setting

Explanation

Settings
Iterations

How often this group of objects shall be processed.

Short label

A convenient name for this container

Enable binning

Option to define binning conditions; see page 119, Common
Properties of Marking Objects.

Single output

Process all container objects as a single, combined vector object.
This can speed up the processing if the container contains a huge
number of children objects.
NOTES:
▪

This option is especially recommendable for MOTF
applications, in which many small layout elements (such as
drilled holes) occur, since this avoid reset jumps.

▪

Automation objects are ignored if this option is set.

▪

If containers are stacked inside each other, this option should
not be used.

Edit Pens (tab)
This tab provides access to pen editing.
After editing, you may save the pen as “object pen”. This allows editing specific pen parameters
which only affect container elements without affecting the actual job pens.
Tab. 7.42: 050
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7.4.2.2

Matrix Copy Container
Panel icon:
Using a Matrix Copy, you can multiply layout elements in rows/columns across the workspace.
Setting

Explanation

Settings
Number of copies

Number of copies in X, Y, Z directions
Use the [Lock / Unlock] toggle button to define the same values
for the X and Y directions.

Pitches [mm]

Distance the copies are spread in X, Y, Z direction
Use the [Lock / Unlock] toggle button to define the same
distances for the X and Y directions.

Starting corner location

Corner of the matrix layout at which the execution starts.

Processing direction

Sequence of processing directions.

Bidirectional

Option to alternate the processing direction per row/column.

Centered

The original center position of the master object (or the center of
gravity in case of multiple master objects) will become center of
container.

Short label

A convenient name for this container

Enable binning

Option to define binning conditions

Single output

Process all container objects as a single, combined vector object.
This can speed up the processing if the container contains a huge
number of children objects.
NOTE: When you have a text/code object in the container, all
children will have the same iteration content – the iteration is not
done per child.

Edit Pens (tab)
This tab provides access to pen editing.
After editing, you may save the pen as “object pen”. This allows editing specific pen parameters
which only affect container elements without affecting the actual job pens.
Tab. 7.43: 051
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7.4.2.3

Polar Copy Container
Panel icon:
Using a polar copy, you can multiply layout elements in a circular arrangement. The center of the
circular arrangement is the original center of the master object. Basically, the orientation of the
layout copies corresponds to the orientation of the master object.
Property

Explanation

Properties
Number of copies

Number of copies that are evenly spread across the defined
sector of a circular arc. The master object is part of this number.

Radius [mm]

Radius of the circular arc

Start angle [°]

Defines the starting angle of the circular arc sector and thus the
position of the first object.

End angle [°]

Defines the end angle of the circular arc sector and thus the
position of last object.
If start angle and end angle define a 360-degree sector, the
copies are evenly distributed along the full circumference.

Direction

Processing direction of the copies along the circular arc

Align children rotation

All copies are rotated in a way, that the vertical object axes are
tangential to the circular arc.

Short label

A convenient name for this container

Enable binning

Same as other binning properties, see page 119, Common
Settings of Marking Objects.

Single output

Process all container objects as a single, combined vector object.
This can speed up the processing if the container contains a huge
number of children objects.
NOTE: When you have a text/code object in the container, all
children will have the same iteration content – the iteration is not
done per child.

Edit Pens (tab)
This tab provides access to pen editing.
After editing, you may save the pen as “object pen”. This allows editing specific pen parameters
which only affect container elements without affecting the actual job pens.
Tab. 7.44: 052

Remark for copy container
▪

Scaling transforms the contained objects themselves and the distances between the objects.

▪

It is possible to nest containers in other containers.

▪

You can also add an automation object to the container, which will be executed per copy.

▪

If a text/code object, whose contents usually change with each execution (e.g. incremental
number), is located in a container, this change already takes place for each child object.

A possible use case for the matrix container is to place drills in a regular fashion.
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7.4.2.4

Tiler Container
Panel Icon:
Using the tiler container, you can process layout objects that are larger than the available
workspace.
Property

Explanation

Properties
Tile size [mm]

Define the size of the tile pieces in X/Y/Z direction in [mm].
Use the [Lock / Unlock] icon to set the X to Y size ratio.

Number of tiles

Define the number of tile pieces in X/Y/Z direction.

Starting corner location

Select the corner of the container layout bounding box to set the
start of processing the tile pieces.
If the Centered option is not checked, it also defines which of the
tile pieces is in the center of the workspace.

Tiling directions

Sequence of tiling along the axis.

Bidirectional

Option to change the processing direction per row/column.

Centered

The tiling grid is centered to the center of the workspace (plus tile
offset).

Skip

Enter the X,Y,Z coordinate of the tile(s) to be skipped, as they
probably do not contain markable vectors.
Use a semicolon to separate the entry of tile coordinates.
The skipped tiles are highlighted in yellow by default.
By default the tile coordinates start counting at "0" in the lower left
corner:

Short label

A convenient name for this container.

Enable binning

Option to define binning conditions.

Tab. 7.45: 068
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Remarks
The tiler creates a kind of tiling grid to divide the layout objects into pieces that fit into the available
workspace.
The position and size of the tiling grid is defined by the tile size, the number of tiles and optionally
by the Centered option.
The starting corner location also affects the position of the tiling grid if the Centered option is not
used.
Sample views of tiling grids:

Fig. 7.57: ADJ

Fig. 7.58: ADK

The tile pieces themselves are processed one after the other. The sequence of processing is
determined by setting the starting corner location and the tiling direction.
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Examples:

Fig. 7.59: ADL

The tile pieces are processed centered to the workspace.
Recommendations:
▪

The layout objects to be tiled should be designed, composed and centered before being placed
in the tiler container.

▪

Every transformation of the tiler container applies to its layout content, but not to the tile pattern.

▪

To synchronize the processing with an external control unit if necessary, it is recommended to
enter a "Wait for start signal “ object at the beginning and a "Write IO port" object at the end
in the tiler container.
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7.4.2.5

z-offset container
Panel Icon:
By using the z-Shifter container, you can execute the layout objects in multiple focal planes to
generate deep engravings, for example.
To make it possible to mark in different focal planes, an appropriate deflection unit (e.g. RAYLASE
FOCUSSHIFTER, AXIALSCAN, AS-FIBER) and a correction file with a z-volume are required.
Setting

Explanation

Count

Defines the number of focal planes in which the layout objects
located in the container are executed.

Delta z [mm]

The value defines the distance between the focal planes.
Negative algebraic signs indicate the focal plane is offset
downward and positive algebraic signs indicate it is offset upward.

[Plus sign]

Adds a new row with shifts to define a new number of focal
planes with a new offset value.

Tab. 7.46: 081

NOTE: If multiple layout objects are located in the container, all objects are initially executed once
per focal plane before the focal plane is changed and the objects are executed again.
NOTE: When you enter automation objects in the z-Shifter container, they will also be executed for
each focal plane.
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7.5

Job Properties Dialog
The Job properties dialog provides specific settings per job, and hosts the job statistics overview.

7.5.1

Job Properties
Select Job > Properties from the menu or double-click any of the job information on the Job panel.
The following dialog is displayed:

Fig. 7.60: ACP
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The following settings always apply to the job currently edited and are stored with it.
Setting

Explanation

Description

Optional label for this setting.

Preset

Select one of the previously stored job presets (see page 80, Job
Presets) displayed in the drop-down list.
If a workspace configuration is marked as "Standard", it is
automatically preselected.
If you don’t want to use any of the stored workspace configurations,
select None.
NOTE: If a stored workspace configuration with Mark-On-The-Fly
(MOTF) settings is selected, the MOTF setting fields are filled
accordingly.
Because of this concept, there is no “Save as default” option on the
job settings tab.
See also page 81, Setup.

Workspace

The workspace size of the loaded configuration or the field size
provided by the correction file.
The expander additionally displays the "Offset" area. The standard
values come from the FC3 correction file, through which the zero
layer is defined primarily in correction files with a Z-area.
Enter different workspace dimensions if required.

Correction file index

Define the index of the correction file that is to be active when the
execution of the job begins.
NOTE: The option is only usable if at least one deflection unit has
been assigned two correction files in the configuration. See page
57, General.

Repeat

Execute the job in an indefinite loop (most likely in combination with
a “Wait for start signal” object).

Number of executions

Execute the job a specific number of times.

Background

Option for inserting an image as a background picture in the work
area.
Valid formats are: JPG, JPEG, BMP, PNG, GIF, EXIF.
Select:
▪

Embed if the image is to be saved as part of the job.

▪

Link if you only want to link the image file to the job locally.

NOTE: The image is scaled to the size of the work area in both
dimensions.
NOTE: The opacity of the background image can be set using the
opacity slider, which is part of the toolbar. See page 22, section 4.3.
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Setting

Explanation

Enable Mark-On-The-Fly

For Mark-On-The-Fly (MOTF) explanation and settings, see page
194, MOTF Jobs.

Start trigger
Distance
Repeat trigger
Execution pitch [mm]
Base pen set

Selection list for the base pen set for this job. For details of pens,
see page 168, Pen Panel.

Refresh on load

Select this option (tick the box) so that the values of the job pen set
are automatically updated with the values of the base pen set when
the job is reloaded.

Use

List of used/available scan controllers for this job.
If no workspace configuration was loaded, you can edit the
selection.
If a workspace configuration was loaded, the list is “read only”.

Tab. 7.47: 053

7.5.2

Optimizations
On the following tab, you can define a selection of optimizations that are performed by RAYGUIDE
in the background and before the actual execution on the scan controller.
The parameters shown on this tab can also be set by a selected preset.
After you have defined a new job pre-setting or edited an existing one, you will see the pre-setting
and its workspace setup as soon as you start a new job or change the used preset in the job
properties.
Setting

Explanation

General
Sort to minimize jumps

For details you may refer to page 86, Optimizations.

Join Layer
Mark-On-The-Fly
Auto segment & Max. Width

For details you may refer to page 199, MOTF Optimizations.

Sort by direction & Range
Tab. 7.48: 074
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7.5.3

Job Statistics
The job statistics provide an overview of the job contents in regards to the processing time and
accumulate the overall lengths of mark vectors and jump vectors.
If multiple scan controllers are assigned to the job, each scan controller is displayed with its
respective associated contents.
Total number of markable objects
Total mark length [mm]

Accumulated length of all mark vectors of all
layout objects, split into outline and filling.
HINTS:
▪

If the job contains bitmaps processed in
Sprint mode, the bitmap lines are added to
the total mark length.

▪

The gaps in a dashed line are not subtracted
from the mark vector length.

▪

Possible Wobble geometry is not taken into
account

Total jump length [mm]

Accumulated length of all jump vectors of all
layout objects, split into outline and filling. Also
contains jumps between the individual mark
objects.

Execution time [m:s:ms]

Accumulated calculated process time
considering speed and delay values of all layout
objects, split into outline and filling.
HINT: The execution time does not include the
time consumed by extra Skywriting vector
extensions.
NOTE: The execution time does not take into
account if the job execution is split between
several cards.

Number of paths

Accumulated number of paths, split per outline
and filling

Number of commands

Accumulated number of commands, excluding
“set pen” commands, split into outline and filling

Number of points

Accumulated number of command-points, split
into outline and filling.
HINTS:
▪

“supporting points” are excluded

▪

Path start points are excluded

This is useful to get an idea at how many points
a poly delay can take effect.
Number of scan lines
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Total number of markable objects
Number of slices

The number of slices always pertains to the
total height of the solid. In solids with a negative
form, however, the number of slice to be
executed will usually be far lower.

Tab. 7.49: 054
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7.6

MOTF Jobs
MOTF stands for Marking-On-The-Fly and means to process objects that are continuously moving
through the workspace, instead of resting still. Typically, a conveyor belt carries targets/work
pieces to and through the workspace of the deflection unit. The movement has to be linear (in most
cases along coordinate axes), i. e. no curvatures are allowed.
To track the movement of the target material, the scan controller is fed by an encoder.
The encoder provides a defined number of signal-edges (called ticks) per turn. By counting the
edges per time, the scan controller knows the speed of the target material passing by.
The SP-ICE-3 scan controller offers a second encoder (compensation encoder) input to
compensate slight deviation movements of the target material perpendicular to the main movement
direction.
Each MOTF job also needs to know when to start the vector execution to meet the right position on
the target material. Therefore RAYGUIDE offers different trigger options.
NOTE: For MOTF executions, trigger signals must be input of the configured "Part sensor" pin of
the SP-ICE-3 controller. This requires specific port configurations on the SP-ICE-3. Refer to the
SP-ICE-3 scan controller manual for information on correct port configuration.
To prepare for MOTF job execution, some configuration work has to be done in advance:
▪

Controller card configuration - for the basic hardware setup

▪

System > Preferences > Workspace > Configuration - for frequently used MOTF trigger
settings.

▪

Optional: Job Properties - if no workspace configuration has been stored to use MOTF defaults.

© 2022 RAYLASE GmbH

RAYGUIDE Manual V1.12

194

7 LASER PROCESS JOBS

7.6.1

MOTF Settings in Controller Card Configuration
Configure the technical details of the MOTF setup:
▪

Open the controller card configuration and go to the MOTF tab.

▪

It is recommended to consult the controller card's manual, too.

Setting

Explanation

Base Mark-On-The-Fly configuration
Part distance [mm]

The distance in [mm] between a workpiece and the trigger reference position
(usually the workspace origin) when a part detection sensor transmits a
detection signal.
Knowing this distance and the speed of movement, the card can determine the
exact moment when to start processing the vector list in the scan field.
The SP-ICE-3 scan controller has a part sensor buffer. Thus, it is irrelevant
whether consecutive parts pass the trigger position before the first part has
reached the scan field to get processed.

Enable compensation decoder

When enabled, a settings dialog is displayed which is similar to the one for the
main encoder.

Debounce part sensor

Enable this option to debounce the sensor, i.e. to ignore any unwanted signals
(often signal glitches) for a certain time.

Debounce time [µs]

Debounce time in [µs]

Suppress part sensor

Enable to avoid pick up any trigger edge for a certain distance, i. e. if other
fiducials pass the trigger sensor while waiting for the next target object.

Suppression distance [mm]

Distance in [mm] over which signals are suppressed

Part sensor response time [µs]

Time in [µs] between a part's actual detection at the sensor and the arrival of
the sensor signal at the card. Refer to the part sensor specification to see the
translation time, for example, of an optical recognition into an output signal.

Reset jump speed [m/s]

Definition of the relative jump speed of so-called reset jumps. These jumps are
made when the MOTF tracking is ended or paused or when the system jumps
to the next assumed layout position.

Margin

Distance in [mm] to offset the earliest possible marking position from the field
border towards the field origin.
NOTE: Any value greater than zero will lead to a shorter processing time of the
layout within the remaining field distance.

Main encoder ID

Assigns input port 0 and port 1 to the main encoder or to the compensation
encoder. By default, the main encoder uses ID=0

Belt offset [mm]

Specify if the conveyor belt moves with an offset to the workspace origin.

Main encoder (also for compensation encoder, if enabled)
Distance per count [µs/tick]

© 2022 RAYLASE GmbH

The encoder delivers a certain number of signal edges per turn. By knowing
this number (refer to the encoder specification) and the circumference of the
encoder wheel, you can calculate the distance the conveyor is moving per
signal-edge = “a count”. Alternatively, read the current encoder position
([Refresh]), move the conveyor belt a certain distance, and read the new
encoder position. Take the difference between the two encoder positions to
calculate the “distance per count impulses”.
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Setting

Explanation
To fine-tune the calculated values, we suggest the following: Define a marking
job with four lines of different lengths, orientated vertically to the belt
movement direction, all placed in the field center, one above the other. The
shortest line should be first, the longest line last in the marking order.

Run the job and see if the four lines are marked in the same place (one above the
other) and straight vertically. If the lines are separated and tilted, there is overcompensation or an under-compensation of the belt movement. Change the "Distance
count impulse" value accordingly and repeat the test until the results are good.
Invert direction

Use if the encoder position value is decreasing instead of increasing although
the conveyor belt moves in the desired direction.

Azimuth [°], Elevation [°]

Set these values if the belt is tilted, that is, the belt movement is not parallel to
the workspace coordinate system.
Azimuth is the angle of the belt in the horizontal plane.
Elevation is the angle of the belt in the vertical plane.

elevation

azimuth

Most belts run in the axis direction and thus have an azimuth angle of 0/180 degrees
(belt moves along the X-axis) or 90/270 degrees (belt moves along the Y-axis).
IMPORTANT: The azimuth angle does consider the belt movement direction in
regards to the workspace axes, as projected after the deflection unit (including
field transformation).
For a simple check, mark a line orientated parallel to the belt movement
direction, and repeat the line at a distance corresponding to the length of the
line. If the processed line is sawtooth-shaped rather than straight, the azimuth
angle needs to be corrected.
Enable index

Some encoder types provide an index signal, used to reset the counter. Check
with your encoder manual, if applicable.

Enable simulation

Enable to simulate a real encoder setup. Useful to evaluate if the job can be
processed in an available scan field/time. If processing fails, the SP-ICE-3
scan controller sends an "out of field" exception.
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Setting

Explanation

Simulation speed [m/s]

Assumed belt speed in [m/s].

Simulation acceleration [µm/µs²]

Assumed acceleration, if required.

Position [tick]

To determine the current encoder position counter value. With [Refresh] the
current counter value is displayed, with [Reset] the value is reset.

Status
Pending parts

Display the number of pending parts of the part sensor buffer. Use [Refresh]
to update the status information.
HINT: The part sensor buffer count does not get cleared in case of an abort
event. It is cleared every time you start an execution.

Tab. 7.50: 055

When using a trigger sensor as part sensor, it is necessary to configure the input port to which the
trigger sensor is wired.
Open the controller card configuration and go to the IO tab, section: Special functions - In

Fig. 7.61: ADG

Remarks
▪

If in your hardware setup, the deflection unit moves and the conveyor belt does not move, the
settings apply analogously.

▪

When running MOTF jobs in a multiple-card scenario, the settings must be made for each card.

RULE: It is recommended to execute MOTF jobs in the on-card execution mode to ensure
immediate reaction/processing on trigger signals. See page 206, Running a Job.
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7.6.2

MOTF Settings in Job Properties / Presets
In most cases, the trigger settings might be the same for all your MOTF jobs. Therefore, it is
advisable to define them via the job preset option.
Select Job > Presets to open the job preset dialog. Go to the MOTF sub-tab.
Select System > Preferences from the menu to open the Preferences dialog. Go to the System
(all users) tab and to the Workspace sub-tab.
Setting

Explanation

Enable Mark-On-The-Fly

Required for a job preset for MOTF jobs. The MOTF trigger options
are released.

Minimum segment width
[mm]

This value defines how far a layout protrudes into the scan field due
to the belt movement before processing begins.
The value is 5% of the field size by default.
In addition, within the segment, reset jumps are omitted.
NOTE: This value is of particular significance when a group of
individual paths (such as parallel fill lines) or rows of drilled points
wander into the scan field due to the belt movement.

Start trigger

Start the first marking after the job was set to the "in execution"
status.
Immediately: Processing starts immediately as soon as you start
the job execution.
Distance: Processing waits until the belt has traveled a certain
distance.
Part sensor: Processing starts on the “part sensor" trigger signal
(and consider the part distance).

Distance

Activated when Start trigger is set as Distance.
Enter the distance in [mm]. The first marking must wait until the job
execution has started.

Repeat trigger

Define, how consecutive parts get triggered:
▪

The job is repeated equidistantly. The distance is defined as
execution pitch.

▪

The part sensor detects the parts as they pass by.

NOTE: The SP-ICE-3 has a part sensor buffer. Thus, trigger events
can be buffered while a part moves from the sensor into the
workspace, allowing to place the part sensor in any distance from
the workspace center.
Execution pitch [mm]

Activated when the repeat trigger is set to distance. Defines the
distance at which the repeated job layout is to be executed.

Tab. 7.51: 056
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7.6.3

MOTF Optimizations
INTRODUCTION: Note that the following optimizations always consider each path, or more
precisely their bounding box, as the smallest, single entity.
Setting

Explanation

Auto segment & Max. Width

Activate this option if your graphic object contains paths that are
relatively broad in the belt direction. If the option is enabled,
RAYGUIDE will, if defined here, only split necessary paths into
segments that are constrained to the maximum segment width.

Sort by direction & Range

Activate this option to sort all paths (including fill lines) of a layout
object taking the belt movement direction into account, so as to
achieve maximum possible belt speed.
(e. g., if the belt moves the target objects from the right side into
the scan field, the paths for processing are sorted according to
their position from left to right).
The Range value defines the width of a virtual segment. Within
each virtual segment, the order of primary path processing is
opposite to the belt direction, while the secondary order is
perpendicular to the belt direction and reverses on alternating
segments.
APPLICATION NOTE: Finding the optimal value for the Range
depends on the internal path distribution and the overall shape. If
the layout object is rather narrow but long in band direction (e.g.
single-line text), a rather small range value is recommended.
If, on the other hand, the graphic object has a more square
outline and plenty of paths that run perpendicular to the belt
direction, a larger range value is recommended in order to avoid
too many perpendicular jumps. A reasonable limit for the value is
25% of the field size.

Tab. 7.52: 070
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The following images show the jumps to visualize the path process order before and after splitting
and sorting.

Fig. 7.62: ADR

MOTF workspace
It is possible to define a much larger workspace along the axis direction of the belt movement.
Refer to page 80, Job Presets.
Use Case: The layout object(s) can be placed outside the field (in the direction in which the
material to be marked is fed) to have more "way" left inside the scan field for processing.
NOTE: If the job validation for geometry is active, you must position all markable objects inside a
defined workspace to avoid warnings.

Speed Optimization
As a rule of thumb, the maximum belt speed is the field size divided by the execution time, or in the
case of equidistance marking, the repetition distance is used for the calculation instead of the field
size.
When using the optimization options the maximum possible speed value can be increased.
To find the optimum values, you can "play" with the optimization values and use the simulated
encoder for evaluation.
HINT: As the optimizations of RAYGUIDE are done in the executor level, importing the log file and
displaying the jumps is a good possibility to visualize the outcome.
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7.6.4

Workspace using Virtual Field
The SP-ICE-3 scan controller provides your system with a "virtual field". The virtual field allows
positioning layout objects that are partially/completely outside the scan field.
However, the objects/vectors must be located in a preset workspace, which defines the area from
which the conveyor belt transports the target material into the scan field.

7.6.5

Trigger Reference
This chapter explains considerations to better understand when marking effectively starts.
In general, RAYGUIDE starts processing markable objects as quickly as possible but considering
reasonable rules.
GENERAL RULE: Wait until the path element has been completely "moved" into the field before
you start processing, unless the layout is positioned in such a way that the first path is already
completely located in the available scan field. Each subsequent path is marked at the latest when
its MOTF-corrected position is also completely moved into the available scan field.
For this, the path, more precisely its bounding box, must lie completely within the scan field. This
avoids an out-of-field exception for cases processing paths that would be marked faster than
moving their vectors into the scan field.
What does this mean for the three different settings for the start trigger?

7.6.5.1

Immediately
The processing of the first listed markable object is started immediately, under consideration of the
previously mentioned general rule.
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7.6.5.2

Part Sensor
The processing of the first listed markable object starts after the trigger event has been recognized
by the part sensor and the part distance has moved along, but considering the previously
mentioned general rule.
The layout object’s position in the workspace must be the relative position of the layout object to
the trigger reference of the target material / workpiece.
▪

A common option is to use the workspace origin as a reference.

▪

It is important to enter the "Part Distance" value in the MOTF configuration of the scan
controller, measured relative to this reference.

Working Field

Part-Sensor
Trigger Position

MOTF direction

Trigger-Fiducial

A= Layout position to trigger reference
B= "Part Distance" Value

Fig. 7.63: ADD

7.6.5.3

Wait Distance
The processing of the first listed markable object starts after the defined wait distance has elapsed,
but considering the previously mentioned general rule.
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7.7

Job Execution

7.7.1

Preview
When starting a preview, the deflection unit projects the geometry of the selected layout object(s)
with a visible pilot laser onto the target material. Therefore, the laser source itself or the system
must provide a visible pilot laser. The preview option must be set in the respective laser
configuration.

7.7.1.1

Pilot laser calibration
In most cases, the wavelengths of the visible pilot laser and the processing laser are different. This
will result in a slight deviation of the deflection caused by different diffraction.
Thus, it is recommended to calibrate the pilot laser.
To calibrate the pilot laser, go to the device calibration of the respective deflection unit, "Preview"
section. For information, refer to page 60, Deflection Unit Calibration.

Workflow
▪

First, mark a square with a suitable pen on a suitable material.

▪

Start the preview of the square. Use the arrow buttons to superimpose (by rotating, shifting,
scaling) the previewed square with the marked square. Below the icons are fields where you
can define the delta values by which the preview changes with each click of the icon.

▪

You may transfer the hot laser calibration values as initial pointer calibration in advance, using
the arrow button between the two calibration sections.

▪

Save the pilot laser calibration: Click on [Apply] or [OK] to close the dialog.

▪

If the deflection unit is a 3-axis or 4-axis unit, you can set a separate head bias to focus the pilot
laser beam precisely on the target material.
During previews, a fairly high scanning speed is often required. You can disable the 3rd/4th axis
when a preview is performed to avoid stressing these axes.

For information on field transformations, refer to page 60, Deflection Unit Calibration.
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7.7.1.2

Running a Preview
Go to the Execution panel.

Fig. 7.64: ACQ

You can choose to display only the selected graphic objects or all graphic objects in the preview by
means of pointers.
The drop-down offers you four options to select the previewed content/shape:
▪

Everything: This also includes fillings and, for bitmaps, each bitmap line

▪

Outline: All outline vectors, but no fillings, bitmaps as rectangles

▪

Rectangle: A bounding box rectangle around the selected objects

▪

Envelope: Only the enclosing outlines of the single selected objects.
Example:

Fig. 7.65: ADO
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▪

Thumb: Positions the preview point on the selected thumb position and tracks it live while the
thumb position is being processed (only functions in edit mode with a single selected thumb).
This option can also be used when "Drawing" vector graphics. Here, the preview point always
shows the end point of the graphic command added last.
NOTE: If you change to the object level in the tree while the thumb preview is active, the
preview automatically changes to the rectangle preview variant.

When you start a preview, RAYGUIDE "disarms" the laser and turns on the pilot laser
automatically. When the preview is finished, the laser is re-armed.
You can also switch on the pilot laser without doing a preview. This means that only one of the two
toggle icon, [Arm] and [Pointer], can be active at the same time.
To activate the pilot laser, click on the [Pointer] toggle icon. The icon switches to red color:

Fig. 7.66: ACR

Then click on the [Preview] toggle icon. It also turns red:

Fig. 7.67: ACS

The preview runs continuously until the button is clicked again. The scanning speed for the preview
can be adjusted with the speed slider. The speed slider provides the speed values in a logarithmic
scale.
When the preview is stopped using the [Preview] toggle icon, the preview only ends after the
current object has been run through. If you want to stop the preview immediately, click on the
[Abort] icon.

Live editing during preview
It is possible to select more/less/other objects, edit and transform the object(s), even down to the
layer/path/command level, while the preview is running. The changes are always shown with the
next preview cycle.
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7.7.2

Running a Job
Executing a laser process job is controlled via the Execution panel (by default, on the right side of
the viewport):
NOTE: To ensure that any person looking at the RAYGUIDE GUI will notice immediately that a
laser process is active, the top and bottom frame lines change color to red as soon as you start
executing a laser process job.

Fig. 7.68: ACT

Job validation
Job validation is a tool to help you preventing mistakes, for example, positioning a layout object
partially outside the available workspace. Job validation is performed ahead of the actual job
execution. You can select if and what type of job validation is to be performed.
Select System > Preferences from the menu, go to the User (current user) tab and to the General
tab, Job validation section.
Setting

Explanation

Job validation
Geometry

Check that no layout object lies partially or completely outside the
defined scan field or workspace area.

Laser pen properties

Check that the defined laser limits (e. g. pulse width, power) are not
exceeded in any of the used pens.

Scanner pen properties

Check to ensure that the defined scanning speed limit is not exceeded
by any of the used pens.

Ramping pen properties

Useful only if a used pen uses the ramping feature. RAYGUIDE
validates if the overall ramping length exceeds the length of respective
path(s).

Tab. 7.53: 059

If any of the active job validation checks finds an issue, a pop-up message indicates the possible
error cause.
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Job access during execution
The currently processed job is in read-only status. You can review the statistics or the used pen
parameters, but you cannot edit them. All other open jobs can be edited in the meantime.

Stopping a job
A job that was started will terminate when all job tasks are performed.
If you want to stop the job execution on purpose (for example, because the job is running in an
infinite loop), click the [Abort] button. This will immediately terminate all active processing, and the
deflection unit resets to the 0/0 position.
In case of executing multiple jobs in parallel, each job has its own entry in the process monitor and
can be stopped individually. Refer to page 211, Process Monitor.
When you launch the job execution again, the job starts from the beginning.

7.7.2.1

Arm Status
To execute a job with working laser emission, the laser must be armed.
This does not necessarily imply that an electric arming signal is sent to the laser. However, the Arm
laster on startup status of the SP-ICE-3 scan controller must be set to TRUE to provide any laser
control signals at all. When the laser is not armed, no signals are transferred from the controller
card to the laser.
In the Execution section of the panel, click on the [Arm/Disarm] toggle button to change the laser
arm status. The red symbol on the icon indicates that the laser is armed.

Fig. 7.69: ACU

Disarming the laser can be useful to prevent accidental laser emission.
In the system preferences (Preferences > System > General tab), you can define that the laser
should always be automatically armed when the RAYGUIDE application is started.
NOTE: The toggle buttons [Arm/Disarm] and [Pointer] are also presented at other locations in the
user interface, such as in the laser diagnosis.
NOTE: The display of the icons does not respond to the switching of the laser status or pilot laser
by means of the automation object (see page 161, Arm / Disarm Laser).
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7.7.2.2

Execution Modes
In the Mark job section of the Execution panel, you can choose between three modes of execution:
▪

On host: Execute the complete job with its job setting. After you click the [Execute] button,
RAYGUIDE starts sending the data to the card for execution. To reduce the idle time during the
data transmission, RAYGUIDE is streaming the data.

▪

Quick: Use the “selected” toggle button to execute selected layout objects only or, if not
toggled, all layout objects. To execute the job, click on [Execute] – here you can select
between "Execute" (= default setting) and "Repeat".

Fig. 7.70: ADB

NOTES:
─ Job settings such as job repeat loops are ignored.
─ No MOTF correction is used.
─ Object binning conditions are ignored.
─ Automation objects are not executed.
─ Text and code are not incremented in a repeat loop.
▪

On card: Use this mode to ensure that there is no idle time when a trigger signal is received,
that is, in MOTF applications.
First, use the [download] button to send the job(s) to the card’s RAM memory. When all data
are transferred, the [run] button is activated.
Click the [run] button to execute the job.

NOTE: If you have a job scenario which permits using the "All" job option, click the [run] button
once to set all jobs to execution.
HINT: If you close the RAYGUIDE application after the download, the job(s) list(s) will remain on
the card(s) anyway. In case you have already started the job execution and close the RAYGUIDE
application afterwards, you can choose whether the job execution shall be continued.
In this case you must a) abort the job execution and b) re-initialize the card when you re-open
RAYGUIDE in order to reobtain access to the scan controller.
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7.7.2.3

Execution with Enabled Shortcuts
The buttons on the Execution panel are also available as keyboard shortcuts.
Press [F10] to enable the keyboard shortcuts. A small window is displayed with the known buttons.
The buttons can be clicked with the mouse or activated with the keys indicated on the buttons.
NOTE: The mode can only be selected with the mouse!
Function

Key

Arm Laser ON/OFF

[A]

Upload (on-card mode only)

[D]

Pointer ON/OFF

[E]

Mark (all)

[M]

Repeat ON/OFF (quick mark only)

[R]

Mark selected (quick mark only)

[S]

Preview ON/OFF

[P]

Abort

[X]

Tab. 7.54: 057

7.7.2.4

Considerations and Rules Regarding Multiple Jobs
Two cases are considered for the execution of multiple jobs:
▪

Precondition: All open jobs are assigned to a specific card, and all job elements of a job are
assigned to the same card.
This allows using the „All“ option in the execution panel to execute all jobs in parallel at the
assigned scan controller. Execution modes: „OnHost“ or „OnCard“

▪

Precondition: All open jobs are assigned to the same scan controller.
This allows to set the second job also in execution status while the first job is still processing,
and so on. RAYGUIDE queues the jobs and processes them one after the other.
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7.7.2.5

Considerations and Rules Regarding Multiple Card Scenarios
In general, RAYGUIDE handles the described multiple card scenarios in the same way, regardless
of whether the multi-field mode setup is defined for unified, intersected, or individual fields, even
though these setups support different purposes in plant designs.

Using an automation object The automation object is only executed on the assigned card.

On host
Execution

Sample 1: Wait Start
All cards wait to continue executing until the trigger signal is
received on the assigned card.
Sample 2: Write IO
Only the assigned card will set the I/O port. All other cards wait
until the port is set before continuing with their objects.
If all involved scan controllers shall write an I/O port, you must
duplicate the automation object per scan controller and assign it
accordingly.
In any case, further execution is synchronized by the automation
object: This means that the automation object is only executed
after each control card has completed the previous process tasks.
Incrementing content

This case needs special consideration when the multi-field mode
is applied to individual fields:
RULE: RAYGUIDE increments the content per involved scan
controller.
Example: You have three scan controllers assigned and process a
text object with incrementing the serial number:
At the first job iteration, scan controller #1 will mark 1, scan
controller #2 will mark 2, scan controller #3 will mark 3.
At the second job iteration, scan controller #1 will mark 4, scan
controller #2 will mark 5, scan controller #3 will mark 6.
If you want to have all scan controllers to process the same
iteration content, set the value of the “batch parameter” according
to the number of assigned scan controller cards.

Job Loop

The subsequent job iteration starts again synchronized: The
executing device waits until each scan controller has finished its
task in the previous iteration.

Abort execution

If an abort occurs on any of the involved scan controllers, all scan
controllers stop processing.
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Using an automation object RAYGUIDE clones the scan controller-related automation object
for each involved scan controller.

On card
Execution

NOTE: Automation objects that are not scan controller-related are
ignored, except for “Time delay”
To enable RAYGUIDE doing so, the necessary related ports must
be configured per involved scan controller – with identical ID/label
designations for the ports.
Job Loop

As there is no crosslink between the scan controller cards, the
loop execution of the involved cards is not synchronized.

Abort execution

As there is no crosslink between the scan controller cards, only
the card at which the abort occurs stops the execution.

Tab. 7.55: 058

7.7.3

Process Monitor
The process monitor is on a panel below the viewport. It offers usefull information, when the job
execution was started. Example:

Fig. 7.71: ACV

The process monitor lists all jobs executed while RAYGUIDE is open, unless you delete a single
entry or all entries manually.
If the same job is executed several times in a row, the existing entry is updated and the counter in
the Cycle column is incremented. The job started last always appears at the top of the list.
The process monitor list provides the following information:
Info

Explanation

Job

Name of the job

Progress

A dynamic status bar to view the current state of progress.
If the job is interrupted for some reason (intentional or after an error),
the progress bar stops, too.
If the job is to be repeated for a number of times, the progress bar
reflects the overall progress.
If the job is to loop infinitely:
The progress bar restarts with each loop if the job execution time is
longer than five seconds.
The progress bar stops when the first cycle is completed if the job
execution time is shorter than five seconds.
However, the timer will continue counting.
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Info

Explanation
Color coding:
Gray bar: The job is still running
Green bar: The job was executed completely
Red bar: The job was aborted by the user or due to an error message.
If a job is processed by multiple cards, the progress still refers to the
entire job status as such.

Expected

Calculated process time for the complete job in one iteration. Even if
the job is processed by multiple cards which share the work, the
cumulated process time is shown here.
NOTE: When the job is repeated a defined number of times, the total
time is displayed. However, when the job is executed in a repetition
loop, the duration of the individual repetition is displayed.

Actual

Actual process time
NOTE: The timer for the current time also runs when waiting for an
event (for example, “Waiting for signal start”) and stops when the
process is completed or aborted.

Cycle

Counter for displaying the performed job executions/the number of
specified job executions.
The pound sign is followed by the number of started job executions.
NOTE: Both counters only work in execution types "On host" and
"Quick".
NOTE: The "Start execution counter" is only reset when the entry is
deleted in the process monitor.

Target

Display all scan controllers linked to the current job itemized according
to their labels.

Current object

Display the current or last processed object per involved scan controller.
NOTE: The object name is only displayed if the execution is in the On
host or Quick mode.
NOTE: When a tiler container is used, the tile coordinate is shown.

Passes

Display of object executions.
NOTE: The display of object pass counter only operates for objects
with a sequence using infinite number of passes.
The display can be activated during the execution using the [Refresh]
icon or it happens at the latest when the infinite execution is aborted.
NOTE: The terminated pass is not counted.

[Abort]*

Button to abort a specific job, in case several jobs are executed in
parallel

[Clear*/Clear all]

Clear individual/all entry(ies) from the process monitor list.

Tab. 7.56: 060

* Per target
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7.7.4

Automated Error Handling
This function is intended for the differentiated communication of possible malfunctions registered
on the control card to an external control unit. Possible error sources can be the control card itself,
as well as connected devices such as the laser or the deflection unit. To use this function, the job
must be executed by the RAYGUIDE application, i.e. an execution in stand-alone mode without the
RAYGUIDE GUI additionally connected to the card cannot use this function.
NOTE: An error reaction only takes place if a job is being actively executed. This also includes an
active preview.
Select System > Error handling in the menu to open the error handling dialog.

Fig. 7.72: ADW
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Setting

Explanation

Device Type

Select which of the available communication interfaces is to be
used.
Currently, the I/O interface or a serial interface is available.

Controller

Specify the card on which the interface is physically located.

Port

Select the desired and preconfigured port on the selected card.

Setup time [µs]

Both values can be defined in case you select an IO interface for
communication.

Pulse width [µs]
Timing Diagram

The timing diagram is used to display the signal sequence
according to the defined bit pattern and timing.
The same principles apply as for the Write IO port automation
object. See page 158, Automation Objects.

Error Action

Define a different signal pattern or command line for each
individual error reason:
▪

Laser: Reacts when the connected laser source reports a
malfunction.

NOTE: Some lasers may report various error states, but on the
SP-ICE-3 scan controller, all are consolidated as one error state.
▪

Deflection unit: Reacts when the scan head monitoring is set
to "active" and the permissible number of consecutive errors is
exceeded. Details see page page 43, General.

▪

Scan controller: Reacts when the card throws an exception,
apart from the special exceptions mentioned below.

▪

Out of field: Reacts when the card notifies vectors for
processing that exceed the field size. (Separated card
exception) Can usually occur during an MOTF job execution.

▪

Execution aborted: Reacts when either the user presses an
abort icon or when an external stop signal is detected on the
scan controller card (Separated card exception).

Tab. 7.57: 077
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7.7.5

Preparation of stand-alone operation of scan controller
You can transfer one or more jobs from the RAYGUIDE application to the memory of the scan
controller card. All job information is stored in a list on the card and remains stored even if the card
is powered down.
When the scan controller card has all necessary job information and is set to Stand-Alone mode,
the card can run the jobs independently, without being connected to or controlled by the
RAYGUIDE software.
External signals are sent to the card via the input IOs - for start/stop processing as well as for job
selection. Typically, these signals are generated by a PLC.
NOTE: To define the stand-alone configuration and transfer jobs, the scan controller card must be
in "connected" status.

Defining a list with jobs for stand-alone operation
Select System > Stand-Alone from the menu or press [Ctrl+F12].
The following dialog is displayed:

Fig. 7.73: ACW
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The stand-alone dialog offers all options to prepare the scan controller for stand-alone operation.
All functions are explained in the table below, followed by generic workflow instructions.
Also, the stand-alone dialog provides an option to save/load all settings for a stand-alone operation
in a so-called “stand-alone configuration”. A stand-alone configuration can be useful to back up the
work or to apply the settings to further scan controller cards.

Settings
Setting

Explanation

Scan controller

Select the scan controller for the stand-alone configuration.

Enable Stand-Alone mode /
Disable Stand-Alone mode

Choose “Enable Stand-Alone mode” to release the stand-alone configuration
section in the dialog and define your stand-alone configuration.
Press [Apply] or [OK] to transmit the stand-alone configuration to the selected
scan controller.
Choose “Disable Stand-Alone mode” and press [Apply] or [OK] to leave the
stand-alone mode. The scan controller is released for operation from the
RAYGUIDE GUI or the API application.

General
Name

The name of the stand-alone configuration.

I/O port

Select the corresponding I/O port at which the bit information defining the job
selection are expected. This technique is called "binning".
An input port may also have to be defined in the scan controller configuration.
Use the [+] shortcut button to open the respective scan controller configuration
dialog directly and add an I/O port. For details on scan controller I/O port
definitions, refer to page 40, Scan Controller Configuration, I/O tab.

Wait for external start

Determine that the processing of the jobs can only start after a start signal was
detected on the respective scan controller.
NOTE: Without a wait condition, the jobs run in an infinite loop, as soon as the
stand-alone execution was activated.

Flow

Choose Sequential if the jobs are to be executed as arranged in the list.
Individual binning conditions are optional.
Choose Switch if the jobs have individual binning conditions. The job sequence
is then determined by the conditions. To set individual binning conditions,
activate Binning in the Jobs section (see below) and set the available bit range
to the specific signal pattern.
The main difference between the sequential and switch options is:
Sequential: More lists can be executed per loop.
Switch: Only the list that matches the binning conditions is executed. Each
binning condition must be unique.
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Setting

Explanation

Jobs
List ID

ID of the job in the job list. IDs can be edited if required.
The list ID number is allocated by RAYGUIDE.
If you want to change the list ID number, note that only numbers above 100
are allowed.

Binning

Enable Binning to define the binning conditions per job.
The top binning flag enables the binning per job.
If Flow is set to Switch, each job must have a binning condition, and the
binning condition must be unique.
If Flow is set to Sequential, each job can, but must not, have a binning
condition.
The binning condition can be set by toggling individual bits (0/1), or by entering
the corresponding numerical value.
Alternatively, you can import the binning conditions from a *.csv table.

Individual job icons

Timestamps

Export CSV

▪

Upload a single job.

▪

Press the arrow pointing up or down to change the order of the jobs in the
list.

▪

Click [Delete] to immediately remove a single job entry from the standalone dialog.

▪

The lower entry shows the timestamp, when the job file was saved (shown
as soon as the job is added to the dialog).

▪

The upper entry shows the timestamp when the job was uploaded to the
scan controller (shown as soon as the job is added to the dialog).

▪

As soon as the save timestamp of the job file is more recent than the
upload timestamp, it is highlighted in orange, indicating that a more recent
version of the job file is available. Download the job file again to work with
the latest version of the job file.
NOTE: This can only work if you always save the job to the same folder
location.

Generate a csv table that lists the jobs added for stand-alone operation:
Job (Including path and filename) / List ID / Binning flag / Binning value /
Timestamp Downloaded / Save Timestamp / Timestamp Modified.
Import the job list in CSV format, mainly to load the data entered in the CSV
table for binning.

Import CSV

NOTE: It is recommended to generate the table using the export function
before importing, to enter the values for the binning conditions, and only then
to import. This ensures that the format will be correct.

[Add jobs...]

Open a browser window to select one or multiple jobs to be added to the
stand-alone list.

[Upload all]

Transmit all listed jobs to the card.
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Setting

Explanation
Immediately clear all listed jobs of the actual stand-alone configuration from
the dialog and also delete the job lists from corresponding scan controller after
pressing [Apply].

[Delete card`s jobs]

Delete all jobs/lists out of the scan controller memory that were previously
uploaded to the scan controller.

Error handling
In case a list execution aborts, a specific behavior can be defined.
An error event can be caused by a laser or deflection unit error, by a scan controller exception, or by an intended
stop signal from the scan controller that is received by the scan controller.
Write on port

Select a specific output port and define a bit pattern to be communicated.
The output port must be defined in advance in the scan controller
configuration. See page 40, Scan Controller Configuration for details on scan
controller I/O port definitions.

Mode & Timing

Same options as for the write port object. See page 159, Write Port.

Enable delay & Delay [ms]

Define the delay time to wait before the next trigger is accepted after an error event.
NOTE: The delay timer starts after the I/O port pulse, if this has been defined.

Restart process

After an error, the whole stand-alone operation returns to the initial wait condition.
This is important so that operation can continue after a cancellation without the
need to reboot the scan controller.
HINT: This option is activated by default.

Stand-Alone execution
Start the execution of the stand-alone operating mode.
The status display changes from Idle to In progress.
Stop the execution of the stand-alone operating mode.
The status display changes from In progress to Idle.
Tab. 7.58: 061

Flow recommendation for the job execution in stand-alone mode.
To prepare a stand-alone execution, follow these steps in the Stand-alone dialog:
1. Select the Scan Controller.
2. Enable “Stand-Alone Mode”.
3. Add all job files to the dialog that you may want to execute during stand-alone operation
(multiple selection of job files is possible).
4. Re-order the job sequence if necessary.
5. Upload all jobs.
6. Verify the time stamps to ensure that all jobs are up-to-date.
7. Define flow control, binning conditions, error handling.
It is highly recommended to enable “Wait for signal start” and “Restart process”.
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8. Press [Apply] > Now the scan controller card is ready to operate stand-alone.
HINT: Indicated by an orange icon upfront the scan controller entry in the job overview. Also,
the execution panel is blocked.
This action will also save the complete stand-alone configuration under its entered name.
9. Press [Run] to initialize the execution on the card, for example, for testing.
The execution status changes from Idle to In progress.
Alternatively, close the RAYGUIDE application. As soon as you reboot the scan controller, the
stand-alone configuration is automatically activated.
To use an already existing stand-alone configuration, for example, to prepare another scan
controller, proceed with the following workflow:
1. Select the Scan Controller.
2. Enable “Stand-Alone Mode”.
3. Load the stand-alone configuration.
4. Add/remove jobs or change the configuration, if desired.
5. Upload all jobs.
6. Click on [Apply].

Editing the configuration in active stand-alone mode
You can edit the currently displayed stand-alone configuration only while the stand-alone mode is
active while the execution status is Idle: Therefore, we recommend to [Stop] the execution first,
before editing. To apply the changes, do not forget to press the [Apply] button.
If you edit a stand-alone configuration while the stand-alone execution has already been started
(status = in progress) and you press [Apply] or [OK], a dialog appears offering you three different
options:

Fig. 7.74: ADE
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If you press [Apply] to confirm the stand-alone configuration, but there are jobs which are out-ofdate or not even uploaded to the scan controller card, the following dialog reminds you and
prompts to upload these jobs before running the stand-alone configuration.

Fig. 7.75: ADF

Terminating stand-alone mode
A scan controller operating in stand-alone mode is inaccessible by any other application (indicated
by the orange card icon in the job overview). Thus, you must disable the stand-alone mode first to
release the scan controller for RAYGUIDE again.
1. Open the stand-alone dialog.
2. Press the [Stop] button to abort the execution of the stand-alone "master list".
3. Disable “Stand-Alone mode”.
4. Press [Apply] or [OK].
Job execution is stopped even if the current job execution status was In progress, and the standalone mode is disabled in the same step.
Now, the scan controller is “released” and can be operated by the RAYGUIDE application
(indicated by the green card icon in the job overview) again.
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7.7.6

Process Adjustment
Process adjustment allows global and timely adjustments of process parameters and/or a layout
transformation, without the need to edit the job itself.
Process adjustment is available via a separate GUI panel. By default, the Process adjustment
panel is on the right side of the GUI. Click the Process adjustment tab.

Fig. 7.76: ACX

The Process adjustment settings apply to the scan controller card(s) assigned to the current job
and become effective immediately for all jobs executed by this scan controller, including standalone jobs.
Process adjustment can be useful if the layout positioning, the laser power, or the process speed
need to be corrected while the job is looping or between job iterations.
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The following settings are available:
Setting

Explanation

Process adjustment
Value ranges can be limited, see below.
Power scale [%]

By default, you can decrease the laser power to 0% or increase it
up to 200%.
NOTE: The power scale is relative to the laser power defined for
the pen. Logically, the total laser power can never exceed 100%.

Speed scale [%]

By default, you can decrease the process speed to 0% or increase
it up to 200%.
NOTE: The speed scale is relative to mark/jump speed defined for
the pen.

Transformation
The behavior of the transformation buttons can be preset:
Rotates the entire job layout counterclockwise or clockwise.
Shifts (offset) the entire job layout in the axis directions up/down,
left/right.
Increases (scale) the size of the entire job layout in Y or X axis in
[%].
Decreases (scale) the size of the complete job layout in Y or X axis
in [%].
Resets all transformations.
Updates the displayed values of the transformation with the values
currently stored on the scan controller card.
Value fields for process
The values can either result from using the above buttons, or you
transformation (Offset [mm], can enter the value directly.
Scale [%], Rotation [°])
If the value is entered directly, press the [Check] button afterwards
to accept the value(s).
NOTE: Compared to the buttons, an offset in z-direction can also
be defined.
Tab. 7.59: 062
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Related Preset: Power and Speed Limits
It is possible to limit the range of laser power and speed changes in advance.
Select System > Preferences from the menu to open the Preferences dialog. Go to the System
(all users) and to the Process adjustment sub-tab.

Fig. 7.77: ACY

Setting

Explanation

Power scale [%] Min/Max

Limits the range of laser power changes in [%] of the process
adjustment setting.
Check the laser power settings for the used pens and the
capacity of the laser source to define suitable limitations.

Speed scale [%] Min/Max

Limits the range of process speed changes in [%] set for process
adjustment.
Check the mark/jump speed settings for the used pens and the
threshold of the deflection unit to define suitable limitations.
Any settings shall take the laser capabilities into account.

Tab. 7.60: 063
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Related Preset: Transformation Deltas
It is possible to preset the delta of changes made by clicking a transformation button.
Select System > Preferences from the menu to open the Preferences dialog. Go to the User
(current user) tab and to the Process adjustment sub-tab.

Fig. 7.78: ACZ

Setting

Explanation

Offset delta [mm]

How many [mm] an object is offset when clicking a [Move] button
on the Process adjustment panel.

Rotation delta [°]

How many degrees an object is rotated when clicking the
[Rotation] button on the Process adjustment panel.

Scale factor

Factor of scaling in [%] when clicking the [Size] buttons on the
Process adjustment panel.

Tab. 7.61: 064

Reset Options
IMPORTANT: There is no automatic reset of the values set hereby, as they keep stored on the
scan controller! Make sure to reset the adjustments when they are no longer needed, for example
when a new job starts.
It is possible to force a reset at each start of the software:
▪

Select System > Preferences from the menu to open the Preferences dialog. Go to the System
(all users) and to the General sub-tab, Initialization section.

▪

Select event for the transformation and scaling settings when they will be automatically reset:
– At software startup
– At start of processing (execution)
– Never
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8

RAYLASE PLUGINS
RAYLASE does offer our own Plugins for various purposes.
These Plugins are offered to get installed during RAYGUIDE installation procedure.
Their Library files will get stored in subfolder \RAYGUIDE\bin\PlugIns\.
NOTE: All plugins are optional and need to be enabled during the RAYGUIDE installation routine to
be available from the GUI.

8.1

SP-ICE-3 Log Import
The SP-ICE3 log object inserts all the graphic content of a SP-ICE3 log file as layout object. A log
file can be created for each SP-ICE3 scan controller card. It contains all the communication to the
card, including all vectors contained in the jobs that were downloaded to the card for laser
processing.
Re-importing the graphic content in that way can be helpful to find the reason for unwanted process
results (error analysis).
In order to have a log file, logging has to be enabled. Refer to page 236, Error Handling and Log
Files for more information on log files.
To create a log file that contains only data of the current job, it is recommended to reset the log file
before executing the job. See page 40, Setup.
Panel icon:
To display the vector content of a log file in the viewport, click the icon of the log importer on the
object panel. The dialog with the log file import settings opens. Alternatively, you can also drag the
log file directly from the folder into the RAYGUIDE viewport or the job tree using the mouse. In this
case, the default import settings are used.
Note that the log file content gets displayed in the viewport as one graphic object, similar to a DXF
or PLT file object, providing same layout hierarchy.

Essential Settings
Setting

Description

Path

Path and file name of the log file. Use the file selection button to load a
file. The default path is C:\ProgramData\RAYLASE\RAYGUIDE\Logs\.

Start path,
Count

If you want only a specific part of the layout to be imported, enter the
number of the first desired path of the layout, and then the quantity of
subsequent paths.

Start time / End time

These fields can be used to limit the time span of the log file, which is
displayed graphically after the import.
The entry is made in the same format as the entry in the log file.
However, the year is left out:
MM-DD HH:MM:SS:FFF

Only executed lists
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Setting

Description

Offset wait distance

When loading a log file from a MOTF execution, this option is
recommended to display the paths as they were placed in the original job
layout. Even split paths appear stitched together.

Center

Check to place the layout centered in workspace.

Overwrite pens

Will use the pen attribute of the log source. In case of SP-ICE-3 log,
however, only the pen attribute dashed line is taken into account.

Tab. 8.1: 065

Additional Settings

8.2

▪

Common settings for all marking objects, refer to page 119, Common Properties of Marking
Objects.

▪

Transformations; refer to page 132, Object Transformation.

weldMARK Job Importer Plugin
This paid plugin allows to load certain weldMARK Jobs Version 3.6 into RAYGUIDE. Contact your
RAYLASE sales agent if you intend to use it.

8.3

Solar wafer
The goal of this plugin is to import and optimize vector graphics used for wafer processing.

Solar wafer importer
Panel icon:
Vector optimization
This job element imports the vector graphic and replaces multiple vectors arranged in a dashed line
fashion with a single dashed line. Only horizontal or vertical dashed lines are recognized. Any
remaining vectors are appended after the dashed line vectors. The lines are processed
bidirectionally.
Pen Usage
Pen 1 is used for solid lines and starting with Pen 2, as many pens as dashed line patterns exist
are created.
All marking parameters except for the dash line related ones are copied from the default pen
(default 1) to the other pens. Therefore, only the default pen has to be configured. It is advised to
use Skywriting with a small change of heading, depending on the pattern.
With this method, you can configure the layout for fastest processing and save a large amount of
process time by avoiding unnecessary jump delays.
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Solar wafer designer
Panel icon:
This job elements can be used to create the wafer layout direct in RAYGUIDE. The major benefit
compared to the import is that the design pattern can be defined directly by entering just a few
parameters. This avoids the prior DXF generation and rounding issues during import and allows
easy adaption of design changes.
ATTENTION: Please note that, for the solar wafer, the marking and jump speeds must be set to
the same value in the assigned pen.

Fig. 8.1: ADP

Setting

Explanation

Wafer
Size

Size of the wafer square in [mm].
IMPORTANT NOTE: Do not perform any object transformations
(e.g. like scaling) of the object after its creation, as this can lead
to incorrect positioning of the dashes in the dashed lines.

Total Lines

Number of horizontal dashed lines evenly spread over the wafer size.

Bus bar pattern
Size
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Setting

Explanation

Margin

Distance between the bounding box of the "bus bar" pattern and
the wafer outline in [mm].

Columns / Rows

Number of columns and rows of the "Bus bars".

Dashed line
Pattern

The dashed line pattern is defined by entering length values for
laser on/off.
Enter at least two numbers.
The first value defines a dash to start the pattern.
Separate values for dash/gap with blanks.
IMPORTANT NOTE: You can edit the dashed pattern any time
after creating the object. However, it must be edited in the "Object
settings" dialog and not in the associated pen settings.

Forward shift

Distance in [mm].
Shifts the dashed pattern for all lines that are marked from left to
right.

Backward shift

Distance in [mm].
Shifts the dashed pattern for all lines that are marked from right to
left.

Deflection unit settings
Jerk limited control

The jerk-limited control enables optimal acceleration and takes
into account a maximum jerk value, leading to smooth command
signals.
In particular, this improves the behavior at the reversal points
between the lines while reducing the load on the glavanometer
scanner. The reduced jerk in the command improves the
accuracy in the process. (When the jerk-limited control is used, a
reduced tracking error is activated for the deflection unit to ensure
that there are only advantages compared to the standard
operation.)
NOTE: When the jerk-limited control is used, the (red) bounding
box around the acceleration paths is enlarged, even if they
themselves are not displayed graphically.

Max current [A]

Entry of the maximum permissible current for the galvanometer
scanner, between 3 A and 9 A. The specification of the current
value in this optimization serves as a target between accuracy
increase and dynamics increase.
RULE: The lower the current value, the higher the accuracy,
under extension of the acceleration time. The inverse applies for
a high current.

Tab. 8.2: 071
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Fig. 8.2: ADQ
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8.4

Remote Interface
The remote interface is an interface for remote control of the RAYGUIDE user interface on the
basis of API events. It enables you to define a TCP/IP socket via which command lines can be
received to open, modify and execute a RAYGUIDE job, e.g. from a PLC.
The functional scope can be expanded as needed by the user to include the RAYGUIDE-API. In
this case, it must be compiled and updated by the user. Instructions can be found in the
RAYGUIDE SDK manual, chapter 3.5.

Fig. 8.3: AEB

Setting

Explanation

Host Information
List of all network adapters in the UP status and all associated IP addresses of the host PC.
NOTE: The list is collapsed by default.
Listening Socket
The IP address on which the SocketServer receives commands is set to "Any" by default. A
specific IP address does not need to be defined here. If you wish to specify a discrete IP address,
all relevant IP addresses are available to you for selection.
Start / Stop listening

Activates/deactivates "listening" and thus the response to remote
commands.

Auto listening

When the RAYGUIDE application is restarted, it is not necessary to
reactivate "listening" to remote commands if it was previously in use.

Available commands
Each command is terminated with "eol" (end of line).
abort, eol

Command for canceling an active job execution.

Arm **, eol

Command for arming the laser.

blockGui, eol

Command to lock the RAYGUIDE GUI so that no operations can
be made on the GUI during remote control.

close **, eol

Command for closing an active job.
NOTE: The closing command automatically implies that the job
will first be saved in order to prevent changes from being lost.
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Setting

Explanation

closeAll **, eol

Command to close all currently open jobs at the same time.
NOTE: The closing command automatically implies that all open
jobs will first be saved in order to prevent changes from being lost.

disablePointer, eol

Deactivates the pilot laser.

disarm, eol

Command for disarming the laser.

enablePointer, eol

Activates the pilot laser.

upload **, eol

Command for uploading the active job onto the scan controller.

executer, <type>, eol

Command for selecting the execution type: host (on PC) / quick
(test run) / card (on card)

getJobElements, eol

Generates a character string with a list of short labels of all job
elements of the active job. The character string is generated in
the JSON format. For more details, see the API Handbook, class
RequestJobElementsEvent.

getJobPens, eol

Generates a character string with a list of all data of all pens used
in the active job. The character string is generated in the JSON
format. For more details, see the API Handbook, class
RequestJobPensEvent.

getPenNumbers,
<jobElementLabel *>, eol

Generates a character string with a list of the pen numbers of all
pens that are used in the job element with the transferred short
label. The short label is case-sensitive. The character string is
generated in the JSON format. For more details, see the API
Handbook, class RequestPenNumbersEvent.

getPens,
<jobElementLabel *>, eol

Generates a character string with a list of all data of all pens that
are used in the job element with the transferred short label. The
short label is case-sensitive. The character string is generated in
the JSON format. For more details, see the API Handbook, class
RequestPensEvent.

modifyText,
<jobElementLabel *>,
<nexttext>, eol

Command for changing the content of a text or code element.
<job element label> corresponds to the name of the job element
in the tree directory.
<next text> Definition of the new text content.

modifyTransformation, <job
element label *>, <rotation>,
<scaleX>, <scaleY>.
<scaleZ>, <offsetX>,
<offsetY>, <offsetZ>, eol

Command with which individual layout objects can be
transformed.

open **, <path>, eol

Command to open a job in a certain folder.

renderAsBitmap, <Path>,
<imageSize>, eol

Command for saving an image of the work area of the current job
locally at a specified location and with a specified image size (the
size refers to the larger side of the image in pixels).

run, eol

Command for starting the job execution task.
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Setting

Explanation

Save *, <path>, eol

Command to save the job after a change (e.g. new text content or
object transformation), as otherwise a prompt will appear when
the job is closed.
<path> defines the file path for the storage procedure.

setActiveJob, <job label>, eol

Command to define the current job or to change it. If you loaded
multiple job one after the other, the job loaded last is the active
job.

SetPreviewParameters
<previewAll>,
<previewMode>,
<previewSpeed>, eol

Command to make the various settings for a preview.
PreviewAll = True: all objects are shown in the preview.
PreviewAll = False: only selected objects are shown in the
preview.
PreviewMode = Mode Index 0 to 4
0 = All; 1 = Contour; 2 = Rectangle; 3 = Envelope; 4 = Point
Unit for the variable previewSpeed = [m/s] Permissible value
range = 0.05 m/s to 10 m/s

StartPreview, eol

Starts the preview with the pilot laser (for details on the preview,
see page 204, Running a Preview).

StopPreview, eol

Ends the preview with the pilot laser.

transform, <rotation>,
Command for setting the process transformation.
<scaleX>, <scaleY>, scaleZ>, NOTE: The rotation must be specified in [rad], the scaling in
<offsetX> <offsetY>,
[absolute factor] and the offset in [µm].
<offsetZ>, eol
Details on process transformation, see page 221, Process
Adjustment.
unblockGui, eol

Command to unlock the GUI again.
NOTE: This command should always be used at the end of a
program run.

assignScanHeads **;
<scanControllerShortLabel>,
<scanHead1ShortLabel *>,
<scanHead2ShortLabel *>,
eol

Command for assigning the deflection unit to the control card.
NOTE: By means of assigning the deflection unit to the scan
controller, a deflection unit can be specifically selected, however
with different correction files and different calibrations.

Active Job
Shows the job name of the currently active job.
Socket Messages
Lists all incoming commands either as confirmed or with an error message.
Tab. 8.3: 080

* The labels are case-sensitive.
** These commands have a specific timeout value. It can, if necessary, be adapted in the
RemoteInterface.json file. For all other commands, the timeout is set to 500 ms.
TIP: To test the remote connection commands, a client tool (RemoteClient.exe) is made available
in the \RAYGUIDE\tools directory.
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NOTES Regarding the sequence: First enter the correct IP address of the server (RAYGUIDE
GUI). Click on "Start Listening" to prepare the server to begin receiving commands. Then establish
the connection on the client side using the "connect" command. The connection is now ready for
using the commands described above.
NOTE: If the client application was closed while the server was still "listening", "listening" needs to
be ended on the server side when the client application is to be restarted and started again before
a connection can be re-established there using the "Connect" command.

© 2022 RAYLASE GmbH

RAYGUIDE Manual V1.12

233

9 CUSTOM PLUGINS

9

CUSTOM PLUGINS
The RAYGUIDE software and its GUI can be extended with customer-defined plugins.
There are two types of custom plugins:
▪

API plugins: This can be used to add, to the RAYGUIDE application, devices or job elements
that were developed/programmed specifically for this purpose.

▪

Embed the control elements for actuating external/third-party components into the "Custom UI
panel".

API Plugins
Examples:
▪

Job elements: Use the RAYGUIDE API to build your desired job elements, such as graphics,
container, and automation objects.

▪

Devices: You can implement another device from type Laser, deflection unit, IO controller or
even scan controller to configure and use it from RAYGUIDE GUI.

Custom UI panel
The custom UI panel is activated from the menu: View > Panels > Custom UI. This UI panel is
empty by default.
Any external control element based on WPF (Windows Presentation Foundation) can be
embedded.
Examples of custom UI panel usage:
▪

Viewing a camera stream of the actual marking process.

▪

Controlling the movement of a conveyor belt.

The RAYGUIDE software development kit (SDK) offers sample codes and the RAYGUIDE SDK
manual provides a detailed description on how to realize a custom plugin.
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EMBEDDED RAYGUIDE GUI
This feature allows you to embed either the complete GUI or selected GUI elements, for example,
the panels, into your machine HMI.
This saves you from programming your own controls to access the RAYGUIDE functionality
(opposite principle to custom plugins).
NOTE: Dialogs cannot be embedded without calling their event.
How to realize the embedded GUI using the Microsoft WPF tool is described in more detail in the
RAYGUIDE SDK manual.
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ERROR HANDLING AND LOG FILES

11.1

Error Messages
Error messages can be generated by RAYGUIDE. These messages appear in the RAYGUIDE GUI
as window-spanning bars. They have to be acknowledged before continuing.
A message contains an expandable stack trace with detailed information. The complete text can be
copied and pasted, e.g. into an e-mail message to support@raylase.de.
Other error messages get generated by the scan controller and will get transmitted to RAYGUIDE
GUI.
For example, an “Out of field” exception is generated, when the conveyor belt moves target
material too fast in MOTF process.

Contact Support
Each RAYGUIDE exception window bar also provides a shortcut to send a support mail. All
required log files (including the batch error message), system configuration and the currently open
RAYGUIDE job file are automatically attached to this email. If you do not want the current job to be
transferred, please delete the corresponding email attachment.
By default, the mail recipient is empty. You can define a default recipient by editing the
corresponding entry in the branding.json file located in the folder:
C:\ProgramData\RAYLASE\RAYGUIDE\Configuration\

11.2

Log Files
There are two log file types: One for the RAYGUIDE software and one for the communication to the
SP-ICE3 scan controller card. If more than one card is applied, each has its own log file.
The name of the card's log file equals the card's label. In case of multiple cards, using the serial
numbers as labels is suggested.
The default file path is C:\ProgramData\RAYLASE\RAYGUIDE\Logs\.
It is recommended to have logging enabled. Open the scan controller card configuration with
System > Devices > Scan controller and set the checkmark at Enable Logging. With the [Reset]
button, the file can be reset to empty. The path to the log files can also be seen (default location or
other) and opened here. Log files can be read in a text editor.
NOTE: The log files are always created new when the software is started or when the maximum
size of 10 MB is reached. The 10 latest files are kept as ZIP files in an archive sub-folder.
NOTE: Multi-point calibration log data is contained in the RAYGUIDE log file.
Log files may also be sent to RAYLASE support in case of errors.
Be sure to include the software version (via Help > About) in your error reports.
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11.3

Notification Panel
In this list hosted on the Notification panel, RAYGUIDE traces status information which can also
help to debug issues, such as a scan controller has not connected. In general, all SP-ICE-3
exception will be listed.
This list will also trace all measured values, generated with the measurement tool.
You can select the complete list and just copy&paste it into a document or e-mail.
To clear the panel, right-click and its context menu will offer you the copy and clear function.
We recommend sorting the list by descending date, to have the latest notification always on top.

Fig. 11.1: AEC
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TROUBLESHOOTING
There is no laser radiation, but the deflection unit is "working".
a) Check if the laser is armed.
b) Check laser configuration, especially the hot power target setting.
c) Check the cabling.
d) Check whether the laser has output an error.

Bitmap or vector object in job tree but no graphic in viewport
An object was just added by dragging it into the tree, but no source file was selected.

An individual object is not processed.
a) The Mark flag in the object settings is disabled.
b) The Should mark flag is disabled in associated pen.
c) The object has a binning condition set which has not been met.

Job does not get processed.
Check if RAYGUIDE is currently connected to the scan controller card. A first indication can be the
color index of the icon in front of the SP-ICE-3 entry in the job overview.
In case the scan controller was disconnected or had a power loss during the use of RAYGUIDE,
we recommend to reconnect. Then, re-toggle the [arm/disarm] button in the execution panel.

The layout of the panels is unusably jumbled or not present at all.
Navigate to View > Layout and use [Reset] to return to the standard panel configuration.

Layout objects cannot be edited in the drawing area.
a) Check your RAYGUIDE rights and the activities to which you have authorized access.
b) Check whether the working area, the job tree or the individual object was proactively "locked" to
prevent editing.

The laser emits power but the deflection unit does not move the laser beam.
a) Check whether the deflection unit is supplied with power and correctly connected to the scan
controller card.
b) Check whether a deflection unit has been configured and assigned to the scan controller.
c) Check the operating status of the deflection unit on the status tab of the deflection unit dialog.

Directly after starting an execution, an "Rpc" error message indicating that
marking was aborted is output.
Use the SP-ICE-3 Config. Tool, "SFC" tab, to check whether the "Abort Mark State" is set
permanently to 1. This would mean that the scan controller is set permanently to "Abort", for
example because an IO pin was wrongly configured for Abort, or the signal is short circuited.
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The icons and panels for a RAYGUIDE plugin (Solar Wafer, SP-ICE-3 Log
Importer, Remote Interface) are not available in the GUI.
The corresponding plugin was not selected during the initial installation of the RAYGUIDE software
or during the last software update.

A single mark object in the container is not selected in the drawing area.
The bounding box of individual objects does not appear in the drawing area after one or more mark
objects are dragged into a group or copy container and then selected in the object tree. The reason
for this is that the Single output option is enabled in the container.
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FREQUENTLY ASKED QUESTIONS
Q: Can I load a job that was created on another RAYGUIDE installation?
A: Yes. All job-relevant information, including workspace configuration and pen set configuration, is
delivered with the job file. You only need to link the job to your local scan controller and any other
connected hardware devices.
Bitmap elements must be stored within the job before they are transferred to another RAYGUIDE
installation.

Q: What if I need to replace my scan controller?
A: You open the scan controller dialog and start the search for the IP address. As soon as the IP
address of the scan controller is found, the connection to the scan controller card is established. The
previous configuration data for the deflection unit including its correction file, field calibration, and
laser configuration, are transferred to the newly installed scan controller when you press [Apply].

Q: What do I have to consider when updating RAYGUIDE?
A: All your configurations regarding hardware devices, RAYGUIDE settings, pens, etc. remain
untouched when updating RAYGUIDE.
The only thing you need to check is the compatibility with the firmware version of the SP-ICE-3
scan controller. The compatible firmware version is always noted next to the RAYGUIDE
installation package on its download website.

Q: Can I use the RAYGUIDE-GUI if I work with a RAYGUIDE SDK license?
A: Yes, but only in demo mode. However, in this mode you can still configure and calibrate the
system using the GUI dialogs. You can also load and check jobs generated by API commands.

Q: Can a job created with RAYGUIDE GUI be processed by another RAYGUIDE API application?
A: Yes, you can load and modify this job and process this job through your custom API application,
as the job is not bound to a specific license.

Q: I use an activation license, but I need to replace my PC or change the operating system. What
do I need to consider?
A: The activation license is bound to certain attributes of your computer. Changing the operating
system may unbind it. We therefore strongly recommend that you contact our support before
changing your PC or operating system.
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Acceleration time [µs]
Time the scanner takes to accelerate/decelerate to the desired speed. This parameter is required
for processing bitmaps in "sprint mode", where an acceleration/deceleration vector is added to
each bitmap line.

Binning
Binning is an option to execute a job or job element, depending on the pattern of an I/O port that is
most likely set by a PLC.

BoundingBox
The bounding box is a rectangle that encloses the layout object and is always vertically oriented. It
is only used internally by the RAYGUIDE application and therefore, unlike the "Enclosing
rectangle", is not displayed in the viewport.

Center of Transformation (CoT)
The point around which an object or container is scaled and/or rotated during an object
transformation.

Change of Heading (CoH)
The angle between two consecutive vectors that describes the change in direction.

Fig. 14.1: ADX

Command
A command is a graphical element that supports the scan controller card library as per the
command definition. The SP-ICE-3 scan controller supports vectors, arcs, ellipses and Bezier
curve commands.
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Container
A container is a special type of object plugin with the goal of assigning certain behaviors to the
objects inserted there. In the simplest case, all objects should have the same number of
executions, for example. Or the aim may be to multiply the objects contained therein in a defined
manner.
Containers can contain both layout and automation objects, or other containers (nested structure).
Each container has its own transformation matrix that transforms all layout objects contained in the
container.

Deflection unit / scanhead / scanner
An opto-mechanical unit that uses so-called optical axes (mirrors and lenses) to deflect and focus
the laser beam.

Device
The term “device” refers to a physical component within the laser cell, such as a deflection unit,
laser, or serial port. In future, other types of "devices" may be added.
Enclosing rectangle
Compared to the bounding box, the enclosing rectangle always rotates together with its layout
object. Its dimensions determine the size specified for the layout object.

Field domain
Positions defined in the field domain refer to the scan field coordinate system. The coordinates get
translated into the scanner domain on the SP-ICE-3 scan controller via field transformation and
correction file. RAYGUIDE manages the coordination of layouts exclusively in the field domain.

Free-shaped vector object (as compared to pre-shaped vector object)
A "free-shaped" vector object is generally created by importing graphic files and always has the
hierarchy structure Object > Layer > Path > Command. It is "free-shaped" because it can contain
very complex polylines and its individual thumbs can be freely edited.

Gate pre-run/hold time
Gate pre-run and gate hold time specify how long the gate signal is activated before marking starts
and is kept active after marking ends.

Gate signal
Signal that generally modulates the laser emission. When the SP-ICE-3 scan controller is used,
you can configure the polarity of the signal (high vs. low) according to the requests of the
connected laser source. This setting is part of the RAYGUIDE laser configuration.

Job
A collection of processable objects that the RAYGUIDE application can load/save with the file
extension RG. These objects can be layout objects and automation objects. Each job content is
translated by the user application into one or more command lists that the scan controller can
process further.
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Laser-on delay / laser-off delay
This delay defines the time by which the laser trigger pulse is delayed in relation to the scanner
position at the beginning/end of a marking vector.

Laser trigger delay
This value defines the time by which the optical pulse is delayed compared to the trigger pulse of
the LM signal.

Layer
Defines a group of paths. Subunit of a free-shaped vector object.

Layout
Sum of all graphical job elements.

Licence
A permission distributed by the owner of the software to use the software. It can be distributed as
activation file or as hardware dongle.

LM signal
Signal used to trigger laser pulses. Its pulse rate is defined via the laser frequency pen value. The
pulse width of the signal is defined either in the laser configuration or also in the pen.
When the SP-ICE-3 scan controller is used, you can configure the polarity of the LM signal (high
vs. low) according to the requests of the connected laser source.

Log file
Files that track all commands sent, for example, by the application to the scan controller. This way,
the actions performed by the RAYGUIDE application are tracked.

Spot Magnification
Option to increase the laser spot size by using either the zoom feature or the defocus feature of a
4- or 3-axis deflection unit. Requires a special FC3 correction file.

Mark/Jump Delay
The delay applies after a mark/jump vector. It is needed to stabilize the optical axes (mirrors) after
deceleration to avoid deflections. The optimal value is established by means of process tests. As
an initial value, we recommend setting it to 120% of the acceleration time.

MOTF
"Mark-On-The-Fly" application in which the parts or the material(s) to be processed move through
the scan field.

Motor axis
A motor axis refers to the axes of a stepper or servo motor device.
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Object
Basic elements of a laser process job.

Path
Single or a chain of graphic commands that define a continuous line. The line can be opened or
closed (start and end points are equal). Subunit of a layer.

Pen
A series of parameters used to define the behavior of the laser and deflection unit during layout
processing.

PLC
Programmable Logic Controller.

Position dependent power correction file
A correction file containing a table of power gain values in relation to the field position. It is
managed by the SP-ICE-3 scan controller. The file is created using the Multi Point Editor
application. The file extension is PC3.

Poly delay
Delay applied for each vector connection so that the deflection unit can follow sharp corners. When
using a variable poly delay, the delay time is adjusted according to the "change of heading angle".

Power calibration file
A file that can be created using the SPICE3PowerCalibrator.exe software tool to linearize the
emitted laser power with respect to the power control value.

Power ramp
Feature for linear modulation of the laser power at the beginning/end of a path by a defined length
or time. It is implemented by the SP-ICE-3 scan controller.

Pre-shaped vector object (compared to free-Shaped vector object)
A vector object defined by its geometric properties, for example, Line, Rectangle, Polygon,
Circle, Ellipse, Spiral.

Protocol (electric decoding vs. language)
The protocol defines how the scan controller communicates with the deflection unit.
One aspect is the electronic decoding of the signal. This determines how many axes can be
controlled per cable.
Another aspect is the data format, so that both sides can interpret the command language.
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Jolt
"Jolt" is the change in acceleration over time. If, for example, a directional change of almost 180°
occurs in a geometry, the scan movement must be fully inverted, which leads to abrupt
deceleration with subsequent maximum acceleration. This could cause the deflection mirrors to
oscillate, which in turn would result in marking inaccuracies. This jolt-limiting control would
counteract this.

Scan controller/card
Special printed circuit board for actuating the laser and deflection unit by hardware signals. Can
provide additional Inputs/Outputs. The RAYLASE product is the SP-ICE-3 scan controller card.

Scan field / working field
Area in which the deflection unit can image the laser beam. Defined by the loaded correction file.

Scanner Domain
The coordinates from the field domain translated into units that can "implement" the respective
received optical axis. This conversion is also performed by means of the correction file when a SPICE-3 card is used. For example: A 3-dimensional coordinate in the field domain is translated into
deflection angles for X- and Y- mirrors and a position in bits for the Z-lens.

Skywriting
Feature that adds an additional acceleration/deceleration vector at the beginning/end of a marking
vector to improve marking precision and power input at vector transitions. Implemented by the SPICE-3 scan controller and applied depending on the heading angle.

System
Refers to the complete RAYGUIDE application suite.

Tracking error [µs]
Time the scanner needs to respond to a new position command. The value is used, for example,
for compensating for the different tracking error values or for speed-dependent power correction.

Sequence
In the RAYGUIDE software, repeated workflows of a geometry with the same parameter set (Pens)
are referred to as a sequence.

Tracking error compensation
Feature of the SP-ICE-3 scan controller to account for the differing dynamic behavior of the X- and
Y-mirrors compared to the Z-lens(es).

Tuning
A property of a deflection unit that defines the dynamic behavior of the unit. Digital deflection units
may have more than one tuning and the ability to switch between them. The equipment of the
deflection unit in terms of tuning is defined in the deflection unit ordering process.
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Velocity based power control
Feature for automatic adaptation of the laser power to the actual speed of the scanner mirrors
during acceleration/deceleration. Implemented by the SP-ICE-3 scan controller. For
implementation, the SP-ICE-3 scan controller uses the tracking error value, which is why it is
important that these values are correct.

Wobble
A defined oscillation of the X and Y mirrors to create a circle or Lissajous shape along a vector.
Mainly used in welding applications or to create wider line thicknesses in the marking result.

Working distance [mm]
Vertical distance between the lower edge of the base plate of the deflection unit and the focal
plane.

Workspace
The work area defined by the user.
▪

It can be limited to a smaller area than the scan field.

▪

It can represent an intersection area or a combined area of several scan fields.

▪

It can represent the virtual field introduced by MOTF or an XY-motor table.
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1 INTRODUCTION

1

INTRODUCTION

1.1

About Click&Teach
RAYGUIDE Click&Teach, often abbreviated with C&T below, is an extension of the RAYGUIDE
laser software. C&T uses cameras mounted on the optical axis of deflection units for displaying an
image of the actual scan field in the scan field window of RAYGUIDE.

Fig. 1.1: Arrangement consisting of a deflection unit, camera adapter, camera lens and camera

In this way it is possible to trace the contours of real objects with the graphic features of the
RAYGUIDE software and to comfortably generate laser jobs. Existing objects in a job can be easily
superimposed with the positions of real objects.
The camera image generally shows only a small section of the scan field. The overall image is
created from individual tiles.

© 2022 RAYLASE GmbH

RAYGUIDE Click & Teach V1.4

5

1 INTRODUCTION

1.2

About this Manual
This manual describes the functionality, installation and operation of the supplementary C&T
application of the RAYGUIDE software when used with the Graphical User Interface (GUI).
The manual part dealing with the supplementary C&T application is contained in the PDF edition of
the RAYGUIDE manual. It is not issued as a separate document.
NOTE: Consequently, the same rights apply as for the main manual of the RAYGUIDE application
and the same rules also apply to the warranty and support.

Conventions
Emphasized phrases are printed in bold.
Important notes and remarks are introduced with NOTE:, RULE:, etc.
Folder and file names are printed in italics.
Names of windows, dialogs and tabs are in plain text: On the Settings tab.
Menu selections are bold and in italics: Select File > Save as...
The names of the dialog options (function buttons, checkboxes) are specified in italics: Select the
Manual calibration mode.
Buttons are bold and in italics and shown with brackets: Click on [Start calibration].
Buttons labeled with graphic icons are described by words.
Example:

is the [Search] button.

References to other pages in the manual are in italics: See page 22, Setup.
Links to web addresses are underlined: Visit RAYLASE.
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1.3

Compatibility
The supplementary C&T application is compatible with the RAYGUIDE laser software.
Please note that currently only the cameras of the GO-PGE series from JAI and the cameras of the
Genie-Nano-GigE series from Teledyne DALSA are supported. C&T was successfully tested with
the models GO-5100M-PGE, GO-2400M-PGE and Nano M2420 Mono.
The basic operating procedures can be simulated with the camera emulator.
NOTE: We recommend primarily operating the camera via a peer-to-peer network connection and
advise against using a company-internal network in light of the data volume.
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1.4

PC requirements
To operate the RAYGUIDE software with the supplementary Click & Teach feature, the PC must
meet the following requirements:
▪

A Windows 10/Windows 11 operating system with a 64-bit platform

▪

A RAM of at last 16 G

▪

It is highly recommended that the network card for the connection have an INTEL chip as this
type of network card was demonstrated to have a trouble-free connection to the camera.
Support is not guaranteed if other network cards are used.
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1.5

Scope of delivery
The scope of delivery of the Click&Teach installation includes the camera plugins for the general
communication with the respective camera type and the UI panel for the Click&Teach application.
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2

INSTALLATION

2.1

Hardware
Apart from the components required for operating RAYGUIDE (laser, control card, etc.), the
following additional components are needed for C&T:
▪

RAYLASE deflection unit with suitable F-Theta lens

▪

RAYLASE camera adapter

▪

Camera (see page 7, Compatibility)

▪

Lighting equipment for lighting the working field

NOTE: The F-Theta lens, deflection unit, camera adapter and laser must be carefully matched in
terms of power, beam diameter and wavelength. Only suitable lasers may be coupled with the
RAYLASE camera adapter, deflection unit and F-Theta lens.
The dichroic element of the RAYLASE camera adapter must be adjusted after mounting and
fastening the fiber collimator of the laser to couple the beam precisely with the deflection unit. Note
the RAYLASE manuals Standard Camera Adapter and High Power Camera Adapter. When using
preadjusted High Power welding modules with a collimator, it is not necessary to adjust the High
Power camera adapter.
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2.2

Software

2.2.1

Click&Teach software installation
RAYLASE makes a specific installation routine available for installing the Click&Teach software
components (validated camera driver and plugins):
1. Select whether you would like to install the GUI and/or the SDK variant.
2. In the Driver category, select the driver that is suitable for your camera model.
NOTES:
▪

Please always install the RAYGUIDE application before installing the supplementary
Click&Teach application.

▪

When installing or upgrading the camera drivers with other setup files, RAYLASE will not be
able to provide support in case of faults.

▪

Please read the license agreement before beginning with the installation.

Fig. 2.1: Installation of camera plugins

2.2.2

Licenses
To be able to use the supplementary Click&Teach application, your RAYGUIDE license requires an
additional "product code". It can be ordered as part of the initial order for the RAYGUIDE software
or at any time after that, and your existing license can be expanded by means of a file upload.
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Viewing product codes
1. Select Help > About RAYGUIDE to view the product codes.
2. Check whether your current license activates the supplementary Click&Teach application.
Example:

Fig. 2.2: License

2.2.3

Software updates
If you update your RAYGUIDE application by loading new versions, the appropriate Click&Teach
installation must also be performed as well. This is necessary to ensure compatibility between the
main application and the supplementary application.
The camera drivers can be selected during an update but do not have to be. This is the case
unless it is noted explicitly that the drivers are updated with the new version.
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2.3

System preparation
Before the C&T application, it must be ensured that the deflection unit and laser of your system
have already been configured and the scan field has been calibrated. This includes multi-point
editing (if necessary) of the appropriate correction file.
Values for the offset and rotation can either be integrated directly in the correction file or can be
applied later in the field transformation after a multi-point correction has been performed.
The details of this process can be found in the manual for the Multi Point Editor, which is contained
in the appendix of the RAYGUIDE manual. In a standard installation, the latter is stored in
C:\ Program Files\RAYLASE\RAYGUIDE\Documentation\RAYGUIDE Manual MN121.pdf.
In addition, entries for the process transformation are taken into account by automatically
displaying the background image with a distortion, and a superimposably traced or positioned
outline is again displayed without distortion when marking.
In addition, it is advisable to already have a pen in the library pen set marked as "Default", which
you can later use to mark your material for the camera calibration with good contrast and a sharp
result.
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3

CLICK&TEACH COMPONENTS
From a user’s point of view C&T consists of two components which are fully integrated in
RAYGUIDE.

3.1

Camera dialog
For each connected camera there is a Settings dialog that is executed as a RAYGUIDE device
plug-in. Select System > Devices > Cameras > JAI camera to open the Settings dialog.

Setup

Fig. 3.1: Camera settings, Setup
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Setting

Explanation

Setup
For defining several camera parameters, such as the exposure time.
Camera

Selection of the desired camera if multiple cameras are found on the
system.

Deflection unit

Selection of the deflection unit at which the corresponding camera is
optomechanically docked.

Settings
Image size (width x
height) [pixels]

The size of the produced tiles can be reduced here. It may be helpful
to reduce the unavoidable image distortions at the expense of the time
required for tiling.

Scaling factor [%]

The resolution of a tile or the overall image after it is taken is reduced
by this factor to save memory and increase performance.

Flipping horizontally

When a camera is attached to a RAYSPECTOR module in
combination with an AS-FIBER, the light for the camera can be
decoupled vertically or horizontally:

If it is vertically decoupled, the camera image must be flipped.
Amplification

The cameras permit the electrical amplification of the detected incident
light to lighten the camera image.

Exposure time [ms]

The cameras permit the setting of the exposure time to be set for an
individual image. A longer exposure time makes the camera image
lighter.

Combining four pixels in
one

The cameras permit so-called "binning".
In this process, pixels are combined. This reduces image noise at the
expense of the resolution. Optionally, the gray values of the pixels can be
summed or their average calculated to calculate the result image point.

Camera info
Information on the manufacturer, model, version, serial number and connection ID
General
Short label
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Click&Teach calibration
NOTE: The buttons of the Click&Teach Calibration tab can only be used if the C&T UI panel is
visible. Otherwise, they are grayed out.

Fig. 3.2: Camera settings, Click&Teach calibration
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Setting

Explanation

Click&Teach calibration
For setting and/or determining the calibration parameters.
Sensor axis offset [%]

The slider can be used to adjust the focus of the camera for the
reference position (at the working distance).
ATTENTION: A positive value shifts the focus "downward".
NOTE: The input field and slider are grayed out if the correction file
has no z-area.

Calibration mode

The camera can either be calibrated manually by aligning the marking
lines with the scale markings in the camera image or largely
automatically by means of image processing algorithms.
For the latter, a clean marking result of the calibration job is required.
The marking parameters (pen) therefore need to be selected carefully.

Calibration for focus
plane [mm]:

For systems that work with a correction file including the z-area, the
camera must be calibrated in different focal planes to be able to take
photographs in different focal planes. A minimum of 2 focal planes
should be calibrated. The data between the calibrated planes are
interpolated. For this reason, it is advisable to calibrate the uppermost
and lowermost planes.
NOTE: If no z-area is defined in the correction file, these fields are
grayed out.

Pen for calibration job

Selection of the pen for marking the calibration job.
NOTE: The pen number refers to the library pen set defined as the
"Default". After the job is created, this pen can still be edited if
necessary.

Calibration of the camera image size
Measure [mm]

The distance between the two scale markings used for the calibration
of the camera image size in the real world.

Image size (width x
height) [pixels]

The image size is the result of the image size calibration and indicates
how large the area recorded by the camera is in reality.

Pixel size (width x
height) [µm]

Indicates how large the area is in reality that is recorded by a single
pixel.

Calibration of the center point
Deviation (x,y) [mm]

For design reasons, there is a deviation between the point to which the
laser points and the center point of the camera image. This offset
relative to the coordinate axis is determined by means of the center
point calibration and is then compensated accordingly during tiling.

Wavelength calibration
Upper left corner (x,y)
[mm]
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At this position, a cross is generated in the calibration job that, on
account of the different wavelengths of visible and laser light, appears
in a slightly different position in the camera image. This difference is
used to calculate the scaling factors for the wavelength correction.
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Setting

Explanation

Lower right corner (x,y)
[mm]

The second cross position is located at the diagonally opposite side
only for the purpose of better accuracy of calculation.

Scaling factor (x,y)

The result of the wavelength correction indicates a factor that must be
applied to the mirror positions to compensate for the different angles of
refraction of visible and laser light.
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3.2

C&T UI panel
The C&T UI panel can be shown or hidden, as desired, on the right edge of the UI panel if a C&T
license exists. Select View > Panels > Click&Teach.

Fig. 3.3: C&T UI panel in RAYGUIDE

The UI panel contains various buttons for controlling different features in addition to the live image
of the camera. The contents of the UI panel are described in greater detail in this manual, see page
42, Buttons.
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4

SETTING UP THE CAMERA
Before beginning to set up the camera, ensure that all mechanical components are correctly
aligned and that the camera is mounted on the deflection unit using the adapter and is connected
to the network with the Ethernet cable. The matching correction file must be loaded for the
deflection unit and the F-Theta lens used (see page 11, Click&Teach software installation). Focus
the camera lens in such a way that a sharp image is displayed.

4.1

Configuration of the network connection with the
camera
Use the configuration tools of the camera manufacturer to perform the basic setup of the camera.
Set the necessary network parameters for your network card and supply the camera with a valid IP
address.

4.1.1

JAI cameras
The JAI company makes the eBUS Player for JAI program available for configuring your cameras.
The eBUS Player enables more extensive settings than the Settings dialog (see page 14,
Click&Teach components), which can only be used to adjust the most important parameters.
The steps necessary for configuring the IP address are described below:
1. Start the eBUS Player and click on the [Select/Connect]. The executable file for a driver
standard installation can be found under
C:\Program Files\JAI\eBUS SDK\Binaries\eBUSPlayerJAI64.exe.

Fig. 4.1: eBUS Player for JAI for the basic configuration of the camera
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2. In the Device Selection dialog, all network adapters that are known to your PC are listed on the
left side. Since your camera does not yet have an IP address, it cannot be reached at this time.
Activate Show unreachable Network Devices:

Fig. 4.2: Configuration of the IP address

3. The camera (GO-5100M-PGE in the example) appears below the network adapter to which it is
connected. Click on the entry to display the Interface Information and Device Information.
4. Click on [Set IP Address…] to open the dialog for configuring the IP address.
5. Enter an IP address that is still free in your network.
6. The red warning symbol in the device list disappears when you close the Device Selection
dialog.
7. Close the Device Selection dialog by clicking on [OK].
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8. Click on [Play] to display a live image. First, however, the IP configuration is completed. Click
on [Device control]:

Fig. 4.3: Permanent configuration of the IP address

9. In the Device Control dialog, select the visiblity level Beginner to reduce the parameter list.
10. The TransportLayerControl section, you can set how the camera should be supplied with an IP
address in the future. If there is a DHCP server in your network, the camera can obtain the
address from there. For this purpose, set the GetCurrentIPConfigurationDHCP element to
True. In this case, the camera is connected directly to a network card installed in the computer,
so that the IP address should be fixed.
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4.1.2

Teledyne-DALSA cameras
The Teledyne DALSA company makes several programs available for configuring its cameras.

4.1.2.1

Sapera Network Configuration Tool
Use the Sapera Network Configuration Tool to set the IP address:

Fig. 4.4: Sapera Network Configuration Tool for setting the IP address

1. Select the camera in the list of network adapters.
2. Change to the Device IP Configuration tab and enter the desired IP configuration.
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4.1.2.2

Sapera CamExpert
Use the Sapera CamExpert to set the camera parameters, such as the exposure time:

Fig. 4.5: Configuration of TELEDYNE-DALSA cameras with CamExpert

1. Select your camera in the Device drop-down list in the Device Selector section.
2. Enter the desired camera parameters.
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4.2

Setting up the camera as a device in RAYGUIDE

4.2.1

Setting up the camera as a device
The camera is added to RAYGUIDE via the Device Configuration dialog. Select System >
Devices> Configure… .
Configuration window with example content:

Fig. 4.6: Device Configuration RAYGUIDE dialog

If the C&T extension is installed and a valid license is available, the existing camera plugins appear
in the Supported Devices window section on the left side. Use the mouse to drag the desired
camera from the Supported Devices window section to the Configured Devices section. Close the
dialog by clicking on [OK].
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4.2.2

Connecting/assigning the camera
In the menu, click on System > Devices > Cameras > JAI camera to open the Settings dialog.
Change to the Setup tab to set up the camera connection.
1. Click on [Search] to search for existing cameras.
2. Select the desired camera in the drop-down list and click on [Connect/disconnect] to
establish a connection or interrupt a connection. An active connection is indicated by a green
“traffic light”.
As soon as a connection is established, several parameters, such as the image size or the
current exposure time, are read out of the camera.
3. Assign the associated deflection unit to the camera.

Fig. 4.7: Camera settings: establishing a connection

4. Edit the parameters in the Settings section. (To adapt further camera parameters, use the
configuration program from the camera manufacturer.)

Fig. 4.8: Camera parameters

The scaling factor has special significance. A complete image of the work area consists of many
(e.g. ten by ten) image tiles. If, for example, a camera generates images with 2000 pixels along the
width, the overall image has a width of 20,000 pixels. This is inconvenient for performance reasons
and is also not necessary. For this reason, the scaling factor is used to scale down the images to a
useful size.
NOTE: Calibration requires a high accuracy, which is why the images are always shown with the
full resolution in this case.
5. Close the dialog with [OK] to adopt the a changes. In the menu, click on View > UI panel >
Click & Teach to open the C&T UI panel.
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4.3

Aligning the camera
Due to the mirror arrangement in the deflection unit, the camera image is always slightly rotated.
The correction file used may add an additional rotation (see page 13, System preparation). This
rotation must be canceled out by a corresponding counterrotation when mounting the camera. For
this purpose, a job of horizontal lines is marked, observed through a camera and aligned in such a
way that the lines are parallel to the image edges. It is best to use the job that is also needed for
the calibration of the camera.
For this purpose, set the calibration mode to manual, select a pen that is suitable for marking on
your material, and click on [Generate calibration job].
NOTE on calibration jobs and RAYGUIDE work area:
In the RAYGUIDE software, the work area can consist of several scan fields.It can be smaller or
larger than the scan field and may have an offset relative to the scan field.
Click&Teach always automatically positions the calibration job centered relative to the scan field
and not centered relative to the work area since every coaxially operating camera always acts per
scan field.
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If the geometries are within an area of the scan field that cannot or should not be targeted by the
laser, the job will have to be adjusted manually (scaling would not be permissible since this would
destroy the dimensions of the scale).

Fig. 4.9: Generating a calibration job

Only the middle part is of interest here, which contains two texts and horizontal lines. The two
crosses in the corners will be discussed later:

Fig. 4.10: Calibration job for aligning the camera
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Mark the job and activate the live image of the camera by clicking on the camera symbol in the
C&T UI panel:

Fig. 4.11: Live image button in the C&T UI panel

In addition, activate the display of the adjustment line in the live image (see page 42, Buttons).
Using the mouse wheel, you can move the line up or down to be positioned where the horizontal
lines of the marking are visible.
You can also display a larger version of the live image by using the mouse to drag the entire UI
panel out of the RAYGUIDE main window.
Now turn the camera lens in such a manner that the texts are not upside down and not sideways,
and the horizontal lines are parallel to the displayed horizontal adjustment guidelines.
The individual steps for the adjustment are described below:

6
5

1
2

3

4

Fig. 4.12: Camera objective

1 – Connection thread for camera lens
2 – Grub screws
3 – Inside cylinder
4 – Knurled screw
5 – Connection thread for camera (C-Mount)
6 – Locking screw (thread-locked, do not open)
1. Screw the connection thread of the camera lens (1) into the camera adapter all the way to the
stop. Tighten the camera lens only lightly at the stop.
2. Screw the camera all the way onto the connection thread (5). Tighten the camera only lightly at
the stop. Tightening the camera too tightly will damage the thread and will lead to the
destruction of the camera or the camera lens.
3. Open the knurled screw (4), adjust the focus roughly and tighten the knurled screw again.
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4. Release the three grub screws (2) slightly and turn the entire camera lens until the image
section is aligned with the X/Y direction of the editing field. While the grub screws are open, the
focus must not be changed, or else there will be a risk of mechanical damage.
5. Lightly tighten one of the grub screws (2) again to prevent accidental turning.
6. Adjust the focus exactly and secure this setting by lightly tightening the knurled screw (4).
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4.4

Calibrating the camera image
For an optimal result when assembling the image tiles, it must be known how large the area of the
working field is that is shown in a single image tile. Also, the center point of the camera image is
never identical with the point onto which the mirrors direct the laser beam. This difference must be
corrected. The laser generally has a different wavelength than the visible light that generates the
camera image and is therefore deflected differently by the optics. This effect, too, can be
compensated for by suitable calibration.

Starting the calibration
1. Select System > Devices > Camera > Camera name to open the Camera dialog.
2. Change to the Calibration tab.

4.4.1

Focus calibration
When using the camera with a RAYSPECTOR module that is coupled to an AS-FIBER deflection
unit, the sensor Z-axis in RAYSPECTOR, in combination with the fitting correction file, is set at the
factory such that the camera is in focus at the working distance. It can still be necessary to adjust
the focal plane slightly.
ATTENTION: This step must be performed once prior to calibration.

In this case, use the slider.
Note that a positive sensor axis offset corrects the focus "downward", while a negative sensor axis
offset corrects the focus "upward".
NOTE: If multiple focal planes are used for the camera calibration below, the focus calibration only
needs to be performed for one focal plane.
NOTE: The sensor axis offset is also displayed on the Calibration tab in the dialog of the
corresponding deflection unit.
NOTE: If the camera is used in a 2-axis unit with an F-Theta objective and the corresponding
correction file, this point is not applied.

4.4.2

Manual calibration
The manual calibration is performed in four simple steps using a marked calibration job.
HINTS:
▪

Ensure that the material you are marking is always fixated during the calibration process.

▪

The marking must always take place in the focal plane of the system.
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4.4.2.1

Generating a calibration job
First generate a suitable calibration job. When you execute it on paper, ensure that you fixate it
properly so that it cannot shift during calibration.
1. Set the calibration model to manual (see page 27, Aligning the camera).
2. Optional: Define the focal plane for the camera calibration
If the work area used has an extension in the z-direction, the calibration described below must
be performed at least twice: at the highest point (z-position = 0 mm) and again at the lowest
point if possible (depends on the values in the correction file). The obtained calibration data are
then automatically interpolated (linearly) for the intermediate z-positions.
NOTE: The value for the lower focal plane is always specified as per the correction file. If a
marking is not possible in this focal position because of the system design, an alternative value
can be entered.
3. Select a pen that is suitable for marking on your material.
4. For the wavelength correction, one cross marking is made at the top left corner and one at the
bottom right corner of the marking field. In the wavelength calibration section, enter the
positions of these markings. They should be separated by a distance of approx. 80% to 90% of
the marking field width. For example, for a marking field of 112 mm x 112 mm, the two points
(-50, 50) and (50, -50) are suitable.
NOTE: If values are entered here that are outside of the marking field, values are automatically
calculated when the job is created that are separated by a distance of 80% of the marking field
width.
NOTE on calibration jobs and RAYGUIDE work area:
In the RAYGUIDE software, the work area can consist of several scan fields. It can be smaller or
larger than the scan field and may have an offset relative to the scan field.
Click&Teach always automatically positions the calibration job centered relative to the scan field
and not centered relative to the work area since every coaxially operating camera always acts per
scan field.
If the geometries are within an area of the scan field that cannot or should not be targeted by the
laser, the job will have to be adjusted manually (scaling would not be permissible since this would
destroy the dimensions of the scale).
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Fig. 4.13: Camera settings: Generating a calibration job

5. Click on [Generate calibration job] to generate a job.
6. Perform the job with the RAYGUIDE software.
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4.4.2.2

Calibration of the camera image size
The area of the working field that a single tile displays is to be determined. For this purpose, you
must inform the system about how large a known comparative measure appears to be in the
camera image:
1. Click on [Start calibration] in the Calibration of the camera image size area. In this step, it is
only roughly determined which area can be seen horizontally with the camera:

Fig. 4.14: Camera settings: starting the calibration temporarily and stopping it

This step aligns the mirrors of the deflection unit to the zero point and the camera image is
displayed in the work area of RAYGUIDE in its full format:

Fig. 4.15: Calibration: selecting the markings and determining the distance
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You can see the scale of the marked job. Each marking is 1 mm from its neighbor in the real world.
Select two scale elements that are close to the edges but still fully visible, and count the distance
between these two elements. In the example, the two outermost markings that are just barely
visible are 17 mm apart.
NOTE: The measurement becomes more accurate as the distance between the two selected scale
elements increases.
2. Cancel this calibration step temporarily by clicking on [Cancel calibration] so that the correct
measure can be entered.
3. Enter the distance between the two selected markings in the Measure field:

Fig. 4.16: Camera settings: calibration of the image field

It is essential that this value corresponds to the distance between the markings that was selected in
step 1 and measured in step 4.
4. Start the calibration again. In the work area, you can see two blue, vertical guidelines. Move
those to a position directly over the two selected markings. To increase the accuracy, you can
zoom into the work area.
5. Click on [Complete calibration] to complete the calibration. The system now knows the size of
the field in the work area that a single image tile or a camera pixel displays. The result is
displayed in the field Image size and Pixel size.
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4.4.2.3

Calibration of the center point
For design reasons, there is normally a deviation between the point to which the laser points and
the center point of the camera image. This distance is determined by the center point calibration
and can be compensated during tiling.
1. Click on [Start calibration] in the Calibration of the Center Point area:
1

2

Fig. 4.17: Camera settings: center point calibration

In the same manner as for the calibration of the camera resolution, the camera image is displayed
in the work area of the RAYGUIDE as a background image, but this time with a vertical and a
horizontal guideline. Move the blue lines in such a way that their point of intersection is directly over
the center point of the calibration job:

Fig. 4.18: Calibration of the center point

2. Click on [Complete calibration] to complete the calibration.
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4.4.2.4

Wavelength calibration
Finally, the different wavelengths of the visible light, generated by the camera image and the laser,
which generates the contours of the material, must be compensated.
1. Click on [Start calibration] in the Wavelength Calibration area.

Fig. 4.19: Camera settings: shaft length calibration

The camera is first aligned with the top left corner and the image is shown in the work area.
2. The cross that the calibration job marked there should be visible. Move the two blue guidelines
to the position where their point of intersection coincides with the center point of the marked
cross, and click on [Complete calibration].
3. The camera jumps to the position of the lower right corner, where the second cross was
marked. Again, move the guidelines until they coincide with the cross and click on [Complete
calibration].
The result is two scaling factors that compensate for the wavelength difference during tiling.
4. Close the dialog by clicking on [OK] to adopt the obtained values.
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4.4.3

Automatic calibration
The automatic calibration simplifies the calibration process through the use of image processing
algorithms.

Fig. 4.20: Camera settings: automatic calibration

1. Set the calibration model to automatic.
2. Optional: Define the focal plane for camera calibration
If the workspace used is to have a fixed size in the z-direction, the calibration described below
must be performed at least twice: at the highest point (z-position = 0 mm) and once more if
possible at the lowest point (depends on the values in the correction file). For the intermediate
z-positions, the obtained calibration data are interpolated automatically (linear).
NOTE: The value for the lower focal plane is always defined as per the correction file. If a mark
in this focal plane cannot be realized due to the system design, an alternative value can be
entered.
3. Select a pen that achieves good results on the surface to be marked.
ATTENTION: A good marking result is a prerequisite for pattern recognition to be successful.
The laser parameters must have been determined in advance on the basis of simple marking
tests. Image recognition requires good illumination with sufficient contrast.
4. In the Measure field, enter the approximate width of the section in the work area that is
displayed by the camera. This value determines the size of the checkerboard pattern that the
calibration job will contain and that will need to be recognized by the image processing later.
5. Generate the calibration job and carry it out. It consists of several reasonably arranged squares
that are to be detected by the image detection feature.
6. Perform the automatic calibration. While it is running, the calibration step that was just
executed is logged in the status bar of the RAYGUIDE software at the bottom right.
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Then a dialog appears that displays either the success of or the failure of the image recognition. If
calibration was successful, the determined values are automatically entered in the corresponding
fields of the Settings dialog. The dialog is closed by clicking on [OK].
If calibration fails, try to improve the illumination or to adjust the laser parameters. You can also see
the results of the image processing directly as images by pressing the left shift key and clicking on
[Calibrate automatically]. In this case, RAYGUIDE places five PNG files into the temp directory of
the user (enter %temp% into the address line of the Windows Explorer to open it). These files all
begin with ClickAndTeach and mark identified checkerboard patterns with a gray border.
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5

CLICK&TEACH UI PANEL
In the RAYGUIDE menu, select View > Panels > Click&Teach to open the Click&Teach UI panel.
It can be shown or hidden, as desired, and is located in the same section as the operating fields for
transformation and process adjustment (the standard position is on the right side of the screen). It
can be used as a separate window. This is particularly useful to display the live image in a larger
format.

Fig. 5.1: C&T UI panel

Buttons
1 – For details, see page 42, Buttons.

Camera selection
2 – For details, see page 41, Camera selection.

Picking
3 – For details, see page 44, Picking.
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Settings
4 – For details, see page 46, Settings.

Progress bar
5 – Shows the progress.

Live image
6 – For details, see page 48, Live image.

Focus position of slider (optional)
7 – If the correction file in use for the deflection unit provides a 3D working volume, this slider can
be used to adjust the camera focus within the available working volume. The displayed z value
pertains to the coordinate axis in the field domain.
The UI panel is subdivided into several sections, which are described below in detail.

5.1

Camera selection
Multiple deflection units can be equipped with cameras. Select the camera to be controlled in the
Camera drop-down list.

Fig. 5.2: C&T UI panel: camera selection

The name of the camera consists of the short designation of the camera and the camera type. The
short designation can be individually assigned by the user (see page 14, Click&Teach
components). The camera type (in parentheses) can be viewed in the Device Configuration dialog
(see page 25, Setting up the camera as a device).
Communication is only possible with the camera selected here. This pertains not only to picking
and tiling, but also to the calibration: in the Settings dialog of a camera, all of the corresponding
buttons are grayed out if the same camera is not also selected here.
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5.2

Buttons
Icon buttons
The following symbol buttons are available in the Click&Teach UI panel and are explained in the
following table:

Fig. 5.3: C&T UI panel: buttons

The following individual functions are available:
Button/icon

Referenced as

Function

[Tile image field]

Tiles the entire image field.
If [Tile image field] is clicked while the left shift key on
the keyboard is pressed, all tiles are stored as PNG files
in the ClickAndTeach subdirectory of the Temp directory.
Enter %temp%\clickandteach\ in the address line of the
Windows Explorer to open the directory.
The PNG files are named as follows:
pic_0123.png, where 0123 refers to a sequential
number.
If [Tile image field] is clicked while the left CTL button is
pressed, the PNG files are named as follows:
pic_0123(456,789).png, where 0123 refers to a
sequential number. 456 refers to the horizontal and 789
to the vertical mirror position of the deflection unit in
micrometers [µm].

[Store current work Stores the current, tiled work area background in a file.
area background]
Two variants are always stored:
In each case, a variant without a field rotation (for
loading again via Click&Teach) and a second variant
with a field rotation are stored if this image is to be used
as a background image for RAYGUIDE jobs. The second
variant can be identified by the supplement to the file
name.
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[Show/hide live
image]

Switches the live image on and off.
The frame rate is 10 images per second.

[Save live image]

Saves the current live image in a file.
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Button/icon

Referenced as

Function

[Crosshair on/off]

Switches the crosshair on and off. The crosshair marks
the location on which the laser is positioned.

[Delete
background]

Deletes the background of the work area.

[Load background]

Loads the background of the work area from a file.

[Load background
loaded last]

Reloads the background loaded last without opening a
file selection dialog.

[Zoom in live
image]

Zooms into the position of the live image. The option
selected in the Picking drop-down list is taken into
account: for example, if Option 3 x 3 tiles is selected, the
area of this size is zoomed into.

[Adjustment line]

Shows/hides the adjustment line in the live image.
NOTE: The position of the adjustment line can be moved
up/down using the mouse wheel.

[Preview]

Starts a marking preview. The current job is started in
preview mode with a slow marking speed and the live
image is switched on with the crosshair on for the
purpose of tracking.
NOTE: When executing the preview, the wavelength
calibration must be taken into account. This is done by
automatically applying the factors for the wavelength
correction that were determined during camera
calibration to the scaling of the current process
transformation. After the preview is closed, the old
scaling is restored.

[Settings]
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Opens the C&T settings.
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5.3

Picking
Apart from tiling the overall work field, it is also possible to separately tile selected sections of the
scan field by clicking on the desired location with the mouse pointer. The picking tool, which
consists of two drop-down lists, is used for configuration:

Fig. 5.4: C&T UI panel: picking tool

Setting

Explanation

Left drop-down list
Select the size of the area to be tiled or switch off picking.
Individual tile

A single camera image is photographed in which the mouse pointer
indicates the mirror positions.

Tile area

An area consisting of multiple camera images is photographed,
where the mouse pointer indicates the mirror positions of the middle
tile.
The area consists of 3x3, 5x5, 10x10, 25x25 or 50x50 tiles.

Size in millimeters

Assign a minimum size to the tiled surface.
Protruding areas that result from the tile size are not cut off.

Selected objects

Selected objects are completely tiled (rectangular). The location
where picking occurs in the scan field is unimportant.

Selected outlines

Tiles are generated along the selected outline. The selection of the
outline can be a whole object, a layer, or a path. The location where
picking occurs in the scan field is unimportant.

Tiling the selected area

Use the cursor to drag open a rectangle on the scan field. The
opened rectangle is tiled when the mouse is released.
NOTE: An uneven number of tiles is always generated in the
horizontal and vertical directions. Protruding areas that result from
the tile size are not cut off.
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Setting

Explanation

Right drop-down list
Two setting options for the background of the scan field.
Delete background

The background of the scan field is deleted first before the new tiles
are copied into it.

Retain background

The background of the scan field is not deleted before the new tiles
are copied into it.

As is the case when tiling the overall field, all image tiles are stored as PNG files in the
ClickAndTeach subdirectory of the Temp directory of the user if the left shift key on the keyboard is
pressed while the mouse is clicked. Enter %temp%\clickandteach\ in the address line of the
Windows Explorer to open the directory.
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5.4

Settings
Some configuration parameters enable you to influence the tiling process:

Fig. 5.5: C&T UI panel: settings

Setting

Explanation

Jump speed [m/s]

Speed with which the mirrors jump from one tile position to the
next.
Standard: 10 m/s.

Jump delay [ms]

The time the system waits after the mirrors have reached the
wanted positions before the image is taken.
This can be useful if the camera can determine the exposure time
and/or amplification automatically and requires some time for this.
Standard value: 0 ms

Overlapping factor

Due to unavoidable rounding errors, a 1-pixel gap may arise
between two individual image tiles. To avoid this, the tiles may
overlap slightly. A value of 2 means, for example, that twice as
many tiles will be generated, which will then overlap by 50%
each.
Standard value: 1.02 ms

Zoom into the picked tiles

If activated, the work area is automatically zoomed so that the
picked tile(s) is/are displayed in full format.
This can also be achieved by clicking on [Zoom into live image].
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Setting

Explanation

Preview speed [mm/s]

Value for the C&T preview speed.
Corresponds either to the speed according to the preview slider
or can be entered directly here.

Preview repeatedly

In preview mode, the job is executed at a low speed so that the
laser position can be tracked in the live image. Normally the
preview is ended after one cycle. If the continuous option is
activated, the preview is repeated again and again until it is
stopped by clicking on [Preview] again.

Crosshair size [%]

The length of the crosshair bars is indicated as a percentage of
the tile size.

Crosshair thickness [pixels]

The thickness of the crosshair bars is indicated in pixels.

Crosshair color

Selection of the color of the displayed crosshair.

Adjustment line position [%]

Specification of the position of the adjustment line in the live
image in [%] of the live image height.
The position can be moved directly using the [+] / [-] buttons or
the mouse wheel.

Live view rotation

The life image can be rotated in 90° steps.

NOTE: The opacity setting of the background images added using Click & Teach is adjusted using
the opacity slider. This feature has been part of the RAYGUIDE toolbar since v1.24.
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5.5

Live image
The live image is shown and hidden using the [Show/hide live image] button and can be stored
using the [Store live image] button. If the image is too small, the C&T UI panel can be separated
from RAYGUIDE, moved to its own window and adjusted in size. The live image can also be
rotated in 90° steps.
NOTE: Note that the live image is not shown in the full camera resolution but is scaled down to the
value set in the Scaling Factor field in the camera settings (see page 26, Connecting/assigning the
camera).
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5.6

Example of tiling
The following figure shows the tiling of a work field with a marked line grid pattern displayed at the
full image size of 1936 x 1216 pixels for the camera model in use:

Fig. 5.6: Tiling of a line grid pattern with a camera image size of 1936 x 1216 pixels

The cushion-shaped appearance and the breaks between the tiles are is caused by the F-Theta
lens’s distortion. When you pick a desired point directly, however, the deviations become
negligible.
The distortions caused by the F-Theta lens are smoothed when marking by means of the correction
file in the deflection unit. You can take advantage of this by reducing the image size of the camera
and thereby reducing the distortions.
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The following tiling was recorded with a reduced image size (see page 14, Click&Teach
components) of 350 x 350 pixels:

Fig. 5.7: Tiling with reduced camera image size of 350 x 350 pixels

The distortions and breaks between the tiles are considerably reduced. However, tiling takes
considerably longer to complete.
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6

CAMERA EMULATOR
The camera emulator is available for testing, presentation and training purposes. It can be used to
simulate the operation of most C&T functions, such as calibration and picking/tiling, without having
to connect a real camera.
If a deflection unit with a pilot laser is available, the functionality of C&T can be demonstrated
clearly even without a real laser.
Instead of having to record images, the emulator already contains a large image from which,
depending on the mirror position, sections can be shown as "live" images or image tiles. As in the
case of real cameras, the emulator is designed as a RAYGUIDE plugin and has many of the same
setting options:

Fig. 6.1: Camera emulator: settings
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Setting

Explanation

Setting
Image size (width
x height) [pixels]

Setting of the image size.

Source image
rotation [°]

If a rotation is set in the deflection unit, it can be compensated here to
achieve a vertically oriented image.

[Display]

Clicking on [Display] shows the background image in the work area. This
can be useful for the calibration of the emulator; see page 53, Manual
calibration.

Scale factor [%]

Adjustment of the scale factor.

The maximum size of the camera image is limited to 360 x 240 pixels. For
real cameras, it can be useful to reduce the size since the unavoidable
distortions become smaller as a result. The emulator always generates an
undistorted image, making a reduction in size unnecessary.

The source image of 3000 x 3000 pixels is small enough so that the scale
factor can be set to 100% without performance reductions.

6.1

Establishing a connection
The connection is established in a similar manner as for a real camera (see page 26, Connecting/
assigning the camera), only that the search always finds four virtual cameras to which the
connection can then be made.
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6.2

Calibration

6.2.1

Automatic calibration
Because the size of the source image from which the sections are displayed and the dimensions of
the work field are known, the automatic calibration always functions perfectly because the
calibration parameters can simply be calculated. It is not necessary to create a calibration job.
Switch to the automatic calibration mode and click on [Calibrate automatically].
NOTE: The automatic center point calibration only functions with the integrated source image since
the center point shift is known (12 pixels in the x direction and 24 pixels in the negative y direction
at 3000 x 3000 pixels (overall size). When using a separate source image, you need to perform the
center point calibration manually.

6.2.2

Manual calibration
For demonstration purposes or when using your own source image, the calibration can be
performed manually. The procedure is slightly different than for a real camera because the creation
of the calibration job is replaced by the manual measurement of suitable distance markers in the
source image.
Problem: The integrated source image has a size of 3000 x 3000 pixels and contains scales on the
x and y axes, where the individual "millimeter" markings are spaced 10 pixels apart:

Fig. 6.2: "Millimeter" scale in the emulator source image (section in the center)

The source image is now always shown in the background of the work field with its full width and
height. The width of the work field is always 3000 pixels. In a work field of 300 mm x 300 mm,
10 pixels are equivalent to exactly one millimeter. However, this is not the case for work fields of
different sizes, in which case a suitable reference size needs to be determined before the actual
calibration is performed.
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The necessary steps for manual calibration are described below:
1. Click on [Start calibration] in the Calibration of the Camera Image area. The center of the
image field is enlarged in the work area:

Fig. 6.3: Determining the comparative measure

2. Find two points in the image that are as far apart as possible and that can be easily found
again. In the example, the "millimeter" markings identified with red arrows at -19 and +16 are
convenient points. The question now is how far apart these points are in the real world. For a
size 300 field, the distance would be exactly 35 mm. In this example, however, we are using a
field of 112 mm x 112 mm. At a pixel distance of 35 * 10 pixels, the actual distance can now be
found using the equation 112 mm/3000 pixels * 350 pixels = 13.067 mm. This distance can also
be measured. To do so, terminate the calibration procedure by click on [Cancel calibration].
Display the overall image in the background by clicking on [Display] under Settings:

Fig. 6.4: Displaying the source image as the background in the work area
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3. Zoom into the image until both markings are easy to see. Measure the distance using the
Measure distance tool of the RAYGUIDE:

Fig. 6.5: Measuring the comparative measure

4. Enter the value (recommendation: calculated value) into the Measure field:

Fig. 6.6: Entering the measured comparative measure

5. Proceed with the calibration as described in page 34, Calibration of the camera image size.
The integrated background image intentionally has an offset of 6 pixels in the x direction and
12 pixels in the negative y direction in order to be able to demonstrate the calibration of the
center point.
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6.3

Changing the background image
The integrated background image, which is used by the emulator as a template, can be replaced
by another image if desired. To do so, copy your PNG image into the directory C:
\ProgramData\RAYLASE\RAYGUIDE\Configurations\.
The file name must have the exact same name as the connected virtual camera, i.e. Virtual
Camera 1.png, Virtual Camera 2.png, Virtual Camera 3.png or Virtual Camera 4.png.
You can open the directory most quickly by simply entering %programdata% in the address line of
the Windows Explorer.
ATTENTION: The autocalibration of the center point only works with the integrated background
image since the deviation from the actual center point is only known for this image.
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7

TROUBLESHOOTING
The C&T UI panel is not visible.
Activate the C&T UI panel via the menu item View > Panels > Click & Teach.

The C&T UI panel cannot be activated.
Check whether the RAYGUIDE license has the necessary product code.

The desired camera does not appear in the drop-down list of the C&T UI
panel.
a) Check whether the camera was added to the Device Configuration dialog.
b) Check whether the camera is connected in the Settings dialog.

The buttons for calibration are grayed out in the Settings dialog.
Select the camera in the C&T UI panel in the Camera drop-down list.

The button for tiling is grayed out in the C&T UI panel.
Calibrate the camera.

The tiles do not join up properly in the center of the image (the outer areas
are normal because of distortion).
Calibrate the camera image size.

The middle of the work field is not displayed in the middle of the RAYGUIDE
window.
Calibrate the center point.

Marked objects in the tiled image are displayed with increasing deviations
toward the edges of the work area.
Perform a wavelength correction.

Images that are recorded in a focal position other than the zero position
exhibit "gaps" between the tiles.
The camera was only calibrated in one focal plane. A corresponding second camera calibration
must be made in another focal position. (See page 31, Manual calibration.)
a) If necessary, disconnect the network connection to the corresponding camera in the device
configuration briefly and reconnect.
b) In the eBus player application, check whether a live image is available there and check the
network settings.
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